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WELCOME TO EMBARCADERO DB OPTIMIZER

Embarcadero DB Optimizer simplifies SQL optimization and development for application
developers with many features for improving productivity and reducing errors. A rich SQL IDE
with statement tuning, data source profiling, code completion, real-time error checking, code
formatting and sophisticated object validation tools helps streamline coding tasks. DB
Optimizer's user interface helps improve overall productivity with integrated development,
monitoring, and tuning components. DB Optimizer offers native support for IBM® DB2® for
LUW, Oracle®, Microsoft® SQL Server and Sybase® as well as JDBC support for other DBMS.

DB Optimizer has four components that when used together can optimize your database
performance.

SQL Editor: A developer can write Java in Eclipse that calls to the database with SQL. The SQL
that calls to the database can be written in the SQL Editor with type ahead, code assist and
quick fixes to show the users syntax and correct mistakes. For more information, see Creating

and Editing SQL Files (SOL Editor) on page 59.

Load Tester: The SQL code can be run in the Load Tester to test execution by multiple
concurrent users. User load testing is so often done my one single user and then problems don't
appear until production with multiple concurrent users. Concurrent user testing is a breeze in DB
Optimizer. For more information, see Using Load Tester on page 46.

Profiler: You can run the Profiler while the Load Tester is executing to show clearly the impact on
the database. The profiler can also be used by QA on load simulation. Finally the Profiler can be
run on any production database to clearly show load, bottlenecks, and sources of bottlenecks or
resource consumption. For more information, see Using Profiling on page 2.

Tuner: Finally if a problem SQL is found on the system the Tuner will show if it's correctly
optimized by the database or not, and if not it will show the best plan and what hints or
optimizer directives can be included in the SQL to force the database to use the optimal plan.
For Oracle these hints can even be stored in the database so that there is no need to even
change the original SQL text. For more information, see Using Tuning on page 5.

ABOUT THIS DOCUMENT

This document is the primary reference and usage guide for DB Optimizer.

For more information, see the Embarcadero website at www.embarcadero.com and online
information in the Embarcadero Documentation Wiki at docwiki.embarcadero.com.
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NEW FEATURES OF DB OPTIMIZER 3.0

User Interface Changes

* Removal of Eclipse-specific Ul elements: To provide a better focus on DB Optimizer-
specific functionality and workflows, Ul elements provided by the underlying Eclipse
framework aimed primarily at Java development have been removed. These include the
Navigate, Project, and Run menus, as well as toolbar buttons for debugging and code
navigation.

¢ Shortcuts to DB Optimizer Preferences: A new Preferences menu has been added with
shortcuts to the preference pages relevant to DB Optimizer configuration. These pages (and
their associated menu entries) are Data Sources, SQL Development, SQL Editor, SQL
Execution, SQL Filters, Data Source Indexing, Profile Alerts, and Tuning Job Editor. The
set of all preferences is available under Preferences > Other option, and the previously-
available Window > Preferences option.

Object Indexing Enabled by Default

Previous versions of DB Optimizer had the option to create an index of schema objects on a
data source in order to provide code completion and semantic validation of object names in the
SQL Editor, but this was disabled by default, because it could affect data source performance. In
DB Optimizer 3.0, the speed and efficiency of Object Indexing has been significantly improved,
so this functionality is now enabled by default. This option can still be disabled from the
preferences window (available from the Preferences > Data Source Indexing option).

New Actions on Oracle Sessions During Profiling
While profiling an Oracle data source, the Sessions tab in the profiling editor has two new
context menu actions on rows in the session grid:

e Kill Session: Instructs the database to kill the given session. The session will still appear
within the profiling editor, based on its activity prior to being killed.

® Trace Session: Instructs the database to begin a full trace operation on the session. (This
simply executes set_sql trace_in session from Oracle’s doms_system package for the
given session.)

MS SQL Server and Sybase ASE Profiling Improved

Profiling on Microsoft SQL Server and Sybase Adaptive Server Enterprise are now more efficient,
contributing less than 2% load on the profiled data source under most conditions. Furthermore,
more accurate data is collected.

Improved User Interface for the Tuning Editor

The dedicated Input tab of the Tuning Editor has been removed, allowing the user to specify
statements for tuning directly within the Overview tab.

DB OPTIMIZER™ XE PRO 2 USER GUIDE 9



NEW FEATURES OF DB OPTIMIZER 3.0 >

In the top-right of the Tuning Editor, there is an input selection button, to add statements for
tuning from the following sources:

¢ New SQL Text: Input/pasted by the user into a dialog box.

e Extract from Database Object: Use SQL DML statements from an appropriate schema
object (such as views, procedures, triggers, functions, materialized views, and packages).
Alternatively, objects can be dragged and dropped onto the Tuning Statements grid from
the Data Source Explorer tree.

¢ Import from File (Workspace): Import statements from a file in an existing SQL Project.

¢ Import from File (System): Import statements from a file on a local disk or from a network
share.

To view or modify a tuning statement, or to bind variable values within the statement, double-
click on the statement in the grid or right-click and select Edit... from the context menu.

Oracle RAC Profiling

All instances of an Oracle Real Application Cluster (RAC) can be profiled using a single profiling
session (and a single connection to the cluster). To enable this functionality for a RAC data
source, you must access the Profile Configurations dialog, in one of the following ways:

¢ Right-click the data source in the Data Source Explorer and select Profile As > Profile
Configurations....

e Click the down-arrow button next to the New Profiling Session button in the toolbar, and
select Profile Configurations....

Within the Profile Configurations dialog, check the box for Real Application Cluster (RAC)
mode.

Within a RAC profiling session, the filter bar at the top of the profiling editor includes an
Instances filter, which allows you to view profiling results for individual instances in the cluster, or
show results for sessions from all cluster instances.

Furthermore, several tabs from the Profiling Details view will show the ID of the instance on
which the selected statement/event/session was observed.

Profiling Alerts

During profiling, alerts can be triggered based on thresholds set on the number of:
® Active sessions
e Sessions experiencing a wait condition
¢ Active sessions not on CPU

These alerts can produce a system notification (from the Windows status tray) and/or generate
an email to be sent to one or more addresses. This allows you to begin a profiling session,
continue with other work, and return to DB Optimizer when the alert has fired to investigate the
underlying cause.
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NEW FEATURES OF DB OPTIMIZER 3.0 >

Alerts can be set up from the preferences page available from the menu item at Preferences >
Profile Alerts. Alerts may be configured per data source and multiple alerts may be configured
for a profiling session.

In order to generate email messages for alerts, the mail server options must be specified on the
Email Settings page under the Profile Alerts preferences, and one or more recipients must be
specified on the Email Contacts page.

Profiling Reports

The results of a profiling session can now be exported as an HTML or PDF document that can be
saved for later, shared, and printed.

Within the Profiling Editor, the Export Report button is located in the top right, between the
filter options and the Help button.

By default, the report is generated for the entire duration of the profiling session. To restrict the
report to a particular time interval, click and drag on the profile session chart. To clear the
selection, click once on the chart outside the selection.

Support for Common Table Expressions on Oracle and MS SQL Server

The SQL Editor and Tuning Editor now both support common table expressions (CTEs) for
Oracle and SQL Server. This includes syntax highlighting and checking in the editor, as well as
generation of Explain Plans for CTEs from the SQL Editor and the Tuning Editor.

Improved Visual SQL Tuning for Oracle

The Visual SQL Tuning (VST) diagram for Oracle 10g and 11g now has the option of showing
Explain Plan details in addition to the column relationships. The Explain Plan display can be
toggled on/off by clicking the leftmost button that appears when hovering over the SQL Analysis
diagram.

The additional nodes shown in the Explain Plan overlay provide details on the flow of the query
plan, with operations (such as nested loops, sorts, and joins) showing connecting tables and
other operations.

Compare the following VST diagram without Explain Plan overlay (largely unchanged from
earlier versions):

b O Oracle » [ ROMLASS®ORD3 (102.00)
=

B sal ""'n"lh"!:’f' Select Aaternent of interest | SELECT 1 -l o=

T8 LOCATIONS (L |—] T DEFARTMENTS ]

T
10 EMPLOYEES iE)
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NEW FEATURES OF DB OPTIMIZER 3.0 >

Versus this VST diagram for the same query with the operations (four nested loops and a hash

join) from the Explain Plan shown:

¢ o) Oracle # R ROMLASFRORII 10200)
| [

F i W Analpsls |
£ S0L Analysis
cf I COUNTRIES |C) ] I LOCATIONS (L)

L £ HL

12

—
|

| T EMPLOYERS (E)

DB OPTIMIZER™ XE PRO 2 USER GUIDE




CONFIGURING DB OPTIMIZER™ XE PRO 2

This section contains information on configuring DB Optimizer. It includes information on setting
up the system directory for project files, as well as licensing information. Additionally, this section
contains information on setting preferences within the application for the customization of
various features and functionality.

e |nitial Setup on page 13

e Customizing DB Optimizer™ XE Pro 2 (Preferences) on page 15

INITIAL SETUP

The following topics provide general help for configuring DB Optimizer:

¢ Specify a Workspace on page 14

e License DB Optimizer™ XE Pro 2 on page 14

Additionally, the following preferences are available to help you customize and tune functions
within the application:

e Specify Data Sources Preferences on page 15

e Specify SOL Development Preferences on page 16
e Specify SQL Editor Preferences on page 17

e Specify Code Assist Preferences on page 18

Specify Code Formatter Preferences on page 20

Specify Code Quality Preferences on page 22

Specify Results Viewer Preferences on page 23

Specify SOL Templates Preferences on page 25

e Specify Syntax Coloring Preferences on page 27

e Specify SQL Execution Preferences on page 28

e Specify SQL Filters Preferences on page 28

e Specify Data Source Indexing Preferences on page 29

® Specify Tuning Job Editor Preferences on page 31

e Specify File Encoding Preferences on page 33

DB OPTIMIZER™ XE PRO 2 USER GUIDE 13



CONFIGURING DB OPTIMIZER™ XE PRO 2 > INITIAL SETUP

SPECIFY A WORKSPACE

When you install DB Optimizer, you are prompted to create a workspace. Then when you launch
DB Optimizer, you have an opportunity to choose your workspace. At any time while running DB
Optimizer, you can change your workspace.

Select File > Switch Workspace.

& Workspace Launcher

%]

Select a workspace

Embarcadero DE Optimizer Professional stores your projects in a Folder called a workspace.,
Choose a workspace Folder ko use Faor this session,

| Workspace: |C:'|,D|:u:ument5 and Settings)Jacquieldboptimizer 3workspace v| [ Browse. ..

+ Copy Settings
[ ]warkbench Layaout
[ ]working Sets

@:\J [ Ok H Cancel ]

For more information about workspaces, see Help > Help Contents > Workbench User Guide.

LICENSE DB OPTIMIZER™ XE PRO 2

The first time you first launch DB Optimizer™ XE Pro 2, you will be prompted to activate the
product. Choose to activate by Internet and follow the prompts. During the activation process
you will receive an email with an activation key; after you enter that key into the License Setup
dialog, you will receive a free 14-day evaluation license.

If due to firewall or other restrictions you cannot use Internet activation, select the E-mail
alternative. If that does not work either, select the Phone alternative.

To continue using DB Optimizer™ XE Pro 2 after the evaluation period, select Help >
Embarcadero Licensing > License Registration and follow the prompts, or visit the

Embarcadero online store at http://www.embarcadero.com/store.html.
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CONFIGURING DB OPTIMIZER™ XE PRO 2 > CUSTOMIZING DB OPTIMIZER™ XE PRO 2 (PREFERENCES)

CUSTOMIZING DB OPTIMIZER™ XE PRO 2 (PREFERENCES)

To customize various aspects of DB Optimizer™ XE Pro 2, select the aspect you want to
customize from the Preferences menu. For information on categories that may not be covered
in this section, see Help > Help Contents > Workbench User Guide or Help > Help Contents
> Debugger, respectively.

This section is comprised of the following topics:

e Specify Data Sources Preferences on page 15

Specify SOL Development Preferences on page 16
Specify SOL Editor Preferences on page 17

Specify SOL Execution Preferences on page 28

Specify SQL Filters Preferences on page 28

Specify Data Source Indexing Preferences on page 29

Specify Tuning Job Editor Preferences on page 31

SPECIFY DATA SOURCES PREFERENCES

When you add a datasource to your list of Managed Data Sources in the Data Source Explorer,
DB Optimizer stores the definition and metadata for the data source in the location you specify
here. For information on adding data sources, see Register Data Sources on page 40.

1 From the Preferences menu, select Data Sources.

The Data Sources pane appears.

& Preferences (Filtered)

E | Data Sources -

CR NS Specify the locstion For data source definitions and their metadaka:

Data Sources:

Metadaka: js'n,]a:q.uie'n,#.palicatinh Data\EmbarcsderaiDats Sourcesimetadsts " Broase. ..

2 Specify the location for data source definitions and their metadata.

3 Click Apply.
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CONFIGURING DB OPTIMIZER™ XE PRO 2 > CUSTOMIZING DB OPTIMIZER™ XE PRO 2 (PREFERENCES)

SPECIFY SQL DEVELOPMENT PREFERENCES

The SQL Development Preferences specified on the first page of the SQL Development
Preferences determines DB Optimizer behavior when connecting to and extracting DDL from a
datasource. For information on preferences accessible by expanding SQL Development, see
Customizing DB Optimizer™ XE Pro 2 (Preferences) on page 15.

1 From the Preferences menu, select SQL Development.

& Preferences (Filtered)

| | S0L Development -

Connection timeout (seconds):

DOL Exkraction
[ |Extract dependent objects also
[ ]add initial USE statement if the platfarm supports it

S0 Development

Extract skorage information
[ ]include DROF statement

2 Choose your preferences and then click Apply.
The following describes the SQL Development preferences:

e Connection timeout (seconds): Specify the connection timeout before the connection to
the database fails.

e Extract dependent objects also: If selected, when extracting DDL dependent objects such
as indexes are also extracted.

e Add initial USE statement if the platform supports it: If selected, a USE statement is
added to the DDL extracted. Adding the USE statement ensures that when you run the DDL,
you are using the correct database context.

e Extract storage information: If selected, When extracting DDL object storage information
is also extracted.

¢ Include DROP statement: If selected, the DROP statement will be added to the DDL so you
can easily execute the statement.
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CONFIGURING DB OPTIMIZER™ XE PRO 2 > CUSTOMIZING DB OPTIMIZER™ XE PRO 2 (PREFERENCES)

SPECIFY SQL EDITOR PREFERENCES
1 Select Preferences > SQL Editor.

% Preferences (Filtered) |:|@@
w

| | | sOL Editor

= 50L Development
S0L Editar Enable the SQL parser Faor Files smaller than | 700 = | KB

Severity level For semantic validation problems: | Ervor w

Hyperlinks can be configured on the Text Editors preference page,

2 Change the settings as appropriate in each section and then click Apply.

* Enable the SQL parser...: For performance reasons, you may want to enable the SQL
parser only if a SQL file is smaller than the size you specify here.

e Severity level for semantic validation problems: Choose a security level from this list.
This determines how semantic code errors are flagged in the editor and the Problems
view.

e The link to specify hyperlinks takes you to the Text Editors preference page.

NOTE: Clearing Enable SQL Parser will disable many of the “smart” SQL editor features,
including code formatting, auto completion, semantic validation, and hyperlinks. For
better performance, you may disable the parser for files above a specified size.

See the following topics to configure other SQL Editor preferences.

Specify Code Assist Preferences on page 18

Specify Code Formatter Preferences on page 20
Create and Edit Code Formatting Profiles on page 21

Specify Code Quality Preferences on page 22

Specify Results Viewer Preferences on page 23
Specify SOL Templates Preferences on page 25

Specify Syntax Coloring Preferences on page 27
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CONFIGURING DB OPTIMIZER™ XE PRO 2 > CUSTOMIZING DB OPTIMIZER™ XE PRO 2 (PREFERENCES)

SPECIFY CODE ASSIST PREFERENCES

The Code Assist panel is used to specify configuration parameters that determine how code
completion features in SQL Editor behave.

Select Preferences > SQL Editor and then in the Preferences dialog, expand SQL Editor
and click Code Assist.

% Preferences (Filtered)

| | Code Assist <o -
= 3L Development
[raka Source Indexing Enable auto-activation
Prafile Alerts Auto-activation delay {ms):
= 50L Editor
Code Assisk Auto activation triggers For S0L: I:I
Code Formatker
Code Quality [ ]Fully qualify completions automatically
Results Viewear
SCL Templates Code assist color options:
Synkax Coloring Zompletion proposal background Eallers @
501 Execution ompletion proposal Foreground
S0L Filkers

Tuning Job Editor

[Restu:ure Defaults ] [ Apply ]

@:.l [ oK H Cancel ]

The following describes the options on the Code Assist Preferences page.
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* Enable auto-activation: When selected enables code assist functionality with the Ctrl +
Space command. If this option is selected, the code assist window automatically appears
when you stop typing.

¢ Auto-activation delay (ms): Specify the amount of time in milliseconds that the window
automatically appears.

e Auto activation triggers for SQL: Enter a trigger character or trigger characters. When
you enter an activation trigger in the SQL Editor, you will see the code assist options
available .

¢ Fully qualify completions automatically: When selected, specifies if code completion
results are returned specific (fully qualified), rather than the minimum required to identify the
object.

¢ Code assist color options: Specifies the color formatting of code completion proposals.
Select background or foreground options from the menu and modify them as appropriate.
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SPECIFY CODE FORMATTER PREFERENCES

The Code Formatter pane provides configuration options for code formatting functionality in

SQ

L Editor.

Select Preferences > SQL Editor and then in the Preferences dialog, expand SQL Editor

and click Code Formatter.

¥ Preferences (Filtered)

(= 50U Development
= SQL Editar

Code Assist
Code Formather
Code Quality
Resulks Viewer
SOL Templates
Synkax Coloring

@

Code Formatter =i -

Select a profile:
|Em|:uaru:a|:lem [built-in] W I Shoy, .., I Rename. .. Remoyve

Preview:

{
coll INT,
cols INT,
cold INT,
cold VARCHAR (30)

[£

CREATE TABELE colTable o

INSERT
INTO colTable o |
VALUES
{
g,
9 Fl
g,
'test’

{Resr.ore Del‘aults] [ Apply

]

o ) (o )

20

The panel provides a drop down list of formatting profiles and a preview window that
displays how each profile formats code.

e Select a profile: From the list, choose the profile you want to view .

¢ Click Show to view the details of the Profile. On the Show Profiles dialog that appears,
you can edit the profile and save the changes.

e Click New to define additional code formatting profiles.

¢ Click Edit to modify existing profiles. You can modify how code characters appear in the
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interface and how SQL Editor determines line breaks.

¢ Click Rename to change the name of an existing profile. The new name cannot be the
same as another existing profile.

NOTE: If you create a new profile with a name that already exists in the system, a prompt will
appear asking you to change the name of the new code formatting template.

CREATE AND EDIT CODE FORMATTING PROFILES

You can create your own code formatting profiles that will define how your SQL code is
formatted.

1 Select Preferences > SQL Editor and then in the Preferences dialog, expand SQL Editor
and click Code Formatter.

2 On the Code Formatter pane, click Show or New and a dialog similar to the following

appears.
& Show Profile
Svle Presyiew:
Kesard: |_ - CREATE OR REPLACE PROCEDURE PreviewProced: |
i |
Haw lnes vall IN WNUNBER,

walz 1IN NUNEEER,
wald IN NUNEEER

i

Mazimunm bne width; 136
[ Insert & neve ling befare keywords 1

I3
| Keep empty BEGIN. .END block om a si lirez:
D e ndfe T_Et'np_val MUMEER;
BEGIN

Candit

HnEREnE SELECT cold
Foomatbng palicy: | Stack condidions, traiing operators b FROM cablel

WHERE
i i} 2 £
Stacking threshold coll = wall AMD G
[] kieep simpla THEN stabemerits an the sama line . T e c
l:?,' This is 2 built in profile, wau wil be prompted b enber a new name when you cloees the profile Apply I K i [ Cancel ]

3 Make your changes, click Apply to preview your changes and then click OK to create the
new profile or to exit the Show Profile dialog.

4 Use the preview pane to preview the changes you make to your code formatting
preferences. Changes are not implemented until you click Apply or OK.
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SPECIFY CODE QUALITY PREFERENCES

The Code Quality preferences allow you to specify the severity level for several categories of
problems that result in inefficient or erroneous SQL.

1 Select Preferences > SQL Editor and then in the Preferences dialog, expand SQL Editor
and click Code Quality.

¥ Preferences (Filtered) |:|®

| | | code Quality Sl v
= 0L Development
[=- 53U Editor
Code Assist
Code Formatter

Select the severity level For the Following cateqgories of problems that result in
inefficient or erroneaus SOL:

Missing walid JOIM crikeria; Wiarning W

Code Quality
Results Yiewer Ireealid or missing QUTER JOIM: Warning W
S0L Templates

Synkax Coloring

Transitivity problem: Warning W
Mested query in WHERE clause; Warning W
Wrong place for conditions in HAYING clause: Wiarning W
Index suppressed by a funckion or an arithmetic operator: |Warning
Mismatched or incompatible column bypes: Warning W

MULL column comparison: Warning v

2 Change the severity levels by clicking the list next to the category and choosing the level.

3 To save your changes, click Apply.
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SPECIFY RESULTS VIEWER PREFERENCES
The Results Viewer pane provides configuration options that specify how the Results view
displays or saves results.

1 Select Preferences > SQL Editor and then in the Preferences dialog, expand SQL Editor
and click Results Viewer.

& Preferences (Filtered)

Results Viewer = -
= 531 SDC?E EEE{TEM Result seks options . .
Code Assist faximum number of result sets: _ wo 5
Code Formatter [ suppress execution messages
Code Cualky
:‘;iu:_t;"ﬂ:; %) Sheove results in editor
tax Colar T 1
Syt Coloring Grid refresh interval (me): | 2000 3|
PMacimum resul rows o sort: 25000 5
Results Format: %Grid V:
[#] Stripe the roves of the results bable
[ isplay results in a separate tab in the SOL editor
() Save results to file
[Rastnm Dafau.i]:s] [ apply ]
=
(?) biicoesnalll caealiii

2 Make your preference changes and then save your changes by clicking Apply.

The following describes the preference options available:

¢ Maximum number of result sets: If selected and the executed SQL returns more results
sets than the maximum specified, result sets in excess of the maximum specified will not be

displayed.

e Suppress execution messages: If selected and the SQL you execute returns informational
messages, they will not be displayed.
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24

Show results in editor: Execution results can be either shown in the editor or sent to a file. If
you choose

Grid refresh interval: Indicates the speed in milliseconds that the Results view refreshes.

Maximum result rows to sort: If the number of rows and results exceed this number, the
column sorting in the result set is disabled.

Results format: These are the different formats that can be used to display the results in the
editor.

Stripe the rows of the results table: Adds intermittent highlighted bars in the Results view.

Display results in separate tab in SQL editor: Opens the Results view in a separate
window on the Workbench.

Save results to file: Provides options that let you save the contents of the result sets to a
file. You can also specify the file type, delimiter and text qualifier.
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SPECIFY SQL TEMPLATES PREFERENCES

The SQL Templates panel provides customization options for creating and modifying SQL code
templates.

1 Select Preferences > SQL Editor and then in the Preferences dialog, expand SQL Editor
and click SQL Templates.

The SQL Templates panel displays a list of all SQL code templates currently available.
Additionally, when you select a template from the list, the Preview section displays the code
block as it will appear when the template is selected in SQL Editor.

& Preferences (Filtered)

[ Templates =T -
= 53 Development .
= 5qL Editor Create, edit or remove templates:
Code Assisk Marne Context Descripkion Aubo In, Mew... I
Code Formatter ALLOCATE.., DB2 (5, 9 allocates a cursor Far th... on -
Code Qualty ALTER_TA... DBZ(8, 2 alers atable on i
Resulks Viewer BLTER_TA... DBZ(8, 90 alters a tablespace on §
5L Templates ALTER_YIEW DBZ (8, 9) alters a view on B
Syrtax Colaring ALTER_FUL., DB2(8, 9) alters a Function on
ALTER_ME... DBZ(8,9) altersa methed on Restare Rer
ALTER PR... DB2(8,9) altersa procedure an
ALTER_SE... DBZ (8, 9) alters a sequence an Revert ko Defa
CALL CB2 (8, 9) calls & procedure an
COMMIT CB2 (3, 9) commits the database ... an
DECLARE ... DB2(8, 9) defines atemporary ta... an
DISCOMM,.. DBZ (6, 9) destroys ane ar more ... an Exp
[Pl Peal FIL PRZ 68 4% deane & Function 0
< *
Prewvicw:
[Juse code Farmatter
IREiture Defal.ﬂ;s] [ Apply I
@ P o Il coacet |
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2 Click on the check box beside each template to specify if it is included in the code assist
check or not, within SQL Editor. Use the buttons on the right-hand side of the panel to

create, edit, or delete SQL templates, as needed.

When you create or edit a template, the Edit SQL Template dialog appears.

*¥ Edit SOL Template

Edit context [¥] Automaticalty insert

Name: | ALTER_TABLESPACE
Description: .qddsadctafhmtaﬂew Oracle (8, 9, 10g, 11g) |
Pattern:  ALTER TABLESPACE §

ADD DATAFILE ‘${filehame}’

AUTOEXTEND ON NEXT ${autoExtendvaluel MAKSIZE ${maxSizeValus);

QK

|| cancel

3 Enter a Name, Description, and Pattern in the fields provided, and click OK.

26

If the template name doesn’t match an existing SQL code template, your new template is
added to the list, and will automatically be considered when the code assist function is

executed in SQL Editor.

Select the Use Code Formatter check box to apply code formatting preferences to the

specified template. See "Specify Code Formatter Preferences" on page 20 for more

information about setting code formatter preferences.
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SPECIFY SYNTAX COLORING PREFERENCES

The Syntax Coloring panel provides configuration options that change the look and feel of code
syntax in SQL Editor.

1 Select Preferences > SQL Editor and then in the Preferences dialog, expand SQL Editor
and click Syntax Coloring.

¥ Preferences (Filtered) |T @ El
E w

fpelfberter ]| Syntax Coloring T
= 531 Developrent

= SQL Editor e _
Code Assisk =-50L [“]Enable
Code Formatter Eeyword
Codar:

Code Qualiy Mon-executable command ine E]
Results Viewer M ber [+]Bold
SQL Templates Other [ 1kslic
Syritax Coloring String

[#- Comment

Preview
Table : Accounts ‘:

CREATE TABLE ALCCOUMTS

i
I IHT ,
TYPE VARCHAR (20) DEFAVULT 'CREDIT',
CODE IHT DEFAULT 30 /# Account code &7

1

SET TERMOUT ©N
FRONFT Demonstrate sglplus commands.

SHET TEDWAITT SATE .

[Rsstursbsfalits][ Apply ]

@ | QK H Cancel J

2 Use the tree view provided in the Element window to select the comment type or code
element you want to modify. Select the options to the right-hand side of the window to
modify it.

The Preview window shows a piece of sample code that updates according to the changes
you made.
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SPECIFY SQL EXECUTION PREFERENCES

The SQL Execution preferences you set determine how SQL is executed.

Select Preferences > SQL Execution.

¥ Preferences (Filtered)

| | SOL Execution -

= 3L Development
SGL Execution

Enable auto-cormit For the Following platforms:
Genetic JDBC
IEM DE2 For LLW
IEM DBZ for 205
Firebird
InkerBase
Microsoft SOL Server
Oracle
Svbase ASE

Enable DEMS output (Oracle anly)

The following describes the SQL Execution Preference options available.

Enable auto-commit for the following platforms: When disabled, the SQL is executed
within transactions that must be manually committed.

Enable DBMS output (Oracle only): When disabled, this omits the output statements that
Oracle would otherwise display.

NOTE: If you disable auto-commit for a platform, you must use SQL Editor’s transaction
features to execute code on that platform.

SPECIFY SQL FILTERS PREFERENCES

These are the set of controls that determine what objects are shown in the Data Source Explorer.

Select Preferences > SQL Filters.
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& Preferences (Filtered) |:|®

| | | sOLFilters -

= 50L Development
SGL Filkers The selected filters will be applied in an ARD manner.

IEM DEBZ For LUW | Microsoft SQL Server | Oracle | Svbase ASE

Ignore system objects

Mew, ..

Deselect Al

SPECIFY DATA SOURCE INDEXING PREFERENCES

The Data Source Index is a local repository that stores the schema of registered data sources in
DB Optimizer™ XE Pro 2. DB Optimizer is automatically set to index information about data
sources registered in the development environment.

By default, the Data Source Index captures all catalogs, functions, procedures, tables, and views.
Additionally, after the initial index, the index performs incremental captures of information.

DB OPTIMIZER™ XE PRO 2 USER GUIDE 29




CONFIGURING DB OPTIMIZER™ XE PRO 2 > CUSTOMIZING DB OPTIMIZER™ XE PRO 2 (PREFERENCES)

However, there is a definitive trade-off when indexing a full database schema. The time it takes
to fully capture a large schema and logical space considerations on local workstations, often
makes it inefficient for DB Optimizer™ XE Pro 2 to perform this task each time a new data source
is registered in DB Optimizer™ XE Pro 2. Thus, the Index can be configured via the DB
Optimizer™ XE Pro 2 Preferences dialog to accommodate machine processing ability and
speed.

1 Select Preferences > Data Source Indexing. Change the settings as appropriate:

¥ Preferences (Filtered) |:|@®
v

| | Data Source Indexing

= 0L Development
[raka Source Indexing Enable indexing

[ clear the index on application dose

Index Conkent

Maxirmum number of objects to indes: | 200000 5

Maxirumn index request result size: o000 o

Clear Inde:x

The following describes the Data Source Indexing options

Enable indexing: When enabled, indexing is performed on demand to support code assist
and validation in the SQL editor.

Clear the index on application close: Select to ensure your indexing data is the most up to
date. This is useful in an environment where the database schema changes often.

Index Content

* Maximum number of objects to index: From the list, select the maximum number of
objects to index. Once this maximum number has been reached, older indexing data is
replaced with new information.

¢ Maximum index request result size: From the list, select the maximum index request
result size. This is the maximum number of objects that can be shown in the SQL Assist
suggestion box.
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SPECIFY TUNING JOB EDITOR PREFERENCES

Tuning job editor preferences let you control certain aspects of the appearance of items in the
tuning job editor as well as default behaviors.

1 Using the SQL Optimization perspective, select Preferences > Tuning Job Editor.

& Preferences (Filtered)

- E&X]

Tuning Job Editor

= 5L Development
- Turing Job Editor Conmect bo the buning sowce automsaticaly

Chblways  (OiMever (5 Prompk
Color scheme For plan cost
Baselne: @

Improvement: (M| Threshald () (10 2

Degradation: (BN Threshold (%) (10 3]

Case metution
For nova relisble resuks, it is recommended to average the execution statistics over multiple Funs.

Murmber of iherations: | 1 s

Result set fetch size: | 10 2

Wi ap acle case execiukions in: LI LM Case_gusry
M| Cvarl SELECT COUNT(Y) FROM ([ T

2 Make your changes and then to save your changes, click Apply.
The following describes the options available:

Connect to the tuning source automatically: When you open a tuning perspective, it
automatically opens the last saved tuning jobs that were open when you closed the
application. This option lets you specify whether, in addition, you want to automatically
connect to the data sources associated with these tuning jobs. If you typically review
existing tuning job archives rather than run new tuning jobs, you may wish to explicitly
connect to a data source rather than connect automatically. The options are:

e Always: Automatically connects to data sources associated with tuning jobs that were open
last time you shut down tuning.

® Never: Automatically opens tuning job archives that were open last time you shut down the
application but does not automatically connect to the associated data sources.

® Prompt: Prompts you to connect to data sources associated with tuning jobs that were
open last time you shut down the application.
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Color scheme for plan cost: In the graphical representations of explain plan cost and
elapsed time, tuning uses a color scheme to highlight differences among generated cases.
Values for the original statement are treated as a baseline, and values for individual cases
that are within a specified threshold range of the baseline value are represented with a
Baseline color. For cases whose values are outside the threshold range, Improvement and
Degradation colors are used to represent values in those cases.

TIP:  You can set the threshold in the application preferences, by selecting Window >

Preferences > Tuning Job Editor and then changing the threshold levels as required.

Case execution: Lets you dictate how execution statistics are gathered.

SPECIFY VST DIAGRAMS TUNING PREFERENCES

The preferences on this page allow you to change the default presentation of count information
and sub-query names in Visual SQL Tuning diagrams.

Using the SQL Optimization perspective, select Preferences > Tuning Job Editor > VST
Diagrams.

® Show count information: If enabled, shows the ratios and count information when the VST

diagram is generated. If not enabled, you must click the Ratios/Counts icon ['2]] on the VST
diagram to view ratio and count information.

¢ Hide sub-query names when expanded: If enabled, shows the sub-query name when the
VST diagram is generated. If not enabled, you must right-click anywhere in the VST and from
the menu that appears, choose Show Query Names
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SPECIFY FILE ENCODING PREFERENCES
The Workspace panel provides options for unicode support in SQL files.

Select Preferences > General, expand General and then click Workspace in the tree.

& Preferences (Filtered)

= General

Appearance
Compare/Patch
Conktent Types

Editors
keys

Metwork Conneckions
Perspectives
Search

Security

Startup and Shukdown
Web Browser

Wiorkspace

Workspace P~

See 'Skartup and Shutdown' Far workspace skartup and shutdown preferences,

Build automatically
[ ]refresh automatically
[ ]5ave automatically before build

Wiarkspace save inkerval (in minutes); | 5

Cpen referenced projecks when a project is opened
() always (O Mever (%) Prompt

Texk file encoding Mew kexk File line delimiter
() Default (Cpl2s2) (%) Default
(%) Other: ) other:

5-A5CT1

UTF-16

UTF-16BE

UTF-16LE b

The default encoding for text files on Windows platforms is Cp1252. You can change unicode

support in from file to file using the Text File Encoding options available on the Workspace

panel.

To change text file encoding in the development environment:

1 Select Preferences > General > Workspace and click the Other option under Text File

Encoding.

2 Use the drop down menu and select an encoding mode from the list provided.

3 Click Apply to save your changes.
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To change text file encoding on a specific, folder, or project:

1 Right-click on the file, folder or project that you want to

TIMIZER™ XE PRO 2 (PREFERENCES)

modify and choose Properties.

2 Modify the Text file encoding selection on the Resource properties page that appears.

& Properties for test

| Resource -
Raﬁwr‘cg — - o  bnanmn npn N WHNHM/.o=.=— 1 idl @ W P H  imM . I .
Buibders F“a‘th,t }'t‘est 2
Project References Type:  Project
Refackoring Hiskory Location: C:\Decusnents and Settings| Jacquieldboptimizer Sworkspaceitest
RunDebug Settings Last modified: February 2, 2011 3:32:34 FM
sqL

Teut file encoding
(%) Inherited Fram contsiner (Cp1252)

() Other:

Mew bexk file line delimiter
(%) Inherited From container

) Other:

[Restore Defaults | [ aooke | ¥

I ok ][ canca |
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CREATING AND EDITING PROFILE ALERTS

You can configure DB Optimizer to send you an alert via email if during a profiling session it
detects that database activity has met or exceeded the threshold that you specified.

1 Select Preferences and then in the Preferences dialog that appears, expand SQL
Development and Profile Alerts.

& Preferences |Z@E| |

Profile Alerts b=

(& Ganeral S
Data Saurcas Hame Context Descriphian
Emibarcaders Licensing Criticaly highusage TORLAESQLOO_L... Achve sessions == 100

® Help |

(# - Install fUipdate:

[® FunfDebug Remove

(= 50L Development

[aba Source Indesing
=R Frofie Alerts
Email Conkacks
Email Settings
- 501 Editor
QL Execution
S0l Filters
- Tuning Job Editor
= Team

Mlarts rasat after |5 5 | minutes

[Restore Defautts | [ pply |

@ L_ox J[ concel ]
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2 To create a profile alert, click New.

To edit an existing profile alert, select the alert you want to modify and then click Edit.

The Create Profiling Alert or Edit Profiling Alert dialog appears.

% Create Profiling Alert

€3 Alert name must be specified,

Mame: | | |
Daka source: |TDRL.C'.BSQLEIEI_1 (S0L Server 5.0,2039.0) L7 |
Fite alert when (&) Active sessions meet or exceed | (3 EI

OSessonsinwait. [ | [ 2]

{:} Sessions in wait class:

() all active sessions nok on CPLU

Send email when alert Fires

Display system nokification when alert fires

Cancel

36

Complete the create/edit profiling alert dialog as required and then click OK.
In the Preferences tree, click Email Contacts.

If you select Display system notification when alert fires, you will receive an alert
notification in your Windows system tray when the alert fires.

If you select Send email when alert fires, you must specify email contacts and email server
settings.
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5 To create a new email contact, click New.

To edit an existing email contact, select the contact you want to modify and then click Edit.

¥ Create Email Contact

@ Specify the details of the contact to add,

Mame: | Jacquie |

Email address; | jacqueline@embarcadero, com |

Data Sources

TORLABSOLOO_1 {SOL Server §.0,2039.00

[] TORLABSOLOO 1 #2 (SOL Server 8.0.2039.0)
[] sfvpclbal .embarcadero.com (Oracle 10,2.0.1)
[] TORLABORCLE 3 (Oracle)

[] TORLABORCLE 2 (Oracle 8.1.7.4)

[] ROMLABORCLE 1 (Oracle 5.1.7.4)

[] ROMLABORCLSI 2 (Oracle 9.2.0.1)

[] TORLABORCLYI 1 {Oracle)

[] DsQUERY {S0L Server)

[] HOBO (SQL Server)

[] local {SQL Server)

Select Al ] [ Deselect all ]

[ oK H Cancel ]

6 From the list of Data Sources, select the data sources for which this contact should receive
an email notification that. an alert has fired, and then click OK to save this contact.

7 To configure your email settings, click SQL Development > Profile Alerts > Email Settings.
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& Preferences (Filtered) |:.E]

| | Email Settings g -

= 35L Development
Daka Source Indexing

Email Configuration

= Brofile Alerts SMTP Host: | pop.embarcadero)com |
Ernail Contacts SMTP Fark: | 110 |
Email Settings
0L Editor Sender Address: | dbouser@embarcadero, com |
5L Execution [ authorization Required
AL Filkers
Tuning Job Editor Username: | |
Password: | |

@ O, H Cancel ]

8 Complete the Email Settings as required and click Apply.

Sender Address: This is an email user configured on your email server. DB Optimizer uses
this address to send alerts to the email contacts defined.
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USING DB OPTIMIZER

This section describes how to use the features of DB Optimizer to optimize your database
operations. This section contains an overview of DB Optimizer functionality and also contains
detailed instructions for

e Working with Data Sources on page 39

Working with SOL Projects on page 55
Creating and Editing SQL Files (SQL Editor) on page 59

Troubleshooting on page 84.

WORKING WITH DATA SOURCES

The Data Source Explorer provides a tree view of all registered data sources and associated
database objects. When you first start DB Optimizer, a prompt appears and offers to populate
Data Source Explorer from multiple sources on the system. This includes previously-registered
data sources on other Embarcadero products, and third-party DBMS clients such as TOAD. If DB
Optimizer cannot detect a data source, you can register it manually.

Additionally, you can initiate this feature by clicking the Auto-Discovery button on the Toolbar or
via the File > Import > Embarcadero > Data Sources > Previously Registered Embarcadero
Data Sources (Registry) command from the Main Menu.

E'EI Data Source Explar 22 %’ S0L Project Explore =0
TN

=l =% Managed Data Sources (5] L
=I-=F Data Jource Group ()
=I-T=F Microsaft S0QL Server (2]
+-l=F Microsaft S0L Server (1)
+- i TORLABSQLOO_1_#2 (S0L Server 8.0,20
=I-T=F Oracle (5]
+ i Mew data source (Cracle 8.1.7.4)
+- S ROMLABORCLEI_1 (Oracle 8.1.7.4)
+-Sw ROMLABORCLSI_Z (Oracle 2,2.0,1)
= ﬂ sfvpclb0l  embarcadero,com (Oracls 10,7
+ [__I;:',I Dakabase Obijecks
= |l|_EI Prafiling R.epository
E i romlabsgldSs_1-sa
(8, 2010-01-08 00:46:23 (34m)

+- s TORLABORCLE_2 (Cracle 5.1.7.4) v
< >
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The Profiling Repository entries in the Data Source Explorer are available only when configured
in the Profile Configuration Dialog for Oracle data sources only. These are saved profiling
sessions that you can share with other DB Optimizer users. For information on configuring the

datasource profiles, see "Building Profiling Configurations" on page 42.

REGISTER DATA SOURCES

When DB Optimizer is started, it prompts you to discover data source catalogs that have been
created by any previously installed Embarcadero products (DBArtisan, Rapid SQL, DB
Optimizer), or other instances of DB Optimizer.

Additionally, the system scans your machine for the client software of all supported third-party
DBMS platforms (TOAD, Eclipse Data Tools Platform, etc.). These data sources are automatically
added to the data source catalog.

ﬂi‘j Embarcadero DB Optimizer Motifications b4

(7]

@ wWelcome to Embarcadero DB Dptimizer =

Embarcadero DB Opkimizer can discover daka sources residing on waour
syskem or available on wour network, ¥ou can search for data sources
right now,
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To manually initiate the scan later, click the Discover Data Sources icon [&g] at the top of Data
Source Explorer. The Discover Data Sources dialog appears.

N | - .
T Discover Data Sources

Discover Data Sources
Select the locations to search for data sources.

[#] Fe syshem and network
[#] Eclipse Data Toals Platfarm (DTF)

CFile system: |
[ ] guuest Software (TOADY

[#] Previously registered Embarcadero data sources (Registry)

(7 Bach et >

Cancel

1 Choose the type of data sources you want to scan for and click Next. The wizard
automatically returns all data sources it finds on your machine based on the criteria you

specified
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L
*F Discover Data Sources

Discovered Data Sources

Select from the data sources discovered in the specified locations,

|
= M
- [F]1= 18 DB2 For LW
&[] Orste
2 [¥]1= Microsoft SOL Server
[# 58 Datotbzo
S ROMLABSGLOO_L
#1584 ROMLABSQLOS L
[#158 TORLABSOLOS 1
& [+ Generic JDBC
(1= File system and network
#-[]= o1P

[ selectal || peselectat |

@ [seock J[ o> J[emen J[ concel |

2 Choose the data sources you want to add to the DB Optimizer environment and click Finish.

42

Data Source Explorer automatically populates with the new data source selections.

TIP: To add data sources manually, right-click Managed Data Sources in the Data Source

Explorer tree, select New > Data Source, and enter the connectivity parameters as
prompted.

For additional information on data source connection parameters, see "DBMS Connection
Parameters by Platform" on page 143.

Once registered, the data source appears in the Data Source Explorer view. If you have
created more than one workspace, they all share the same data source catalog.

Once a data source has been registered, the connection parameters are stored locally. In
some cases, a user ID and password are required to connect to a registered data source. DB

Optimizer™ XE Pro 2 can encrypt and save user IDs and passwords to connect
automatically.

NOTE: In some cases, older versions of DB Optimizer and DB Artisan/Rapid SQL are not
compatible with this version of DB Optimizer, and the methods listed above will not
import these older data source catalogs. If you are experiencing difficulties, you can
import the old data sources via the Windows registry by selecting File > Import... >
Embarcadero > Data Sources > Previously Registered Embarcadero Data Sources
(Windows Registry).
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ADD A NEW DATA SOURCE

You can also add a new data source manually.

1 Click File > New > Data Source.

& NMew Data Source: New data source |:|®

Register a new data source

Choose the server byvpe and location For wour new data source,

Generate an unique name based on the alias or the host name

Data source name:

Select a server type: Select a daka source graup:
[} Generic JDBC = =% Managed Data Sources
C'HYIEM DBZ for LW 1= Data Source Group

CHiMicrosoft SOL Server T=" Microsoft SOL Server

£t)5vhase ASE

|:| Create a new server bype-specific subgroup

Select a category: | Mo categary =

2 If you want the system to assign a name to the data sources, select Generate a unique
name based on the alias or the host name.

If you want to enter the data source name, deselect Generate a unique name based on
the alias or the host name and then in the Data source name: field, enter the data source
name.

3 Inthe Select a server type area, select the type you want to add.
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4 In the Select a data source group area, select the data source group where you want the
new data source to appear in the Data Source Explorer.

5 If you want to assign the new data source to a category, useful if you have a large number of
data sources to manage, click the Select a category: list and choose one of the categories.

Select a category: | Mo category

QDevelnpment

C]Test
[ Jon
@ QPdeuctinn

Categorized data sources appear with the color for the designated category on the bottom
left of the data source icon in the bottom of such as g for the Test category and g for the
Production category.

When you open a tuning job or SQL Editor window to create SQL for the categorized data
source you will see that the category color is applied to the top of the window, as follows.

-
| Untitled Tuning Job 4.tun 53

B Overview | B Analysis

£E Overview

Tuning Statements Generate cases [ ]Perform detail anakysis

6 Click Next.
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¥ Hew Data Source: New data source

Configure a new Oracle data source

Enter Oracle-specific conneckion and security credential information for the new
data source.

Cracle
() Use a TNS name alias

{*}} Ilse a direct conneckion

Host/Instance: *|
Port: | 1521
Tvpe: {:} Service name "EJ' SID

Service/sID name:“|

Security credentials

Lser name: |

Passwiord: |

Conneck as: | narrmal b

Auko-conneck (Saves and encrypts password)

[ ] allow trusted connections

©

7 Complete the data source configuration and then click Test Connection. This will ensure
your configuration is correct. If the connection test fails, make the necessary corrections and
then click Finish.

The new data source appears in the Data Source Explorer.
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IMPORT AND EXPORT DATA SOURCES

Some Embarcadero products contain data source catalogs that are shared with DB Optimizer. In
other words, instead of manually adding data sources to the environment, you can import an
existing data source catalog from other Embarcadero products or third-party DBMS sources.

You import Data Sources via the File > Import command in the Main Menu, expanding the
Embarcadero folder in the Data Source Selection tree, and choosing Data Sources.

Select
",

Impoart data sources. | E ] 5

Select an import source:

F- = General
E-EE Cvs

-2 Team

The following types of sources can be imported to Data Source Explorer:
¢ Eclipse Data Tools Platform (DTP)
e Previously Registered Embarcadero Data Sources (File)
® Previously Registered Embarcadero Data Sources (Registry)

® Quest Software (TOAD)
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Once a data source is registered, it automatically appears in Data Source Explorer. Connection
parameters are stored locally, and DB Optimizer™ XE Pro 2 can be set to connect automatically
each time you select the data source from the tree.

Conversely, you can also Export your current data source catalog to a file, which can then be
imported into other instances of DB Optimizer™ XE Pro 2 via the Previously Registered
Embarcadero Data Sources (File) option. This is performed using the File > Export command
in the Main Menu, and then selecting Embarcadero > Data Sources from the tree view in the
Export dialog.

To import data sources:
1 Select File > Import. The Import dialog appears.
2 Choose Embarcadero > Data Sources from the tree and click Next.

3 Choose a source from which you want to import the data sources. You can choose to import
data sources from the DTP, TOAD, or an existing Embarcadero data source catalog stored in
the Windows registry or as a file (created via the Export command). Click Next.

4 Specify the location of the import source and click Finish. Data Source Explorer is
automatically populated with the new data sources.

To export data sources:
1 Select File > Export. The Export dialog appears.
2 Choose Embarcadero > Data Sources from the export tree and click Next.

3 Use the check boxes beside each listed data source to indicate which data sources you want
to export. Click Next.

4 Click Finish.

5 The data sources are automatically exported in the form of an XML file. You can import this
file to other instances of DB Optimizer™ XE Pro 2 via the Import command.

CATEGORIZE DATA SOURCES

To make managing a large number of databases easier, you can assign a category to a data
source. Categorized data sources appear with the color for the designated category on the
bottom left of the data source icon in the bottom of such as g for the Test category and F& for
the Production category. You can categorize a datasource this when you add a new data sources
(see Add a New Data Source on page 43) or by editing the properties of an existing data source.

1 In the Data Source Explorer, locate and then right-click the data source you want to add to
a category.

2 Choose Properties.
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¥ Properties for DSQUERY_#2 (SOL Server)

bype Fiter tect | Data Source Canfiguration : -
- Configur ation A
S0 Fikers Configuration | Advanced |

Data source name: | CSQUERY_#2

Cateqory: Mo category w

Microzoft 50L Serd [ Develogment
() Use a mebwcek [ || Test

oh
Sorver dias ﬁﬁul:h.l:thn

3 From the Category list, choose the category you want and then click OK.

When you create a tuning job for the categorized data source you will see that the category
color is applied to the top of the tuning job data source details, as follows.

-
| Untitled Tuning Job 4.tun 53

L‘-" Overview P Analysis

£E Overview

Tuning Statements Generate cases [ ]Perform detail analysis

BROWSE A DATA SOURCE

You can drill down in the Data Source Explorer tree to view registered databases on a server, and
view tables, and other objects in a database. Additionally, you can view the structure of
individual objects such as the columns and indexes of a table. Right-click the object for a menu
of available commands, such as Extract to Project, which creates a new SQL file containing the
object’s DDL.

In most cases, whenever you browse a data source, DB Optimizer requires login information in
order to connect with the data source. Enter a valid user name and password in the fields
provided. The Auto Connect option retains your login credentials for future connections to the
same data source.

You can turn off the Auto Connect feature by right-clicking on a specified data source and
toggling the Connect on Expand option. By default, when Connect on Expand is active, DB
Optimizer automatically attempts to connect to the server each time you browse a data source.
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VIEW DATABASE OBJECT PROPERTIES

All objects in Data Source Explorer contain properties as they relate to the DB Optimizer
application.

f 5oL = h
93 Data Source Expl &2 . = 50L Project Equ i
R -2 BSY

= T=F Managed Data Sources [ﬂ
1= DBZ Servers
1= M5 50L Servers
% datoearl1 (SOL Server)
j'j datoedwinal (SOL Server 7.0.1094.0)
= % datotb19 (SQL Server 3.0,813.0)
= t‘ﬂ Databases (41)
=[] Applabs
"I" Check Constraints
Ml Defaults
?% Faoreign Keys
fx Functions
Indexes
ﬁ” Primary Keys
;?1 Procedures
&4 Roles
™ Rules
Tables
Triggers
l,"n IUnique Keys
‘*EE IUser Datatypes
& Users
Ga Views
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DB Optimizer Object Properties are viewed via the Properties dialog. The dialog is accessed by
right-clicking the object in Data Source Explorer.

% Properties for TORLABSCORCL {MOVIES) (Dracle 10.2.0.1) :|@|E|
|| | | Data Source Configuration -
Configuration -
251 Fikers Configuration  advanced

Data source name: | TORLASSCORCL (MONIES)

Category: [:]Tc;“: R
COracle
(_JUse & TS name alias

(¥ Use & direck connection

Hostfinstance: | TORLABSCORCL
Part: [ 1521

Type: (_rService name (®1sID

ServicelSID name: | orcl

Sacurity aredenbials
User name:  MOVIES |

Pazzmord:  eesese |

Conneck as: normal
[#] usto-connect {Saves and encrypts password)
[ fliows trusted connections

[Tast Connaction ] l Apphy ]

@)
e

[ o || conca |

To view Data Source Explorer object properties:
The properties are accessed by right-clicking a data source in Data Source Explorer.

The dialog displays properties with regards to Configuration and SQL Filters.

The Configuration node provides information about the parameters used to initially define the
data source during the data source registration process. For more information on these values
and how to modify them, see "Register Data Sources" on page 40.

The SQL Filter node enables a developer to place filters on data source objects that appear in
the Database Explorer. For more information, see Filter Database Objects on page 52.
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SEARCH FOR DATABASE OBJECTS

Database object searches rely on the Object Index when returning results. By default, caching is
set to configure only parts of a database. To configure the Index to expand object searches, see

Specify Data Source Indexing Preferences on page 29.

1

Select Search > Database. By default, the search scope is all currently connected
databases. Under Specify the scope for the search, clear any databases or server check
boxes you do not want to search.

Specify the search criteria:

Type the value to search for in the Search String field. Use the * character to indicate
wildcard string values and the ? character to indicate wildcard character values.

Select Case Sensitive to indicate to the search function that you want case sensitivity to be a
factor when searching for appropriate string matches.

Select Search Indexed Data to indicate that the search function should read the Index. This
increases the performance of the search function and will typically result in faster returns on
any hits the search might make.

Select Apply SQL Filters to apply any relevant database or vendor filters to the search.

Choose Declarations, References, or All Occurrences to specify what the search is
restricted to in terms of database objects.

¢ A Declaration is an instance where an object is declared. For example, an object is
declared in a CREATE table.

¢ A Reference is an instance where an object is used or referred to. For example, an object
is referred to in a procedure or as a foreign key in a table.

e Choose All Occurrences to return both declarations and references in the search results.

Use the check boxes beside the database object panel to select and deselect the specific
database objects that you want to be included in the search process.
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3 Click Search.

The results of your search are generated in the Search view. When you open a matched file,
references to the keyword are flagged with yellow arrow icons that appear in the left-hand
column of the editor.

~ DELETE FROM Shape Edge Display Ver
= WHERE Shape Edge Display ID IN
- (SELECT do.Object_Table Row ID

FROM Diagram Object do,
Meta Table mt

WHERE mt.Name = 'Shape Edge Display' and
do.Herta Table ID = mr.Meta Table ID and
do.Diagram Il = BDelDiagramID)

Jb

DELETE FROM Shape Edge Di=play
WHERE CObject GUID IN

(SELECT do.Object GUID

FROM Diagram Object do,

Heta Table mt
WHERE mt.Name = 'Shape Edge Display' and
do.Heta_Table ID = mt.Meta Table ID and
do.Diagram ID = @DelDiagramID)

You can navigate between keywords within all returned files using the yellow “up” and
“down" arrows that appear at the top of the Search view.

FILTER DATABASE OBJECTS

Filters can be placed on data sources and corresponding data source objects to restrict their
display in Data Source Explorer. This feature is useful if you have data sources that contain large
numbers of database objects. You can apply filters to view only the schema objects you need for
the development process.

There are two types of data source filters available:

* Global filters that affect all registered data sources in the DB Optimizer™ XE Pro 2
development environment.

¢ Data Source specific filters affect only the specified data source for which they are defined.

e On Sybase and SQL Server platforms, you can apply database filters, which enables you to
set different filters on different databases within the same source.

In both cases, data source object filters are defined via the Object Filter Manager, through the
development of filter templates. Once defined, filter templates can be activated and
deactivated as you need them.

Several filter templates can be combined at a global level or applied to a specific data source.

52 DB OPTIMIZER™ XE PRO 2 USER GUIDE



USING DB OPTIMIZER > WORKING WITH DATA SOURCES

See also:
Define Global Database Object Filters on page 53

Define Data Source-Specific Object Filters on page 53

DEFINE DATA SOURCE-SPECIFIC OBJECT FILTERS
Data source-specific object filters affect only the specified data source.

To define data source-specific filters:
1 In Data Source Explorer, right-click the data source and select Properties.

The Properties dialog appears.

2 Select the SQL Filters node and select Enable data source specific settings. The other
controls on the dialog become enabled.

3 Click New. The Filter Template dialog appears.
4 Specify the parameters of the filter.

¢ In the Name field, enter the name of the filter as you want it to appear in the selection
window on the SQL Filter node.

* The Database Type pane provides a list of data source objects. Deselect the data source
objects that this template filters so that they do not appear in Database Explorer when
displaying data source objects for the data source.

e Click New to add filter parameters for data source object properties. The New SQL Filter
Predicate dialog appears.

e Use the Property and Operator fields to supply the filter criteria. Property specifies
whether the value is a Name or Schema, and Operator specifies the matching type of the
filter syntax. (Equals, Not Equals, Like, Not Like, In, Not In)

* In the Value field, enter the full or partial syntax of the property or properties you want to
filter in Data Source Explorer.

5 Click OK. The filter property specification is added to the Filter Template.

6 When you have finished defining the filter template, click OK. The template name is added
to the Properties dialog. It can be enabled and disabled by selecting or deselecting the
check box beside its name, respectively.

DEFINE GLOBAL DATABASE OBJECT FILTERS

Global filters affect all registered data sources in the DB Optimizer™ XE Pro 2 development
environment. When you create and apply a global filter to a platform vendor in DB Optimizer™
XE Pro 2, all databases associated with that vendor are affected by the filter, as defined.
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Individual global filter templates are separated, by supported data source platform, on tabs in
the SQL Filter window. Select the appropriate tab to view existing filter templates or add new
ones, as needed.

To define a global filter:

1
2

Select Window > Preferences from the Main Menu. The Preferences dialog appears.

Expand the SQL Development node and select the SQL Filter subnode. The SQL Filter
pane appears.

Click New. The Filter Template dialog appears.
Specify the parameters of the filter template:

In the Name field, enter the name of the filter as you want it to appear in the selection
window on the SQL Filter node.

The Database Type pane provides a list of data source objects. Deselect the data source
objects that this template filters so that they do not appear in Database Explorer when
displaying data source objects for the data source.

Click New to add filter parameters for data source objects properties. The New SQL Filter
Predicate dialog appears.

Use the Property and Operator fields to supply the filter criteria. Property specifies whether
the value is a Name or Schema, and Operator specifies the matching type of the filter
syntax. (Equals, Not Equals, Like, Not Like, In, Not In)

In the Value field, enter the full or partial syntax of the property or properties you want the
template to filter in data source Explorer.

Click OK. The filter property specification is added to the Filter Template.

When you have finished defining the filter template, click OK. The template name is added
to the Properties dialog. It can be enabled and disabled by selecting or de-selecting the
check box beside its name, respectively.

TIP: Data Source object filters are added and removed from the development environment
by selecting and de-selecting the checkboxes associated with each filter template on
both the global and data source-specific dialogs.

DROP A DATABASE OBJECT

To delete an object permanently from a database, right-click the object in Data Source Explorer
and choose Drop from the menu. The Drop Wizard prompts you to confirm removal of the
object and provides a DDL preview of the deletion code.

54
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WORKING WITH SQL PROJECTS

You create projects to organize and store SQL development files. The purpose of projects is to
keep your work-in-progress files organized, as well as maintain a common directory structure
when developing code and executing files on registered data sources. Once a file has been
developed and is ready for deployment, that file can then be executed on a registered data
source.

SQL Project Explorer is used to view and access files. It uses a tree view to display the project as
a series of folder directories with a folder labeled with the project name as the parent directory,
and with project categories, and associated project files as its children.

5 pata source Explor | 25 50U Project Explore 21 . —

= !ﬁu:l Jaquis
1 4 Connections
& ] Creation Scripts
=T General SOL
= % Insert
#3 schamahlame. tableflame
£i¥ Untithed 50050

* -f;L S Project

[# Untitled Tuning Job22.bun
[ vritled Tuning Jokw.tun

All files in an SQL Project project are organized under the following categories:

e Connections: List the connections of any given SQL file of a data source associated with the
project.

¢ Creation Scripts: Provide DDL statements and statements that define database objects.

® General SQL: Provide a category for all other SQL files that are not used in database object
creation. This includes DML files, and so on.

e Large Scripts: Contain all files larger than the currently set SQL Editor preference. The file
size limit can be modified on the Preferences panel by selecting Window > Preferences in
the Main Menu.

Physically, the projects and files you create as you work in DB Optimizer™ XE Pro 2 are stored
under the Workspace directory you specified at the prompt when DB Optimizer™ XE Pro 2 was
started. The directory and files can be shared, and other tools can be used to work on the files,
outside the DB Optimizer™ XE Pro 2 development environment.

You can move existing files within a project by clicking and dragging the file you want to move in
the Project Explorer from one node to another, or via the File > Move command.

CREATE A NEW SQL PROJECT

1 Select File > New > SQL Project from the DB Optimizer™ XE Pro 2 Main Menu. The New
Project Wizard appears.

2 Enter the appropriate information in the fields provided:
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* Name: Enter the name of the project as you want it to display in the Project Explorer view.

e DBMS Platform: Select the data source platform to which the new project will be
associated. This enables DB Optimizer™ XE Pro 2 to properly parse SQL development code
for project files.

¢ Location: When selected, the Use Default Location check box indicates the project is to be
created under the currently selected Workspace. Deselect the check box and specify a new
folder path if you do not want to create the project in the currently selected Workspace.

3 Click Finish. The new project icon appears in the Project Explorer view under the name that
you specified. If you did not select Use Default Location, the project will appear in the
appropriate Workspace when you open it in DB Optimizer™ XE Pro 2.

NOTE: Alternatively, you can select New > SQL Project from the Main Menu or click the New
Project icon in the Tool Bar to create a new project.

OPEN AN EXISTING PROJECT
You can open projects by navigating to SQL Project Explorer and expanding the node of the
project that contains the files you want to access.

Below each project name are a series of nodes that categorize any existing SQL files by
development type:

e Connections: Lists the connections of any given SQL file of a data source associated with
the project.

¢ Creation Scripts: General data source object development scripts. This node contains DDL
statements and statements that define database objects.

® General SQL: Provides a category for all other SQL files that are not used in database object
creation. DML files, etc.

e Large Scripts: Contains all files larger than the currently set SQL Editor preference. The file
size limit can be modified on the Preferences panel. (Choose Window > Preferences in the
Main Menu to access the panel.)

NOTE: Physically, the projects and files you create as you work in DB Optimizer™ XE Pro 2 are
stored under the project directory that you specified at the prompt when the project
was created. The directory and files can be shared, and other tools may be used to
work on the files, completely exempt from the DB Optimizer™ XE Pro 2 development
environment.

SEARCH A PROJECT

1 Select Search > File.

2 Specify the search criteria:
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Type the value to search in the Containing Text field. Use the * character to indicate
wildcard string values, the ? character to indicate wildcard character values, and the \
character to indicate an escape character for literals (* ? /).

Select Case Sensitive and indicate to the search function that it should take into account
case when searching for appropriate string matches.

Select Regular Expression to indicate to the search function that the string is a regular
function.

In the File Name Pattern field, specify the extension name of the files to search for explicitly.
If the value in this field is a * character, the search function searches all files regardless of
extension. Manually type in the extensions to indicate file type (separate multiple file types
with commas), or click Choose and use the Select Types dialog to select the file extensions
the process will search for the string by.

Select Consider Derived Resources to include derived resources in the search.

Select Workspace or Working Set to choose the scope of the search. If you choose
Working Set, specify the name of the defined working set manually, or click Choose and
navigate to the working set you want to search for in the provided string.

Click Search. The results of your search are generated in the Search view on the Workbench.

ADD FILES TO A PROJECT

Existing files that reside in directories outside of the workspace can be added to a project via the
following methods:

¢ Dragging and dropping the file set from a system directory to SQL Project Explorer.
e Copying and pasting the file set from a system directory to SQL Project Explorer.

e Executing the Import command.

To drag/drop or copy/paste files from a system directory to SQL Project Explorer:

1

With the SQL Project Explorer view open, navigate to the directory where the files you want
to add to the project are located on the system.

Drag and drop the files you need from Windows Explorer into SQL Project Explorer. The files
appear in the tree view under the appropriate categories.

NOTE: Alternatively, you can use the Copy command on the files you want to add in Windows
Explorer, and then right-click the Project Explorer and select Paste from the menu. The
files appear in the tree view under the appropriate categories.
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To use the Import command:

1

Right-click anywhere on the Project Explorer and select Import. The Import dialog appears.

2 Expand the General node and double-click File System. A dialog containing the import

specification parameters appears.

In the From directory field, manually type the directory location of the files you want to
import to Project Explorer, or click Browse and navigate to the appropriate folder. The
panels below the field populate with the folder selection and a list of suitable files contained
in that folder. Use the check boxes beside each folder and file to specify what folders/files
you want the import function to add in Project Explorer.

In the Into folder field, manually type the name of the folder within Project Explorer where
you want to import the files specified in the panels above, or click Browse and navigate to
the appropriate folder.

Select the Overwrite existing resources without warning check box if you do not want to
be prompted when the import process overwrites Project Explorer files that contain the
same name as the imported files.

Choose Create complete folder structure or Create selected folders only, depending on
whether you want the import process to build the folder structure of the imported directory
automatically, or only create those folders you selected in the panels above, respectively.

Click Finish. The import process moves all selected folders and files into Project Explorer
and thus into the DB Optimizer™ XE Pro 2 development environment.

NOTE: In addition to accessing the Import command via the shortcut menu, you can also
access the Import dialog by choosing File > Import... from the Main Menu.

DELETE A PROJECT

You can delete a project by right-clicking its folder in the SQL Project Explorer and selecting
Delete.

When you delete a project, DB Optimizer™ XE Pro 2 will prompt you with a Confirm Project
Delete dialog that asks you to confirm the deletion of the project, and offers you the option of
deleting the project from the DB Optimizer™ XE Pro 2 interface, or deleting the project from the
system.
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e If you select Do not delete contents, the files and directory structure will be removed from

SQL Project Explorer, but they will still exist on your machine.

e If you select Also delete contents ..., the files and directory structure will be removed from

SQL Project Explorer and deleted from your machine.
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CREATING AND EDITING SQL FILES (SQL EDITOR)

The SQL Editor is a Workbench interface component that enables the development, viewing,
and formatting of SQL code.

@Bensnn.sql &3 |:| sglLog.log

CREATE TABLE dbo.ben=on

|
ok char(8) NOT NULL,
=al numeric(38,0) NOT NULL,
loc numeric(38,0) NOT MULL,
CONSTELINT pjob
PRIMARY EEY CLUSTERED (job)

)

qo
IF COBJECT ID('dbo.benson') IS NOT MNULL
PRINT '<<«< CREATED TABLE dbo.benson >>>'
ELSE
PRoNT '<<« FAILED CEEATING TABLE dbo.benson >>>'
oo

The Editor supports the following the functionality
¢ Code assist:

e Code complete: Type Ahead and Name completion. For more information, see
"Understanding Code Assist" on page 65.

e Code templates: Templates for creation of tables, procedures, etc. For more information,
see "Understanding SQOL Templates" on page 77.

e Hyper links. For more information, see "Understanding Hyperlinks" on page 68.

e Semantic validation. For more information, see "Sematic Validation" on page 60.

® Object hovering: Hover over an error found and an explanation of the cause of the error
appears.

e Code formatter. For more information, see "Understanding Code Formatting" on page 69.

e Code correction and transformations, For more information, see "Examples of
Transformations and SQL Query Rewrites" on page 74.

® Object indexing: For more information, see "Specify Data Source Indexing Preferences" on
page 29.

e SQL Project Explorer. For more information, see "Working with SQL Projects" on page 55.
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SQL Editor contains context-sensitive command menus that are tailored with pertinent
functionality for the specified file format.

If SQL Editor does not recognize a selected file format, DB Optimizer™ XE Pro 2 automatically
launches the file externally in the system default application. External editors are not embedded
in the Workbench. For example, on most machines, the default editor for HTML files is the
system Web browser. SQL Editor does not, by default, recognize HTML files, and opening an
HTML file from the Workbench launches the file in an instance of the Web browser instead of the
Editor.

Any number of instances of SQL Editor can be open on the Workbench at the same time.
Multiple instances of SQL Editor displaying different content may be open in the same
Workbench. These instances will be stacked by default, but can also be tiled side-by-side so the
content of various files can be viewed simultaneously for comparison or multi-tasking purposes.
When an instance of SQL Editor is active, the Workbench Main Menu automatically contains
commands applicable to the file format. If a view is active, SQL Editor commands are disabled
automatically, except when commands are still valid between the selected view and the file
displayed in the interface.

Sematic Validation

When working with code in SQL Editor, the window contains a number of features that provide
an increase in the efficiency and accuracy of code development. The following syntax
highlighting changes are automatically applied to code as a user adds lines in the interface.

Code Formatting
Comments Green font, italics
SQL Commands Dark blue font
Coding Errors Red underline
Strings Red font
Non-Executable Command Line Aqua font
Commands

Single line and multiple line comments appear in different colors.

Furthermore, SQL Editor provides two column bars, one on either side of the code window. The
purple change bar in the left-hand column indicates that the line of code has been modified.
Hover over the change bar to display the original code text. The red square in the right-hand
column indicates that there are errors in the code window. Hover the mouse over the square to
view the error count. Click the red bar in this column to navigate directly to the line in which the
SQL Editor detects the error. SQL Editor automatically highlights the appropriate code. Non-
executable command line commands are displayed in a different formatting style than SQL
commands. Syntactic and semantic errors are also highlighted.

SQL Editor also features dynamic error detection, object lookup and suggestion features, code
folding, and auto-formatting. SQL Editor is able to identify different areas in a statement, and
enables users to retrieve subclauses, resolve table aliases, and dynamically return lists of tables,
views, and columns, as needed.
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See also:
Working in SOL Editor on page 61

CREATE AN SQL FILE
1 Create or open a SQL project.

2 Select File > New > SQL File. A blank instance of SQL Editor appears.

NOTE: If you are not in a SQL project when you create a new SQL file, it will not open in SQL
Editor.

OPEN AN EXISTING SQL FILE
1 Open the SQL project containing the file, or that you want to contain the file.

2 If necessary, add the file to the project. (see "Add Files to a Project" on page 57)

3 Inthe SQL Project Explorer, double-click the file to open it in SQL Editor.

WORKING IN SQL EDITOR

SQL Editor handles SOL code formats and contains context-sensitive command menus, tailored
with pertinent functionality for development purposes. Other files may be opened in DB
Optimizer™ XE Pro 2, as well, but these are handled by other editors.

For example, if a text file is opened in the Workbench, DB Optimizer™ XE Pro 2 detects and
opens the contents of that file in a text editor viewer with pertinent commands for that file type.
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Any number of instances of SQL Editor can be active on the Workbench at the same time.
Multiple instances of SQL Editor displaying different content may be active on the same
Workbench. These instances will be stacked, by default, but can also be tiled side-by-side, so
the content of various files can be view simultaneously for comparison or multi-tasking purposes.
When an instance of SQL Editor is active, the Main Menu contains commands applicable to the
file format. If a view is active, SQL Editor commands are disabled automatically, except when
commands are still valid between the selected view and the file displayed in the interface.

[s, *Benson.sql 3

FREATE TABLE dbo.benson
!
job char(8) NOT NULL,
sal numeric(38,0) NOT NULL,
loc numeric({38,0) HOT NULL,
CONSTRAINT piob
PRIMARY KEY CLUSTERED (job)
)

oo
IF OBJECT ID('dbo.benson') IS NOT NULL
PRINT '«<«<«< CREATED TABLE dbo.benson >>>'
ELSE
PRINT '"<«<«< FATLED CEREATING TABLE dbo.benson »>»>>'
oo

Among the commands SQL Editor supports via the right-click menu:

® Revert File: Automatically restores the working file to the original text as it appeared the last
time the Save command was issued.

¢ Shift Right/Shift Left: Indents the line of code in the working file to the right or left,
respectively.

* Toggle Comments: Hides or displays comments in the code of the working file, depending
on the current hide/show state.
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¢ Add Block Comment/Remove Block Comment: A block comment is used to insert a
comment into SQL code that spans multiple lines and begins with a forward slash and
asterisk. While block comments are typically used to insert a command that spans multiple
lines, some developers find them more useful than line comments, especially if a
development team is using different text editors on an individual basis. Moving code from
one text editor to another often breaks line comments in the middle of a line and causes
errors. Block comments can be broken without causing errors.

NOTE: In addition to editing commands, some commands such as extract, drop, and execute
can be accessed by right-clicking over statements in SQL code that are performed on
specific tables, views, and columns. These commands will appear automatically in the
appropriate menu when the code is highlighted. Full information on using these
commands is found elsewhere in this documentation, based on the task each
executable performs.

¢ Explain Plan: An explain plan details the steps that occur in SELECT, UPDATE, INSERT, and
DELETE statements and is primarily used to determine the execution path followed by the
database in its SQL execution.

See also:
e Understanding Automatic Error Detection on page 63

Understanding Code Assist on page 65

Understanding Hyperlinks on page 68

Understanding Code Formatting on page 69

Understanding Code Folding on page 73

Understanding Code Quality Checks on page 73

Understanding SQL Templates on page 77

UNDERSTANDING AUTOMATIC ERROR DETECTION

SQL Editor orders and classifies SQL statements. This enables it to edit code as you work within
SQL Editor and highlight errors and typographical errors in “real time”. As you work, SQL Editor
examines each clause in a statement and provides error reporting and other features as
required.

SQL Editor identifies the following clauses and elements:
e SELECT: Specifies the field, constants, and expressions to display in the query results.
* FROM: Specifies one or more tables containing the data that the query retrieves from.

e WHERE: Specifies join and filter conditions that determine the rows that query returns. Join
operations in a WHERE clause function in the same manner as JOIN operations in a FROM
clause.
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* GROUP BY: Specifies one or more columns used to group rows returned by the query.
Columns referenced in the SQL SELECT statement list, except for aggregate expressions,
must be included in the GROUP BY clause. You cannot group by Memo, General or Blob
fields.

¢ HAVING: Specifies conditions that determine the groups included in the query. If the SQL
statement does not contain aggregate functions, you can use the SQL SELECT statement
containing a HAVING clause without the GROUP BY clause.

¢ ORDER BY: Specifies one or more items used to sort the final query result set and the order
for sorting the results.

As you develop code in SQL Editor, it automatically detects semantic errors on a line-by-line
basis. Whenever an error is detected, the line is flagged by an icon located in the left-hand
column of the editor.

|i“_y- benson |5_“_y- *ADDRESS_ROLE E@ *Benson.sgl 23

—“'CREATE TALELE dbo.ben=on
i
job CHAR (8) NOT MNULL,
szal NUMERIC (38, 0) NOT NULL,
loc NUOMERIC (38, 0) HOT MNULL,
CONSTRAINT pjob PRIMARY KEY CLUSTERED (job)

Jo
IF CBJECT ID('dbo.benson' IS5 HOT HULL
PRINT '«<<« CREATED TAEBLE dbo.benson >>>'
ELSE
] PRoNT '<<« FAILED CEREATING TABLE dbo.benson »>>>'
oo
SISELECT *

@ FROM tbo.benson:
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Additionally, all semantic errors detected in SQL Editor are displayed in the Problems view.

(& Problems 3

3 errors, 0 warnings, 0 infos

Description Resource Path Location
= ‘- Errors (3 items)
€3 An unexpected token ™< << FAILED CR Benson.zgl SQL Project 1 line 14
€3 An unexpected token ™" was found. Exp File.sql SQL Project 1 line &
€3 Table benzon cannot be resolved on 'da Benson.zgl SQL Project 1 line 19

Right-click the an error and select Go To in order to find the error. DB Optimizer™ XE Pro 2
opens and navigates to the specific line of code containing the specified error.

NOTE: Automatic error detection functions, such as syntax checking and semantic validation
are suspended if #define or #include directives are detected in an editor window. DB
Optimizer™ XE Pro 2 does not perform #define/#include substitutions on execution.

UNDERSTANDING CODE ASSIST

When SQL Editor has finished analyzing a partial piece of code, it displays a list of data source
objects for you to select from.

SQL Editor takes the following into consideration when analyzing code for a list of possible data
source objects for insertion:

e Text to be inserted

e Original text to be replaced

e Content assist request location in original text

e The database object represented by the insertion text

Generally, insertion suggestions use the following format:

<insertion_text > - <qualification_information >

Code assist is available for SELECT, UPDATE, INSERT, and DELETE statements, as well as stored
procedures, and functions (built-in and user defined.)

Additionally, code suggestions can be made for DML statements nestled within DDL statements.
This functions in the same manner as code assist for statements that are not nestled, and applies

to CREATE PROCEDURE, FUNCTION, TRIGGER, TABLE, and VIEW statements.

When the code assist window is open, you can filter out singular object suggestions by pressing
(Ctrl + Spacebar). This removes all objects from the assist window while retaining procedures
and functions. To display objects again, press (Ctrl + Spacebar) again.
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The following table displays a list of all possible object suggestions, and the format in which SQL
Editor inserts the suggestions into a statement:

Object and Stored Procedure Suggestions

Object Suggestion Syntax/Example

Table (TABLE) [catalog].[schema]
EMPLOYEE - (TABLE)HR

Alias Table (TABLE ALIAS)

[catalog].[schema]tableName
EMPLOYEE-(TABLE ALIAS)HRJOBS

Column datatype - (Column)
[catalog].[schema].tableName

JOB_TITLE: varchar(20)-
(Column)HRJOBS

Alias Column datatype - (COLUMN ALIAS)
[catalog].[schema].tableName.
columnName

JOB_TITLE:int-(COLUMN
ALIAS)HR.JOBS.JOB_ID

Schema (SCHEMA)) [catalog]
dbo-(SCHEMA)NorthWind

Catalog (CATALOG)

Call Call HR.ADD_JOB_HISTORY

Function Suggestions

Function Suggestion Syntax/Example

Built-in SELECT A FROM HR.DEPARTMENTS
WHERE HR.DEPARTMENTS AVG

User-Defined SELECT + FROM HR.CLIENTS WHERE
HR.F_PERSONAL

NOTE: Function suggestions are only available for Oracle and DB2 platforms.
SQL Editor detects incomplete or erroneous code, processes the code fragments, and then
attempts to apply the appropriate logic to populate the code.

As code is typed into SQL Editor, the application ‘reads’ the language and returns suggestions
based on full or partial syntax input.

Depending on the exact nature of the code, the automatic object suggestion feature behaves
differently; this enables SQL Editor to provide reasonable and ‘intelligent’ suggestions on
coding.
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Additionally, semantic validations can be made for DML statements nestled within DDL
statements. This functions in the same manner as validation for top-level statements, and
applies to CREATE PROCEDURE, FUNCTION, TRIGGER, TABLE, and VIEW statements.

The following chart displays the possible statement fragments that SQL Editor will attempt to

suggest/populate with objects:

Statement Fragment Elements

Object Suggestion Behavior

SELECT

A list of tables, when selected
automatically, prompts the user to
select a column.

UPDATE and DELETE

A list of tables appears in the FROM
and/or WHERE clause.

INSERT

A list of tables and views appears in the
INSERT INTO and OPEN BRACKET
clause prior to values.

A list of columns based on the table or
view name appears in the OPEN
BRACKET or VALUES clause.

In addition to DML statements, SQL Editor also suggests objects based on specific fragmented

syntax per line of code:

Statement Syntax

Object Suggestion Behavior

A partial DML statement (for example
SEL ... indicates a fragment of the
SELECT clause)

The keyword is completed
automatically, assuming SQL Editor
can match it. Otherwise, a list of
suggested keywords is displayed.

If the preceding character is a period,
and the word prior is a table or view, a
list of columns appears.

If the word being typed is a part of a
table name (denoted by a schema in
front of it) the table name is
autocompleted.

If the word being typed has a part of a
column name (denoted by a table in
front of it) the column name is
autocompleted.

Without typing anything.

A list of keywords appears.

A period is typed.

If the word prior to the period is a
name of a table or view, a list of
columns is displayed.

If the word prior to the period is a
schema name, a list of table names is
displayed.

If the word prior to the period is either
a table name or a schema name, then
both a list of columns and a list of table
names is displayed.
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To activate code suggestions:

By default, code suggestions are automatically offered if you stop typing in SQL Editor for one
second. You can turn off the automated suggestion feature on the Code Assist preferences
page.

If automated code suggestion is disabled, you can still access the suggestion window using the
following method:

1 Click the line that you want SQL Editor to suggest an object for.

2 Press (CTRL + Spacebar) on your keyboard. SQL Editor ‘reads’ the line and presents a list of
tables, views or columns as appropriate based on statement elements.

NOTE: On a per platform basis, auto-suggestion behavior may vary. (For example, the WITH
statement on DB2 platforms.)

To modify object suggestion parameters, including setting it from automatic to manual, see
"Specify Code Assist Preferences" on page 18.

You can speed up the performance of the code assist functionality by enabling datasource
indexing either when you connect to the datasource, see "Working with Data Sources" on

page 39 or on the Preferences page, see "Specify Data Source Indexing Preferences” on
page 29.

UNDERSTANDING HYPERLINKS

SQL Editor supports hyperlinks that are activated when a user hovers their mouse over a word
and presses the CTRL key. If a hyperlink can be created, it becomes underlined and changes
color. When the hyperlink is selected, the creation script for the hyperlink object is opened in a
new editor.

Hyperlinks can be used to link to tables, columns, packages, and other reference objects in
development code. Additionally, hovering over a hyperlink on a procedure or function of a call
statement will open it. You can also use the hyperlink feature on function calls in DML
statements.

Clicking a hyperlink performs an action. The text editor provides a default hyperlink capability. It
allows a user to click on a URL (for example, www.embarcadero.com) and database object links.

Hyperlink options (look and feel) can be modified via the Hyperlinking subnode in the Editors >
Text Editors node of the Preferences panel.

NOTE: Hyperlink functionality relies on certain objects being captured in the Object Index. If
the index is turned off, or has been restricted in what information it captures, users will
be unable to link them (as they are non-existent within the Index.) To specify object
index types, see "Specify Data Source Indexing Preferences" on page 29.
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UNDERSTANDING CODE FORMATTING

Code formatting provides automatic code formatting in SQL Editor while you are developing
code.

To access the code formatter, select the open editor you want to format and select Ctrl+Shift+F.
The code is formatted automatically based on formatting parameters specified in the Code
Formatter subnode of the SQL Editor node in the Preferences panel.

You can also format an entire group of files from Project Explorer. To do so, select the directory
or file and execute the Format command via the shortcut menu. The files will be formatted
automatically based on your formatting preferences. See "Specify Code Formatter Preferences"
on page 20 for more information.

The following examples display a list of code formatting parameters and the resultant output in
SQL Editor, based on the same set of SQOL statements.

Custom Code Formatting Example 1

The following chart indicates a list of custom code formatting parameters and their
corresponding values. The chart is followed by the actual syntax as it would appear in SQL
Editor, based on the formatting parameter values. Compare the parameters and formatted code
in Example 2 with this example for a concept of how custom formatting works.

Custom Code Formatting Parameter | Value (if applicable)

Stack commas separated by lists? Yes
Stack Lists with ___ or more items. 3
Indent Size? 2
Preceding commas? Yes
Spaces after comma? 1

Trailing commas? -

Spaces before comma? -

Right align FROM and WHERE clauses | Yes
with SELECT statement?

Align initial values for FROM and Yes
WHERE clauses with SELECT list?

Place SQL keywords on their own line? | No

Indent size? -
Indent batch blocks? Yes
Number of new lines to insert 1
Indent Size 5
Right Margin? 80
Stacked parentheses when they No

contain multiple items?

Stack parentheses when list contains -
___ormore items.
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Custom Code Formatting Parameter Value (if applicable)
Indent Size? 5
New line after first parentheses? No
Indent content of conditional and Yes
looping constructs?
Number of new lines to insert? 1
Indent size? 5
(59l Filesgl &3

Begin

If =5
SELECT apple

(] » pear

' prange ‘Big Orange’
' strawberry

' orchard name

' owner

FROM fruit F, orchard ©
WHERE fruit region in (‘latin america’

' ‘france*
' ‘rus=ia”
' ‘canada*
' Yhawaiif)

and orchard not in (=elect region

70

from bad growers bg, (select orchard
from hybrid growers
where us_approved in
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Custom Code Formatting Example 2

The following chart indicates a list of custom code formatting parameters and corresponding
values. The chart is followed by the actual syntax as it would appear in SQL Editor based on the
formatting parameter values. Compare the parameters and formatted code in Example 1 with
this example for a concept of how custom formatting works.

Custom Code Formatting Parameter Value (if applicable)
Stack commas separated by lists? Yes

Stack Lists with ___ or more items. 2

Indent Size? 0

Preceding commas? -

Spaces after comma? Yes
Trailing commas? Yes
Spaces before comma? 2

Right align FROM and WHERE clauses with SELECT statement? | No
Align initial values for FROM and WHERE clauses with SELECT -

list?

Place SQL keywords on their own line? Yes
Indent size? 4
Indent batch blocks? No
Number of new lines to insert 1
Indent Size 5
Right Margin? 80
Stacked parentheses when they contain multiple items? Yes
Stack parentheses when list contains __ or more items. 2
Indent Size? 2
New line after first parentheses? Yes

Indent content of conditional and looping constructs? -

Number of new lines to insert? 1

Indent size? 5
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=
(59l *File,sql &
Begin
If ==5
SELECT
apple ,
pear ,
a3 orange ‘'‘Big Crange’ ,
strawberry ,
ocrchard name ,
aWner
FROM
fruit F ,
orchard ©
WHERE
fruit region in |
‘latin america® ,
‘france® ,
‘russiat
‘canada*® .,
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UNDERSTANDING CODE FOLDING

SQL Editor features code folding that automatically sorts code into an outline-like structure
within the editor window for easy navigation and clarity while developing code.

5, =ADDRESS_ROLE &2 . [5% *Benson.sql

CREATE DEFAULT ET FALSE A5 O
oo
+IIF OBEJECT ID({'FERFCNTR KES.ET FRLSE') IS NCOT NULL]
go
~'CREATE TAELE PERFCHTER ES5.ADDRESS ROLE
{

ADDRESS ROLE_ID numeric(10,0) IDENTITY (20000,1),
NAME varchar (128) NOT NULL,

DESCRIPTICN varchar (255) NULL,

LIST ORDER int NOT NULL,

IS_DEFAULT bit NOT NULL,

IS_SYSTEM REQUIRED bit NOT NULL,

ROWTIMESTAMP datetime CONSTRAINT DF ADDRESS R ROWTI__ 1BF

COMSTRAINT ADDRESSROLEPE
PRIMARY KEY CLUSTERED (ADDRESS ROLE ID)

}

oo
EXEC SE_bindEfE'.'.Jlt 5 PE_:.]:_::'IT_:._Z{.S = ET_]:_;L:SE L ;L::_:.ESS__:.C:E A | 3_:3]:_;'-1__T:T :
go

(%] EX sp_]::indrule 'PERFCHMTE ES.TRUECEFALSE', ';L::_:.ESS__:.C:E : :3_:3]:_7__711' !
(€] 1 '

The editor window automatically inserts collapsible nodes in the appropriate lines of code for
organizational purposes. This enables you to expand and collapse statements, as needed, while
developing code in particularly large or complicated files.

UNDERSTANDING CODE QUALITY CHECKS
Code quality markers provide annotations that prevent and fix common mistakes in the code.

These notes appear in a window on any line of code where the editor detects an error, and are
activated by clicking the light bulb icon in the margin or by pressing Ctrl + |.

For example, if a statement reads select * from SCOTT.EMP, SCOTT.DEPT, when you click the
light bulb icon or press Ctrl + |, a window appears beneath the line of code that suggests Add
join criteria.

When you click on a proposed fix, the statement is automatically updated to reflect your change.
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The following common errors are detected by the code quality check function in the editor:

Code Quality Check Type

Definition

Statement is missing valid JOIN criteria

If a SELECT statement contains missing join criteria, when it is executed, it
can produce a Cartesian product between the rows in the referenced
tables. This can be problematic because the statement will return a large
number of rows without returning the proper results.

The code quality check detects missing join criteria between tables in a
statement and suggests join conditions based on existing foreign keys,
indexes, and column name/type compatibility.

Example
The following statement is missing a valid JOIN criteria:

SELECT * FROM employee e,customer c, sales_order s
WHERE e.employee id = c.salesperson_ id

The code quality check fixes the above statement by adding an AND
clause:

SELECT * FROM employee e,customer c, sales_order s
WHERE e.employee id = c.salesperson_id AND
s.customer_id = c.customer_id

Note: This code quality check is valid for Oracle, DB2, and Sybase-specific
join conditions.

Invalid or missing outer join operator

When an invalid outer join operator exists in a SELECT statement, (or the
outer join operator is missing altogether), the statement can return
incorrect results.

The code quality check detects invalid or missing join operators in the
code and suggests fixes with regards to using the proper join operators.
Example

The following statement is missing an outer join operator:

SELECT * FROM employee e, customer c WHERE
e.employee id = c.salesperson id (+) AND c.state =
\ CAI

The code quality check fixes the above statement by providing the missing
outer join operator to the statement:

SELECT * FROM employee e,customer c WHERE
e.employee id = c.salesperson_id(+) AND
c.state(+) = ‘CA’

74
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Code Quality Check Type

Definition

Transitivity issues

The performance of statements can sometimes be improved by adding
join criteria, even if a join is fully defined. If this alternate join criteria is
missing in a statement, it can restrict the selection of an index in Oracle’s
optimizer and cause performance problems.

The code quality check detects possible join conditions by analyzing the
existing conditions in a statement and calculating the missing, alternative
join criteria.

Example
The following statement contains a transitivity issue with an index problem:

SELECT * FROM item i, product p, price pr WHERE
i.product id = p.product id AND p.product id =
pr.product id

The code quality check fixes the above statement with a transitivity issue by
adding the missing join condition:

SELECT * FROM item i, product p, price pr WHERE
i.product id = p.product id AND p.product id =
pr.product id AND i.product id = pr.product id

Nested query in WHERE clause

It is considered bad format to place sub-queries in the WHERE clause of a
statement, and such clauses can typically be corrected by moving the sub-
query to the FROM clause instead, which preserves the meaning of the
statement while providing more efficient code.

The code quality check fixes the placement of sub-queries in a statement,
which can affect performance. It detects the possibility of moving sub-
queries from the FROM clause of the statement.

Example

The following statement contains a sub-query that contains an incorrect
placement of a WHERE statement:

SELECT * FROM employee WHERE employee id = (SELECT
MAX (salary) FROM employee)

The code quality check fixes the above statement by correcting the sub-
query issue:

SELECT employee.* FROM employee (SELECT DISTINCT
MAX (salary) coll FROM employee) tl WHERE
employee id = tl.coll
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Code Quality Check Type

Definition

Wrong place for conditions in a
HAVING clause

When utilizing the HAVING clause in a statement

It is recommended to include as few conditions as possible while utilizing
the HAVING clause in a statement. DB Optimizer™ XE Pro 2 detects all
conditions in a given HAVING statement and suggests equivalent
expressions that can benefit from existing indexes.

Example

The following statement contains a HAVING clause that is in the wrong
place:

SELECT col_a, SUM(col b) FROM table a GROUP BY
col a HAVING col _a > 100

The code check fixes the above statement by replacing the HAVING clause
with equivalent expressions:

SELECT col _a, SUM(col b) FROM table a WHERE col_a
> 100 GROUP BY col_a

Index suppressed by a function or an
arithmetic operator

In a SELECT statement, if an arithmetic operator is used on an indexed
column in the WHERE clause, the operator can suppress the index and
result in a FULL TABLE SCAN that can hinder performance.

The code quality check detects these conditions and suggests equivalent
expressions that benefit from existing indexes.

Example

The following statement includes an indexed column as part of an
arithmetic operator:

SELECT * FROM employee WHERE 1 = employee id - 5

The code quality check fixes the above statement by reconstructing the
WHERE clause:

SELECT * FROM employee WHERE 6 = employee id

Mismatched or incompatible column
types

When the data types of join or parameter declaration columns are
mismatched, the optimizer is limited in its ability to consider all indexes.
This can cause a query to be less efficient as the system might select the
wrong index or perform a table scan, which affects performance.

The code quality check flags mismatched or incompatible column types
and warns that it is not valid code.

Example

Consider the following statement if Table A contains the column col int and
Table B contains the column col 2 varchar(3):

SELECT * FROM a, b WHERE a.col = b.col;

In the above scenario, the code quality check flags the ‘a.col = b.col’ part
of the statement and wamns that it is not valid code.
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Code Quality Check Type Definition

Null column comparison When comparing a column with NULL, the !=NULL condition may return a
result that is different from the intended command, because col=NULL will
always return a result of false. Instead, the NULL/IS NOT NULL operators
should be used in its place.

The code quality check flags occurrences of the !=NULL condition and
replaces them with the IS NULL operator.

Example
The following statement includes an incorrect col = NULL expression:
SELECT * FROM employee WHERE manager id = NULL

The code quality check replaces the incorrect expression with an IS NULL
clause:

SELECT * FROM employee WHERE manager_ id IS NULL

UNDERSTANDING SQL TEMPLATES

DB Optimizer provides code templates for DML and DDL statements that can be applied to the
Editor via the (Ctrl + Spacebar) command. When you choose a template from the menu that
appears, SQL Editor automatically inserts a block of code with placeholder symbols that you can
modify to customize the code for your own purposes.

EJ¥ CREATE_TABLE - creates a tabds with 3 columns  [CREATE TABLE schemahlame. tablefame

£} CREATE_TABLE - creates and populates a table w Emmm sme1 dataTypel PRIMARY KEY,
ﬂ} CREATE_TRIGGER - creates a database trigger colurmniame? dakaTypes |
columniame? dataTyped

--define other columns

%

Code templates are available for DML, ALTER, DROP, CREATE, and platform specific
commands.

A comprehensive set of DDL/DML templates are available, with statement alternatives varying
by DBMS and specific DBMS versions. You can modify and create new templates via the SQL
Templates panel on the Preferences dialog. See "Specify SOL Templates Preferences" on
page 25 for more information on how to create and alter SQL code templates.
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VIEW CHANGE HISTORY

Each time an SQL file is saved, the local history of that file is recorded (changes made). Using the
Local History command, you can view all changes made to the file. Local History is accessed via
the shortcut menu of SQL Editor and selecting Compare With > Local History.

T nl
Eensun.sql ( test.sql (E:]D Compare Benson.sgl Current and Current Revision &3 = =
TextCumpare Ii::'l_l L A o A A
Local: Benson.sql
k:REPLTE TABLE dbo.benson CRELTE TAELE dbo.benson
! |
Job char (&) HOT NWULL Job char () NOT |
sal numeric(38,0) NOT NULL sal numeric(38,0) HOT ]
loc mumeric(38,0) NOT NULL loc numeric(38,0) HOT ]
CONSTRLINT pjob CONSTRLINT pioh
PRIMARY KEEY CLUSTERED (job PRIMARY EEY CLUSTERED
) )
go go
IF CBJECT ID|('dbo.benson') IS IF CBJECT ID('dbo.kbenson')
PRINT '<«<« CREATED TABLE d PRINT '«<<«<< CREATED TLEBE
ELSE ELSE
PRoNT '<«<« FAILED CREATING PRoNT '«<<« FATLED CREA]
go go
(4] 1 | [i] (4] i | [i]
Py m— i -
SQL Log (EBEL SQL Erro (& Problem (\E Tasks (Eu] Bookmar gt Outline (@ History &3 - =
. = _E
Benson.sql -::;-c:' G:Er = 2 ﬂp E||E;|
Revision Time
E 05/02/08 11:45 AM
E 04/02/08 11:43 AM
%l 1 | (2]

® The History view displays all recorded times the file was changed since its inception/
introduction into the workspace.

e Double-click a time in the History view to access the Text Compare panel. It displays the
text of the file after the change occurred at the time indicated in the History view.
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REVERT TO AN OLD VERSION OF A FILE

The Replace With > Local History command provides you with the ability to revert a SQL file
back to a previously recorded local history.

To replace the contents of a file with the contents of a previously saved version via local history:

1 Right-click the SQL Editor and select Replace With > Local History from the shortcut menu.

The Replace from Local History dialog appears.

£F Compare - [.EI
/551 Project 1/Benson.sql ® =
Reevision Time
£ 04/02/08 11:43 AM
<] 2
[ee, Text compare 20 A B
(5% Warkspace Fie B Local History (D4/02/08 11:43 AM] ]
CONSTRAINT pich CONSTRATHT pjob )
PRIMARY EFEY CLUSTERED (jcok) ERIMARY FKEY CLUSTERED (job)
) }
o To
IF OBJECT_ID("doo.bensan') IS5 WOT NUL IF CBJECT_ID('dbo.bensen') IS5 HOT
PRIMNT '««<« CREATED TABLE dho.bens ERINT '«<<« CRERTED TRBLE dha.
ELSE ELSE -
[ PRoNT "<<< FAILED CREATING TABLE |— BRINI '<<< FAILED CREATING Ta|| |
oo o a
—
<1 - 2 [«] . [»
@ [ Replace ] [ Cancel |

2 In the Local History of ... panel, select a previously recorded version of the file by clicking
the appropriate timestamp.
3 Click Replace.

The contents of the currently-opened file revert to the contents of the file at the history
point you selected in the dialog.

Alternatively, from the shortcut menu, select Replace With > Previous from Local History
to replace the contents of the file with DB Optimizer™ XE Pro 2's last recorded history point.

DELETE AN SQL FILE

To delete a file, right-click its icon in the SQL Project Explorer and select Delete. This will remove
the file from both the SQL project and the file system.
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EXECUTING SQL FILES

DB Optimizer™ XE Pro 2 can execute SQL code directly on registered data sources.

Files are executed via the Execute SQL command in the Run menu, or by clicking the green
arrow button on the toolbar.

When an SQL file is open in the Workspace, select it and choose a database and an associated
catalog on which you want to execute the file via the lists in the Toolbar.

You can click the execute icon to execute code on the specified database and catalog, start a
transaction or commit a transaction, or modify SQL session options prior to execution.

To execute a file:

Open the SQL file you want to run, ensure it is associated with the correct database, and
click Execute. DB Optimizer™ XE Pro 2 executes the code on the data source you
specified. Results are displayed in the Results view and can be exported into a file via the
Data Export wizard, or displayed in multiple file formats (HTML, XML, and TXT formats).

To execute a transaction:

To execute transactions, you need to ensure that the auto commit feature is turned off. See
"Specify SQL Execution Preferences" on page 28 for more information on how to turn off

auto commit.

Open the transaction file you want to run, ensure it is associated with the correct database,
and click Start Transaction. DB Optimizer™ XE Pro 2 executes the transaction on the data
source you specified.

Once the transaction runs, you can execute the file as normal.

NOTE: Click Commit or Rollback to finish or cancel a transaction.

To commit a transaction:

Open the transaction file you want to commit, ensure it is associated with the correct database,
and click Commit Transaction. DB Optimizer™ XE Pro 2 commits the transaction on the data
source you specified.

TIP:  You can set transactions to auto-commit prior to execution on the SQL Execution node
of the Preferences panel.

See Also:
e Associate an SQL File with a Data Source on page 81

e Configure an SQL Session on page 82
e Execute SQL Code on page 83

¢ View and Save Results on page 83
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ASSOCIATE AN SQL FILE WITH A DATA SOURCE

When working with files, SQL Editor enables developers to view and change the data source to
which they are connected.

The bread crumb line in SQL editor is used to display and specify a data source in relation to the
specified SQL Editor file. The menu contains a list of all registered data sources. Additionally, on
platforms that support catalogs, these are displayed as well.

[s% *urtithed S5 53 =
b o} Microsoft SGL Server b R ROMLABSCLOS 1 (9.0.3054.00 [ master =5 ]

select T from dbo.Customers:

Changing a catalog via the drop down lists is the equivalent of issuing a USE DATABASE
command on SQL Server, Sybase, and MySQL platforms. Any change will not affect the current
connection, and the list automatically updates to display the name of the newly selected data
source.

If no registered database is associated with a SQL file (as would be the case if a user started a
new, unsaved file), the list is empty. This indicates that the file is not connected to a registered
data source.

To change or associate a registered data source with a SQL file:

Click the database list and select the name of a registered database from the list provided.
Depending on the state of the code in SQL Editor, DB Optimizer™ XE Pro 2's behavior differs
when the connection is made:

TIP:  If you are receiving multiple syntax errors, always check that the file is associated with
the correct data source and corresponding database/catalog before troubleshooting
further.
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CONFIGURE AN SQL SESSION

The SQL Session Options dialog provides configuration parameters that indicate to DB
Optimizer™ XE Pro 2 how to execute code in the development environment.

ﬁ‘.‘i S0L Session Options

8= %

SQL Session Options

Specify the SQL session options for the current editor,

v

Property Value
—| Ansi Defaults
Set ansi_nulls false
Set ansi_padding false
Set quoted_identifier true
Set ansi_warnings false
Set ansi_null_dfit_on false
|=| Arithmetic
Ignore Arithmetic Overflow false
Abort On Arithmetic Overflow false
—| Transactions
Izolation Level Read Committed
Set implicit_transactions false
Set cursor_dose_on_commit false
—|Result et
Maximum Rows in Result Set 0]
Maximum Mumber of Bytesina ... 2048
Query Timeout (seconds) ]

Finish

J

Cancel

To modify SQL session options:

1 Click the SQL Session Options icon in the Toolbar.

The SQL Session Options dialog appears.

2 Click on individual parameters in the Value column to change the configuration of each

property, as specified.
3 Click Finish.

The session options will be changed and DB Optimizer™ XE Pro 2 will execute the code as
specified when you execute it.

Session options only apply to the corresponding editor and are not retained when executing
multiple SQL files.
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ExecuTe SQL CODE

Files can be launched from within the DB Optimizer™ XE Pro 2 development environment for
execution on a registered data source Files are executed via the commands in the Run menu.

When a SQL file is open in the Workspace, select it and choose a database and an associated
catalog on which you want to execute file using the drop down menus in the Toolbar. You can
click the execute icon to execute the code on the specified database and catalog, start a
transaction or commit a transaction, or modify the SQL session options prior to execution.

To execute code:

Open the SQL file you want to run, ensure it is associated with the correct database and click the
Execute icon. DB Optimizer™ XE Pro 2 executes the code on the data source you specified.
Results are displayed in the same tab or in a new tab.

To execute a transaction:

Open the transaction file you want to run and ensure it is associated with the correct
database, and then click the Start Transaction icon. DB Optimizer™ XE Pro 2 executes the
transaction on the data source you specified.

To commit a transaction:

Open the transaction file you want to commit, ensure it is associated with the correct
database, and then click the Commit Transaction icon. DB Optimizer™ XE Pro 2 commits
the transaction on the data source you specified.

TIP:  You can set transactions to auto-commit prior to execution on the SQL Execution node
of the Preferences panel in DB Optimizer™ XE Pro 2.

VIEW AND SAVE RESULTS

Once a file has been executed, the results are displayed in the Results view. Here, you can
examine the outcome of the execution process, as well as save the results in other file formats,
as needed.

You can view results in the following formats:
e HTML
e XML
e TXT
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To save results:

1 Right-click on the Results view and select Save Data. The Save Data dialog appears.

*# Save Data

Save data to a file
Save data ko a specified file bype.

Enter or seleck the parent folder:
MyvProject

=T,

@ % MyProject

File namme: [ result

File type: |Delimited bext files (*.csv, * ppe, *.tab, *.bxt)
Excel Files {*.xls)
Include |vpy_ files (*.xml)

2 Select the project name to which you want to save the results, enter a file name, choose the
file parameters, and then choose a file format from the drop down menu. You can select
delimited text file, Excel, XML, or HTML file formats.

3 Click Finish. The results are saved in the directory location and format that you specified.

TROUBLESHOOTING

DB Optimizer™ XE Pro 2 contains a number of views used exclusively to log and monitor the
SQL development process.
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e The SQL Log captures all SQL commands executed by SQL Editor and the system. SQL Log
entries are listed by SQL Statement name, Date issued, Host/Server, Service, User, Source,
and the Time (in milliseconds) it took to execute the command.

5] SQLLog 2 . % SQL Errors | (21 Problems | 4] Tasks | L[l Bogkmarks | 2= outine (2 History
FE BxE=XE T

S0L Statement Date HastfServer || DEMS
% €3 ALTER TABLE dbo.testapps  ADD CONSTRAINT Cx_123  CHECk 2008-02-04 11:06:12.656  datotbid 5QLServer =
© & CREATE TASLE dba.benson [ job char(3)  MOTNULL, salm 2008-02-04 11:05:53.00  datathig SOLServer ¢

] IF OBIECT_ID{dba.benson’) IS NOT MULL  PRINT ‘<«<< CREATEL 2008-02-04 11:05:53,171  datoth1d SQL5erver ¢

1<

e The SQL Errors log automatically logs all SQL errors encountered when SQL commands are
executed through DB Optimizer™ XE Pro 2. Errors are listed by Error Code, SQL State, error
Details, Resource, and the Location of the error in the SQOL file.

|| s Log | 3 sQUErers 51 - [2 Probiems | 4] Tasks | Ll Bookmarks | OF Qutine | £ Hitory = = O
Error Code S4L State Details Resource Locaton
170 37000 Line 4: Incorract syntax near PRONT'. Bensan.sal line 13
17a 37000 Line &; Incorrect symtax mear ‘sdasd', Berson.sgl ine 8

® The Problems view captures syntactic and semantic errors and warnings in the files of the
workspace. These entries typically take the form of error messages or warnings issued by the
system over the course of a procedure execution. Problems are organized by Description
(which indicates the type of problem logged), Resource, file Path, and Location. Using the
Problems view, you can apply quick fixes to issues that DB Optimizer™ XE Pro 2 detects, as
well as locate other problems that have similar attributes.

] 50L Log | %2 501 Errors | [51 Froblems 52 . =) Tasks | L[]l sookmarks | 5% outine| 2 History Rt .
0 errors, 0 warnings, 0 infos
Description 4 Resource Fath Location
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See Also:

¢ View Log Details on page 86

Maintain Logs on page 87

Filter Logs on page 87

Import and Export Error Logs on page 90

Find and Fix SQL Code Errors on page 91

Find and Fix Other Problems on page 91

VIEW LOG DETAILS

The SQL Error Log and Problems views contain functionality that enable you to view details
regarding individual log entries, and in some cases, locate or fix those issues automatically.

To view details about SQL Errors entries:

Right-click the error whose details you want to view and select SQL Error Details.

& SOL Error Details

@ Line 4: Incorrect syntax near 'PRoNT.

Reason:
Batch: 2

Line: 12

Position: 0

Error Code: 170
SQL State: 37000

Details: Line 4: Incorrect syntax near 'PRoMT'.

The SQL Error Details dialog provides information about the specified SQL error.

Additionally, you can double-click the error to view the problem code in SQL Editor.

To view details about Problems

Right-click the entry whose details you want to view and select Properties. The Properties
dialog appears, summarizing the issue.
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MAINTAIN LOGS

The SQL Log and SQL Errors views both contain commands that enable you to save, restore, or
otherwise move log entries into files outside of DB Optimizer™ XE Pro 2. Additionally, both
views also contain commands that enable the clearing of the view.

The current editor option will only show users statements as generated by the active editor.

To maintain log entries:
All entries automatically captured by the Error Log are written to a file (.log suffix) that resides in
the Workspace .metadata folder.

e Right-click in the SQL Log view and select Clear Log Viewer to remove all messages.

¢ In the shortcut menu, select Delete Log to delete the .log file. If entries are created after the
Delete Log command is issued, DB Optimizer™ XE Pro 2 will automatically generate a new
log file in the .metadata subfolder.

NOTE: Old Error Log entries cannot be recovered once the .log file is deleted. To prevent data
loss, archive the .log file via the Export command prior to deletion.

* To clear the Error Log view without deleting the .log file, select Clear Log Viewer from the
shortcut menu. The View will be cleared of entries, but these entries will still be contained in
the .log file.

* To restore the Error Log view based on the entries contained in the .log file, select Restore
Log from the shortcut menu. The View is restored based on the entries in the .log file.

FILTER LOGS

Filters can be applied to Problems, SQL Log, and the SQL Errors views to limit searches when
troubleshooting and pinpointing specific processes within the system.
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To filter the SQL Log:

e On the SQL Log view, select the Toolbar Menu icon [ =] (the downward-pointing arrow in
the right-hand corner of the view) and choose Filters. The SQL Log Filters dialog appears.

&4 QL Log Filters

=,

SOL statement types
Successful

Failed

Limit display statements to: | 100

(<]

[ ]Show statements with host:

Filter by source
User

[ By current editor
[] system generated
Unavailable source

[ oK H Cancel ]

88

 In the SQL Statement Types frame, select Successful or Failed to filter by the type of Error
Log entries.

¢ Select Limit display statements to indicate a maximum limit of the number of entries
displayed in the Error Log, and enter the maximum entry value in the corresponding field.

e Select Show statements with host to indicate that only entries from a specific data source
are to be displayed, then type the name of the data source (as it appears in the Database
Explorer) in the corresponding field.

¢ In the Filter by Source pane, specify User, System Generated or Unavailable Source to
filter statements by the type of source from where they originated.
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To view and filter the Problems log:

1 On the Main Toolbar, click Window > Show View > Other > General > Problems.

2 On the Problems view, select the options icon [ = ] and choose Configure Contents. The
Confgure Contents dialog appears.

P Cunfigu re Contents

Configurations: « Scope

All Errors (%) On any element

Warnings on Selection g :

D E”ws';:famings e O On any element in same project
Duplicate

[] Errors/warrings on Proje (O On selected element only

O Cn selected element and its children
() On working set: Window Working Set

w Description

(Y]

conkains |

Texk:

where severity is: [¥]Error [ |Warning []Info

- Types
—porome '
Select Al
Problem
! SCL Errar Marker Daselect Al
Transfarmation Marker

L4 b
() Mateh all configurations
(%) Match any configuration

[ QK ][ Cancel ]

The Configure Contents dialog enables you to create multiple filter profiles that you can
apply to the log by clicking the options icon [ =], clicking Show, and then choosing the filter
to apply. The Configurations panel on the left-hand side of the dialog displays all existing
filter profiles stored in the Workspace. Selecting a configuration displays its filter
parameters, and selecting the check box associated with its name enables the filter in the
Problems view (only problems that match the criteria defined in the Filters dialog will appear
in the view).

The ability to define different profiles enables the selection of multiple filter profiles. For
each profile selected, the profile criteria is applied to the View, concurrently. You can filter
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problems by:

¢ Working Set

Character String
Problem Severity
Problem Type

A combination of the above four filter options

Profile Criteria

Description

Working Set

The options located in the Scope area of the dialog enable you to filter problems based on
defined Working Sets. A Working Set is a collection of user-defined Project files that you can
organize, as needed, in DB Optimizer™ XE Pro 2. Select an option, and then click Select to
define a Working Set to which the parameters apply. If no Working Sets exist, you need to
define one or more via the New button on the Select Working Set dialog.

Select one or more Working Sets to which you want the criteria to apply. If no Working Sets
exist, or none suitably match the current filter criteria, click New or Edit to define a new
Working Set, or edit an exist Working Set, respectively.

Character String

Use the Description list to select contains or doesn’t contain, as needed, and type the character
string in the field below the list. The Problems view is filtered to only contain, or omit, problem
descriptions that fully or partially match the string value.

Problem Severity

In the Where severity is area, choose Error, Warning, Info or some combination of the three
check boxes. Only entries whose severity matches the check boxes you have selected remain
visible in the Problems view.

Problem Type

The options in the Types list on the right-hand side of the dialog enable you to filter problems
by type. For example, deselect Problem to remove any system entries from the view, or
deselect SQL Error Marker to remove any SQL code entries from the view.

Once you have defined and/or selected the appropriate filter profiles, the profiles will
appear in the Show submenu in the Toolbar Menu of the Problems view. Select or deselect
the profiles from the submenu, as needed.

IMPORT AND EXPORT ERROR LOGS

Error messages are written to a file named .log located in the Workspace directory .metadata
folder. This file can (and should) be cleared periodically via the Delete Log command to prevent
performance issues with regards to system memory and file size. However, the Export command
enables you to archive log files prior to deletion. The files created by the Export command can
then be imported back into the Error Log as needed at a later point in time.

To export the SQL Log:

Right-click the SQL Log view and choose Export Log. The log is saved in the specified
directory path with a .log extension.
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To import the Error Log:

Right-click the SQL Log view and choose Import Log. Select the previously exported .log
file. The Error Log view is restored with the entries from the specified export file.

FIND AND FIx SQL CODE ERRORS

The SQL Errors view contains an option that enables you to navigate directly to the resource
associated with an error entry.

E"}Bensun.sql £ =l sglLog.log
CONSTEAINT piob
PRIMARY EKEY CLUSTERED (job)
)

go

IF OBJECT ID('dbo.benson') IS NOT NULL
PRINT '<<< CREATED TABELE dbo.benson >>>'

ELSE

PRoNT '«<«<< FATLED CREATING TABLE dbo.benson >>>'

Lo

To navigate to the source of a SQL error entry:

Right-click the entry to which you want to navigate and select Go To. The file to which the
error applies automatically opens in a new instance of SQL Editor, and the line is highlighted

in the window.

FIND AND FIX OTHER PROBLEMS

By default, the Problems view organizes problems by severity. You can also group problems by
type, or leave them ungrouped.

The first column of the Problems view displays an icon that denotes the type of line item, the
category, and the description. Click the problem and DB Optimizer™ XE Pro 2 will open the SQL
file and automatically highlight the line that triggered the issue.

You can filter Problems to view only warnings and errors associated with a particular resource or
group of resources. You can add multiple filters to the view, as well as enable/disable them as
required. Filters are additive, so any problem that satisfies at least one of the filters will appear.
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Problems can sometimes be fixed via the Quick Fix command in the shortcut menu. The Quick
Fix dialog enables you to apply a fix to a problem detected by the view. The dialog also
provides a list of similar problems to the one you selected, and enables you to apply a fix to

multiple problems at the same time.

ra
I

5, 33 warnings, 0 infos
ription -
& Using the CONYER T() function suppresses index usage
& Using the LEMO) Function suppresses index usage
& Using the LEMN() function suppresses index usage
& Using the LEMN() function suppresses index usage
& Using the ROUND) Function suppresses index usags
@ Using the ROUND() Function suppresses index usage
& Using the SUBSTRING() function suppresses index usage
& Using the SUBSTRING() function suppresses index usage
& Using the SUBSTRING() function suppressas index usage
& Using the TRUNCE function suppresses inds: usage
& Using the TRUNCE) function supprasses index ussge
& Using the TRUNCD function suppresses index usage
& Using the TRUNCC) function suppresses index ussge
& Using the TRUNCE) function suppresses index usage
A Usineg the TRUNCD Function suppresses index usbpe

Sybase.sql
Sybase.sql
Sybase.sql
Sybase.sql
Sybase sql
Sybase.sql
Syhase sql
Sybase.sql

DEZ.2q)
DBZ.5q
DEZ.5q)
DEZ.50]
MryFile.=gl
MiyFile. gl

Select a fix:

&4 Quick Fix (%]
Select a fix

Select the Fix For Uising the TRUNCE

function suppresses index usage”. o

Prioblams:

Resource ocation ||
& DBZ.sql line 151

i Sybase,sql fine 181
iy b e
[#] & sybase.sql  lne 187

{8 DB2.5q) fine: 90 '

¥ & oez.sq fine: 103

& DB2.5q line 146 -

T I AT e ]

To apply a quick fix to an issue in the Problem view:

1 Right-click on a problem in the list and select Quick Fix from the menu. The Quick Fix

dialog appears.

2 Select a fix from the list provided and click OK. DB Optimizer™ XE Pro 2 attempts to resolve

the issue.

To find similar issues:

1 In the Quick Fix dialog, click Find Similar Problems. The Problems list populates with all of
the issues that are similar to your initial selection.

2 Use the check boxes beside the problems to select them, and then choose a fix and click
OK. DB Optimizer™ XE Pro 2 attempts to resolve all of the specified issues.
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NOTE: The SQL Profiler is not available in the Basic version of DB Optimizer.

For details on working with profiling, see the following topics:

¢ Understanding Profiling on page 2

Understanding the Interface on page 3

® Running a Profiling Session on page 4

Configuring Profiling on page 38

Using Load Tester on page 46

UNDERSTANDING PROFILING

Profiling continuously samples the data source to build a statistical model of the load on the
database. Profiling can be used to locate and diagnose problematic SQL code and event-based
bottlenecks. Additionally, profiling enables you to investigate execution and wait time event
details for individual stored routines. Results are presented in the SQL Profiling Editor, which
enables users to identify problem areas and subsequently drill down to individual, problematic
SQL statements.

NOTE: DB Optimizer supports the Oracle Real Application Cluster (RAC). When you want to
profile a RAC you can profile the entire cluster in one profiling session. For more
information, see Building Profiling Configurations on page 42.

Profiling filters out well performing, light weight SQL and collects information on heavy weight
SQL. SQL that is heavy weight is either long running queries or queries that is short but run so
often that they put load on the database

Profiler takes snapshots of user and session activity once a second and builds up a statistical
model of the load on the database. The sampled data is displayed in three ways:

® | oad on the database measured in average number of sessions active
e Top Activity - Top SQL, Event, and Sessions, Object I/O, and Procedures
e Details - Detail on a SQL statement, Session, Event, Object I/O or Procedure

The graph on the top of the screen shows the load on the database and can quickly indicate
visually how the database is functioning. The database could be

e [dle
e Lightly loaded
® Heavily loaded
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¢ Bottlenecked
Problems can come from any one or more of four areas
® Machine CPU or Engine, slow disks (network)
¢ Application locks, invalid SQL
e Database cache sizes, log files, etc

¢ |nefficient SQL

UNDERSTANDING THE INTERFACE

The profiling interface is divided into three major parts:
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® The Load Graph is located on the top section of the editor and provides a display of the
overall load on the system. The bars represent individual aspects of the enterprise, and the
view can be used to find bottlenecks.
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* Top Activity is located on the middle section of the editor and displays where the load
originates. Specifically, the top SQL statements, top events that the database spends time
in, as well as the top activity sessions.

® The Profiling Details View is located on the bottom section of the editor and displays
detailed information on any item selected in the middle section. For example, an SQL
statement, an Event, or a Session.

The graphical portion of the profiling editor presents the distribution of sessions executed over
the length of the profiling process, and those that were waiting in DBMS-specific events. It
provides a first and most important step in identifying problem areas. Results can be viewed in
real-time.

The Load Graph and Top Activity Section compose one view in the editor, while the Profiling
Details view is a separate interface component that only activates when an item in the Top
Activity Section is specified.

NOTE: Use a 1280 x 1024 monitor resolution when viewing profiling information. Smaller
resolution sizes can obscure details in the view.

RUNNING A PROFILING SESSION

Profiling provides the continuous monitoring of a data source and builds a statistical model
based of database load based on the users state every second. The created profile can then be
saved to file, and the data can be saved, analyzed, and optimized by importing statements into
the tuning component and running a tuning job.

The following list provides the general workflow and overhead tasks, when attempting to
monitor data sources and store query information.

1 Execute a Profiling Session on page 5
Work with Session Results on page 7

Creating Profiling Reports on page 31

2
3
4 Saving Profiling Sessions on page 33
5

Import Statements to Tuning on page 36

In addition to the workflow tasks outlined above, the profiling interface also enables a number of
important functions to help in statement analysis and diagnosis. This additional, or extra,
functionality can be found in "Other Profiling Commands" on page 36

Furthermore, in some cases you will need to configure system variables and parameters in order
to get the results you need from the application. See "Configuring DBMS Properties and
Permissions" on page 38 for more information on how to configure profiling and your registered
data sources prior to running a session.
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EXECUTE A PROFILING SESSION

Profiling is monitored and managed via profiling’s three major interface components: the Load
Chart, Top Activity Section, and Profiling Details view.
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To execute a profiling session:

1

In Data Source Explorer, right click on the data source you want to profile and select Profile
As from the menu, and then choose Data Source 1.

In the Profile Configurations dialog, select the configuration to use for this profiling
session. If you haven't already created a profile, see Building Profiling Configurations on
page 42 for a description of the profiling configuration options you can choose.

The profiling session begins. Alternatively, clicking the Profiling icon on the Toolbar
automatically runs a profiling session for the last data source you selected.

Once a profiling session launches, it runs until you stop it. When a session has run for a
length of time, you can then interpret and analyze the results. See "Work with Session
Results" on page 7.
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To stop a profiling session:

You can stop a profiling session at any time by clicking the Stop button [ @] in the upper
left-hand side of the Profile Session screen of by clicking the Stop button in the Progress
Window.
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o -
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Executing a Session from the Command Line
NOTE: This is not supported when using DB Optimizer InstantOn.

You can launch a profiling session from the command line using the following syntax:

dboptimizer.exe profile ds:ROM*L*ABORCL10G_1 duration:20 tofile:c:\testprofile.oar

In the above command, the user has specified ROM*L*ABORCL10G_1 as the data source, and
indicates a profiling session of 20 minutes. The tofile variable specifies the directory and name of
the file to which the profiling session will be saved.

KILLING AN ORACLE SESSION

For the Oracle platform, you can stop profiling an active user session at any time during the
profiling session by right-clicking the session on the profiling Sessions tab and chooing Kill
Session.

5oL ]

=E overview | 53 5L €5 Events | &7 Sessions

ser Mame Prograrn SID

—m

Copy

E:' Trace Session

227 Kill Session
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TRACING AN ORACLE SESSION

While profiling an Oracle database you can choose to start a trace on a specific session by
right-clicking the session on the profiling Sessions tab and choosing Trace Session.

E= Qverview | 03 50L (5 Events #Tj Sessions

User Name Program SID

SYSTEM ]

Copy

#" Trace Session

3 Kill Session

WORK WITH SESSION RESULTS

Results are displayed in the Profiling Session editor whenever a profiling session is executed.
Results can appear in real time (if real time profiling is enabled) or once a session as finished its
execution.

Results are displayed in the three major interface components of the editor, which you can use
to analyze the overall efficiency and capacity of queries running on the data source, to various
levels of detail:

The Profiling Ul has three correlated sections:

e Selection in Chart will fill the top activity section data, distributed in Overview/SQL/Events/
Sessions/Object I/0.

e Selection in any tab of Top Activity will fill the Profiling Details with top selection type related
data.

For more information, see:
® Opening an Existing Profiling Session on page 8
® Analyze the Load Chart on page 8

¢ Analyze the Top Activity Section on page 10

® Analyze Profiling Details on page 16
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OPENING AN EXISTING PROFILING SESSION
Saved profiling session data is stored in either an SQL Project or in a Profiling Repository on an
Oracle data source.

To view a saved profiling session, locate it in either the SQL Project Explorer or in the Data
Source Explorer and double-click the icon to open it in the Profiling Session window.
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ANALYZE THE LOAD CHART

The Load Chart is located on the top section of the Profile Session editor and provides a display
of the overall load on the system. The bars represent individual aspects of the enterprise, and
the view is used to discover bottlenecks.
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The most important part of the screenshot above is the Average Active Sessions (AAS) graph.
AAS shows the performance of the database measured in the single powerful unified metric
AAS. AAS easily and quickly shows any performance bottlenecks on the database when
compared to the Max Engines (for Sybase) or Max CPU (for Oracle) line. The Max Engines line is
a yardstick for performance on the database. When AAS is larger than the Max CPU line there is
a bottleneck on the database. Bottleneck identification is that easy.

AAS or the average number or sessions active, shows how many sessions are active on average
(over a 5 second range in DB Optimizer) and what the breakdown of their activity was. If all the
users were running on CPU then the AAS bar is all green. If some users were running on CPU
and some were doing I/O, represented by blue, then the AAS bar will be partly green and partly
blue.

The line Max Engines or Max CPU represents the number of CPU processors on the machine. If
we have one CPU/Engine then only one user can be running on the CPU/Engine at a time. If we
have two CPUs/Engines then only two users can be on CPU at any instant in time. Of course
users can go on and off the CPU/Engine extremely rapidly. When we talk about sessions on the
Engines we are talking about the average number of sessions on CPU/Engine. A load of one
session on the Engine, thus would be an average which could represent one uses who is
consistently on the CPU/Engine or many users who are on the CPU for short time slices. When
the number of Engines becomes a resource bottleneck on the database we will the average
active sessions in CPU/Engine state go over the Max Engine/Max CPU line. The number of
sessions above the Max Engine line is the average number of sessions waiting for CPU/Engine.

The Max CPU is a yardstick for performance on the database. The number of CPUs or Engine on
the data source is information DB Optimizer obtains during the profiling process. However,
sometimes the number of CPUs or Engines is not reported. In these cases it might be desirable
to change the default number of CPUs/Engines from one to a number more closely matching
the actual system running the data source. You might also want to change the Max CPU/Engine
line to reflect the performance impact of adding or removing a CPU or Engine from the system.

To change the Max CPU or Max Engine count in the Load Graph:

1 From the Profile Session window, right-click anywhere on the AAS graph and select Edit
Engine Count or Edit CPU Count.

2 Inthe Engine Count dialog that appears select Use a custom value, enter a new value, and
then click OK.

The AAS or Load Chart Max CPU or Max Engine line is updated immediately to reflect the
change.

The Load Chart is designed as a high level entry point to profile session results. Subsequently,
you can use the Top Activity and Profiling Details views to examine more detailed information on
waiting and executing sessions over the length of the session. Alternatively, you can select one
or more bars on the graph to populate the Top Activity section (and subsequently, the Details
View) with information on a specific subset of the graph.

The Load Chart displays the distribution of waiting and executing sessions over the length of a
profiling session.
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e Time is displayed on the X axis. You can zoom in and zoom out on the graph via the icons in
the upper right hand corner of the graph, once a profiling session is stopped.

e The Y axis shows the average number of sessions waiting or executing. Each supported
platform has a specific set of wait event times.

DBMS Wait Event Category

IBM DB2 Fetch, Cursor, Execution, Operation,
Transaction, Connectivity, Lock, Other

Oracle On CPU, System I/O, User I/O, Cluster,
Application, Configuration, Commit,
Other

SQL Server CPU, Lock, Memory, Buffer, I/O, Other

Sybase CPU, Lock, Memory, I/O, Network,
Other

e A chart legend displays a color and code scheme for executing and waiting session
categories, in the upper right-hand corner of the view.

ANALYZE THE TOP ACTIVITY SECTION

The Top Activity Section is located in the middle section of the editor and displays where the
load originates. Specifically, the top SQL statements, top events that the database spends time
in, as well as the top activity sessions.
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The Top Activity Section is composed of a series of tabs that provide detailed statistics on
individual SQL statements and sessions that were waiting or executing over the length of a
profiling session.
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e The top SQL tab provides more detailed information than provided on the Overview tab, in
terms of executing SQL statements and procedures. For more information, see "Top SQL
Tab" on page 12.

e The top Execution Activity (DB 2 Specific) tab provides details about the statements and
procedures that ran. This is DB 2 specific. For more information, see "Top Execution Activity

Tab (DB2 Specific)" on page 14.

e The top Events tab displays information about wait events profiled by the execution
process. For more information, see "Top Events Tab" on page 14.

* The top Sessions tab displays information about sessions profiled by the execution process.
For more information, see "Top Sessions Tab" on page 15.

® The top Object I/O tab (Oracle-Specific) tab does not appear in the Top Activity Section
unless the data source being profiled is an Oracle platform. This tab displays information
about the I/O profiled by the execution process. For more information, see "Top Object I/O

Tab (Oracle-Specific)" on page 15.

® The top Procedures tab (SQL Server and Sybase Specific) displays information about
procedures profiled by the execution process. For more information, see "Top Procedures

Tab (SQL Server and Sybase Specific)" on page 16.
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When you select any item from the Top Activity tabs, details are displayed in the Profiling Details
view. The tabs that appear in Profiling Details will be different depending on the database
platform and whether you selected a statement, session, or an event. This is to accommodate
the parameter specifics of the item you selected.

Topr SQL TaB

The Profile editor's SQL tab shows a representation of all SQL statements that are executing or

waiting to execute over the length of the profiling session or within the currently selected graph
bars.

NOTE: The image below depicts results achieved for a Sybase database. The columns
displayed on this tab differ depending on the database platform.
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Statements can be grouped by type by right-clicking the view and selecting Organize > By
Type. The statement types are: INSERT, SELECT, DELETE, and UPDATE

TIP:  Statements are grouped when they differ only by their clause values. This enables the
roll-up of SQL statements that only differ by a variable value. For example: select * from
emp where empno=1; and select * from emp where empno=2. A '+’ symbol appears
beside rollup statements. You can click the symbol to expand and view the different
statement predicates.

Additionally, the SQL tab displays two other groupings of statements:

Group Description

OTHER Includes all recognized statements other than INSERT, SELECT, UPDATE,
and DELETE statements.

DB OPTIMIZER™ XE PRO 2 USER GUIDE 12



USING PROFILING > RUNNING A PROFILING SESSION

Group

Description

UNKNOWN

Statements that are not recognized by the application. DB Optimizer has
been improved to query the caching more often and more intelligently so
that UNKNOWN appears less frequently in the Top SQL tab. The system
queries the data source for SQL text in 15 second intervals. Unknown may
still appear infrequently as the SQL text may have been removed by the

database.

All statements are displayed in a tree structure with the following statement components:

Statement Component

Description

Subject The DML statement type (and FROM clause, as appropriate).
Predicate The WHERE clause.
Remainder Any statement component following the WHERE clause.

For example, all statements with common subjects are shown as a single entry with multiple
children; one child for each unique predicate. Predicates are similarly broken down by

remainders.

NOTE: Right-clicking the SQL tab and selecting Organize By lets you choose between
Statement Type grouping and None. The None option disables grouping by
statement.

Statistics

Statistics are provided for statements and statement components. The statistics let you evaluate
costs and spot wait event problems not just at the level of entire SQL statements, but also at the
level of statement components. For each subject, predicate or remainder entry, the following

statistics are provided:

NOTE: Columns displayed on the top SQL tab differ depending on the data source platform.

Statistic Shown for Platform | Notes
Executions SQL Server, Oracle, | The number of active executions for the statement or statement
Sybase, DB2 component over the length of the profiling session or the selected
graph bars.
Avg. Elapsed (sec) Oracle, DB2 The average amount of time that elapsed while executing the

statement during the profiling period. This column appears for only
SQL Server, DB2 and Oracle datasources.

DB Activity (%) SQL Server, Oracle, | A graphical representation of the distribution of execution and wait
Sybase, DB2 time for the statement or statement component.
SQL ID Oracle The ID value of the SQL statement. This statistic only appears on Oracle
data sources.
Child Number Oracle The child number in the database. This statistic only appears on Oracle
data sources.
Parsing User ID Oracle The ID of the user who parsed the statement. This statist only appears

on Oracle data sources.

13
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Statistic Shown for Platform

Notes

Plan Hash Value Oracle

The execution value of the statement. This statistic only appears on
Oracle data sources.

ToP EXECUTION ACTIVITY TAB (DB2 SPECIFIC)

In addition to the statistics displayed on the Top SQL tab, DB2 platforms have an additional tab
in the Profile Session editor named Execution Activity, which contains the following statistical
rows: Rows Read, Rows Written, Fetch Count, Statement Sorts, Sort Time, and Sort Overflows.

Top EVENTS TAB

The Top Events tab displays information about wait events on the resources involved in the
profiling process. This display is used to tune at the application or database configuration level.
For example, if the top events are locks, then application logic needs to be examined. If top
events are related to database configuration, then database setup should be investigated.
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NOTE:

The columns that display are data source-dependant. For example, the Wait Count and

Avg. Per Wait (sec) columns display only for an Oracle data source.
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TOP SESSIONS TAB
The Sessions Tab provides information about individual sessions. This tab provides information
about sessions that are very active or bottlenecked.

EE Overview E’ SqL 'EB Events aﬂ Sessans |
Usear Mame Pragram S0 Serials Activity (%) Madhine Session Typa
SYSTEM Exetulor 2xe 125 32563 I 27.19 EMBARCADERO'ROVIERITARL USER
ORACLE.EXE (CX]0) 162 iy 20.67 TORLABORCL10G_1 BACKGROLMD
ORACLE.EXE (maoo) 111 229521 3.43 TORLABORCLIOG_1 BACKGROLMD
EYSTEM Executor.exe 143 26884 1 2.72 EMBARCADERC\ROVWEANITUCADL IUSER
ORACLE.EXE (SMOM) 163 11 2-70 TORLABORCL 10G_1 BACKGROLMD
EYSTEM Executor.exe 111 228831 2.37 EMBARCADER D ROVSNOVACTL IJSER
EYSTEM Evecufor.exe a7 48228 1 1.86 EMBARCADERC ROV/SHNOVACTI JSER
SYSTEM SWecutor.exe 120 398231 1.59 EMBARCADERO\ROWESNOVACDL USER
ORACLE.EXE (mO01) &7 43155 1 1.54 TORLABCRCL10G_1 BACKGROLMD
AN LS S ove fuarank aca a TN ADANGTT 80e 8 oAU RN

Top OBJECT I/O TAB (ORACLE-SPECIFIC)
The Object I/O Tab is specific to the Oracle data source platform, and displays information
about Oracle I/O loads on the profiled data source.
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0 Other

The following parameters are displayed on the 1/O tab:

Value Description

Object The name of the data source object affecting the Oracle /0.

Type The object type. For example, table, partition, or index.

DB Activity (%) Use the color chart on the right-hand side of the I/O tab to view the I/O
load on the data source during the profiling session.

Tablespace The name of the tablespace where the object resides.

File ID The unique ID value of the file from where specified object resides.
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ToP PROCEDURES TAB (SQL SERVER AND SYBASE SPECIFIC)

The Procedures Tab is specific to the SQL Server and Sybase data source platforms. It displays
information about Procedure loads on the profiled data source.

'E"E' Cveryiew | E|'-E|L SL |{9 Events |§1 Sessions I_;?; Prnceduresl

Procedure Mame | Database Mame | Procedure ID | Executions | DE Activiky (%0 = |
‘TEST_PROCZ cadruta 850099035 | 50.00
TEST_PROCL cadruta 1842102572 1 [ 50.00

The following parameters are displayed on the Procedures tab:

Value Description

Procedure Name The name of the procedure affecting the database performance.

Database Name The name of the database where the procedure resides.

Procedure ID The unique ID value of the file where the specified procedure resides.

Executions The number of times the procedure was executed during the session.

DB Activity (%) Use the color chart on the right-hand side of the Procedures tab to view the
procedures load on the data source during the profiling session.

ANALYZE PROFILING DETAILS
The Profiling Details view displays detailed information on any item selected in the Top Section
View, such as an SQL statement, an Event, a Session or a Procedure.
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S0LID 1135755065 Oplimizer Mods ALL_ROWS Fabches 0,00 0,00 0,000
S0L Addres: S998CESD Fargng Lker ID 5 Ewecubons 1 1.00 1.0
Child Addrass G3BAASZ0 Ourtine Categary 0.00 0.0

Thilkdren 1 Outline 510 0 1,004,000 1,004.00

Plar Hash Valus 35922535028 13,262.00 13,26 .00
Madule Exeobor.exe LArsIng =ta e er L0 L0

ACtion Memary 152433 CPU Time 93, 750000 &3, 750.00 a3, 750,00

501 Oparaticn Code 2 Laads 134 Slapzed Time A0,27%,820,00  70,275,320.00 70,275 420,00
Program 100 10 1644 Inwaidabions 132
Frogram Line= 195

Depending on the data source platform you have specified, the tabs that appear in the view will
be different, in order to accommodate the parameter specifics of the statement you have
selected.

Depending on the top activity selected and the profiled platform types, some tabs may not be
available.
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Statement Selected

When a Statement is selected the following Profile Detail tabs are available.

Tab Name | Description Supported Platform
Oracle | Sybase |DB2 |SQL
Server
SQL text Displays the full code of the selected SQL statement. yes yes yes |yes
SQL Details | Provides details on statement, like execution statistics. yes yes
Events Provides database activity details about events the statementis | yes yes yes |yes
associated with.
Sessions Shows which sessions executed this statement. yes yes yes |yes
Children Lists all copies of the cursor or sgl query, if Oracle has cached | yes
Details multiple copies of the same statement.
Object I/O | If the SQL query has done physical I/O, then these are the yes
objects, such as tables, and indexes that were read to satisfy the
query. Temporary objects with not have values in Object and
Type columns.
Procedures | Shows which procedures contain the selected statement. yes yes
Event Selected
When an Event is selected the following Profile Detail tabs are available.
Tab Name | Description Supported Platform
Oracle | Sybase |DB2 |SQL
Server
SQL Shows which SQL statements waited on this event. yes yes yes |yes
Sessions Provides information about the sessions associated with the yes yes yes |yes
event.
Procedures | Shows which procedures contain the selected event. yes yes
Raw Data Raw data that was sampled from the database, specifically the | yes
following:
® Sample time
¢ SID
e Serial #
® User name
® Program
e SqlID
* P1
* P2
*P3
Analysis Displays for “buffer busy waits” and “cache buffer chains latch” | yes
waits. The analysis shows data and documentation to assist in
solving these bottlenecks.
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Session Selected
When a Session is selected the following Profile Detail tabs are available.

Tab Name | Description Supported Platform
Oracle | Sybase | DB2 | SQL
Server
Sessions Provides parameters regarding the session. For example, yes yes yes

database server connection information, and data regarding the
client tool and application.

SQL Shows which SQL statements this session ran. yes yes yes |yes
Events Shows which events this session waited on. yes yes yes |yes
Procedures | Shows which procedures ran the selected session. yes yes

NOTE: When right-clicking on a SQL statement in the Top Activity Section in Profiling, if the
SQL statement is run by a different user than the user who is running DBO, than the
User Mismatch dialog appears, with an example of the following message: “This query
was executed by [SOE] and you are currently connected as [system]. We recommend
you reconnect as [SOE] to tune the SQL. Would you like to continue anyway?” This
message indicates that the statement is being tuned by a user other than the user who
originally ran the query, and tables may be missing based on the different schemas.
Click OK to run the query, or click Cancel and run tuning under the original user.

Procedure Selected
When a Procedure is selected, the following Profile Details become available

Tab Name | Description Supported Platform
Oracle | Sybase | DB2 |SQL
Server
SQL Text Shows the SQL text of the selected procedure. yes yes
SQL Shows which SQL statements this procedure ran. yes yes
Events Shows which events the selected procedure waited on. yes yes
Sessions Provides parameters regarding the session. For example, yes yes
database server connection information, and data regarding the
client tool and application.

This section also addresses the following topics:

¢ Viewing Details on the SQL Tab on page 19

e Viewing Details on the Sessions Tab on page 22

* Viewing Details on the Events Tab on page 92
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Viewing Details on the Procedures Tab on page 28

VIEWING DETAILS ON THE SQL TaAB

In the Top Activity Session, selecting a statement entry on the SQL tab displays information in
the Profiling Details view. The graph portion and details on the event category tabs on the new
editor pertain only to the selected statement. Additionally, new tabs become available:

SQL Text tab: Shows the full code of the SQL statement. For more information, see "SQOL
Text" on page 20.

SQL Details tab: Displays execution details. This tab is only displayed for Oracle data
sources. For more information, see "SQL Details" on page 20.

Events tab: Displays information about the events the selected statement is associated with.
For more information, see "Events" on page 21.

Sessions tab: Displays information about the sessions that the selected statement is
associated with. This tab is displayed only for Oracle data sources. For more information, see
"Sessions" on page 21.

Procedures tab: Displays information about the procedures that contain the selected
statement. This tab is displayed only for SQL Server and Sybase datasources. For more
information, see "Procedures" on page 22.

To select a SQL tab statement entry:

On the SQL tab, click on a statement with no child nodes or on a leaf node in the statement
structure.

The new profiling editor page opens, as reflected by the bread crumb trail at the top left of the
editor. You can continue to drill down into the statement, as needed.

19
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SQL Text
The SQL Text tab displays the full code of the SQL statement.

(D Profing Btk 52 =0

SOL: SELECT COUNT(™ ) FROM (SELECT USERKAME FROM SYS.DEA_USERS WHERE DEFAULT_TABLESPACE="SYSTEM' OR TEMPO..

| My =
ot iyt |

E0L Tenk {9 Events | & Sestlons I Chigren Detals a‘.'a 57 Detals

SELECT COUMI (*)
FRCH
|
EFLECT USERMNAME
FROMH 32’5.E3L_'J53§3
WHERE
_TTL:J__:_:IE:ESEMZ = "5Y5
TEMPCORARY TASLESFACE
UHICH
SELZCT TSERNAME
F 5¥5.0BA_T5_QUOTAS
WHERE TABLESERCE HAME = FEVETEW"
UHICH
5 SREMTER
ES SY3.0SR 515 PARIVE
WHERE PRIVILEGE = "UMLIMITED TASLESPRCE'

SQL Details

The SQL Details tab provides information and the execution of the statement and other
information related to how it is running. It is only applicable to Oracle data sources:

(=]

(@ Profing Datsik 23

S(L: INSERT INTO PERFCHTR_DRATA_1{QUERYID, VALUE 1] SELECT 851, COUNT(=) FROM SYS.V_SL0CK L SY5.0BA_OBJECT..
| Bt s Tens | 88 5L Datals | €3 Everts| 47 sessiors | [0 chidren Detaks
Sl Identification Optimizer and Qutline Ewecution Statistics (total)  Per execulion — Perrow
1135735565 Opfimizar Made ALL_ROWS Fetdhes 0,00 .00 0,00
S958CES] Parsing User 100 5 Ex=pubons 1 100 1.00
GEEAASHD Cuthre Cab=gory Sorle O 0,00 0,00
] Qutine 5100 0 Disk Aeacs 1004 1,004.00 1,004,040
Flan Hash Value 3852252403 . . Buffer Cels 13261 13,251.00 13,25 1.00
v Farsing Statistics
Module Exetubar.exe = E Rows Prooessed 1 1.00 1.00
Action Memaory 152433 CPUTim= 23, 750.00 &3, 750,00 93,750.00
S0L Operakon Jode 2 Loads 134 Elapged Time 70,278, 820,00  70,279,320.00 T0,278.420.00
Program 10 B0 1644 Irvaiidaliors 132
Program Lire= 185
SQL Details include:
Parameters Description

SQL Identification Values

The SQL ID value of the statement.

Optimizer and Qutline Values

Optimizer-specific values pertaining to the parsing user ID value and
outline SID.

Parsing Statistics

Information regarding memory, loads, and invalidation values.

Execution Statistics

The execution statistics of the statement. This category includes disk reads,
buffer gets, rows, and values that represent CPU and elapsed time.
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Events
The Events tab provides details about the events that the statement is associated with.

| @ Profiing Detais £3 =)

SL: INSERT INTO PERFCNTR_DATA_1{QUERYID, VALUEL) SELECT 951, COUNT(*) FROM SYS.\_SLOCK L 5Y5.0BA_OBIECT...

(BB} 5L Text | aw QU Details | €8 Events| 7 sessions | T Chidren Detaiis|

Event Activity (%) ™|
dh file sequental read 1 142
db fie scattered read 0.50

Sessions
The Sessions tab provides information about any sessions the statement is associated with:

-

(@ Profing Detada 53 ) =1

SJL: INSERT INTO PERFCNTR_DATA_1({GUERYID, VALLET) SELECT 951, COUNT(*) FROM 5YS.V_SLOCK L,5¥5.08A_DBIECT.

Bt sn et | o 500 etats €8 Evennts [ £7 Sessians | T Chikdeen Dietails

Liser Hame SBragram | 5] Sanal= | Acthaty (%) - | Machine | Session Type |
SYSTEM Executar exs 145 9260 I 3,14 EMBARCADERORWEROVACD L LISER,
SYETEM Eretubornexg 145 2242 MM 0.35 EMBARCADERDAWENDVAZD L LIEER

Session details include information on different parameters, depending on the platform. For
example, on Oracle platforms, the following parameters are displayed: User Name, Program,
SID, Serial #, Activity (%), Network Machine Name, and Session Type.
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Procedures

The Procedures tab provides information about any procedures containing the selected
statement.

@ Profing Detsis 53 =08
S0L: WHILE (SELECT COUNT(*) FROM codrutatl) = 1| BEGIM DELETE FROM codruba.t L WHERE jjj = (select mas{jj.
,EE SOL bext | E']' Evenis _:1 Sessians _["\_1‘!1 Praceduras

Frocedure Mame Database Name Frocedure ID Executions Db Activity (%)
TEST_PROICE codruts ASOCAG03E 1 I 16,19

The following parameters are displayed on the Procedures tab:

Value Description

Procedure Name The name of the procedure that contains the selected statement.

Database Name The name of the database where the procedure resides.

Procedure ID The unigue ID value of the file where the specified procedure resides.

Executions The number of times the procedure was executed.

DB Activity (%) Use the color chart on the right-hand side of the Procedures tab to view the
procedures load on the data source during the profiling session.

VIEWING DETAILS ON THE SESSIONS TAB

In the Top Activities Section, selecting a statement entry on the Sessions tab displays
information in the Profiling Details view. The graph portion and details on the event category
tabs on the new editor pertain only to the selected statement. Additionally, new tabs become
available.

Selecting an event type entry on an event category tab opens a new profiling editor page. The
graph portion and details on the Sessions tab and event category tabs on the new editor page
pertain only to the selected wait event and to SQL statements that waited in that event.

¢ Session Details tab: Shows system details about the selected session. For more
information, see "Session Details" on page 23.

¢ SQL tab: Displays information about the SQL files that the selected session is associated
with. This tab only appears on Oracle platforms. For more information, see "SQL" on
page 24.

¢ Events tab: Displays the time and parameter information about the selected session. For
more information, see "Events" on page 25.

® Procedures tab: Displays the details of any procedures run in the selected session. For SQL
Server and Sybase datasources only. For more information, see "Procedures” on page 25.
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Session Details

The Session tab provides further information about the selected session. The following are
examples of the session details provided for different platforms.

NOTE: The fields that display vary depending on the database platform.

Oracle Profiling Details

Session: 145, 3160

5 session Detak| B s () Events|

Microsoft SQL Server

Database Server Connection Client Tool Application
SID 145 Program Exeputor.exe SOLID 1545343752
Sensls 9180 05 User WNT AUTHORITTARCRYMOUS LOGORN SQL Operation Code 3
Liser Name SYSTEM 05 Process 1D TB72: f6 76 Last Call Bapsed Time 95

Process OS5 PID 142532 Host EMBARCADERC ROWSHOVACDL IModule Executor.sxs
Logged On Time 2008-12-19 17:25:06.0 Terminal ROWSMOVACOY Actian

Logged On For 00:01:27.0 Chent ITi S0L Trace DISABLED
Connection Type DEDICATED Clent Info

Sesson Typs USER
Pesauros Cansumer Groun

-

=2 session Detais | 5 5aL | (3 Everss|

Session: 55_2009-09-30 09:40:34.940 (sa / Executor Module)

Database Server Connection Client Application
SPID S5 Applicakion neme  Exeoutor Madule
KPIC 4,048 WT domnain
Database 10 109 HT wsername
User ID 0 Host pracess 100 3552
Login bimee 20008 09=30 0r9: 4034094 Haostrame TORLABDEMOO1L

Met address Q0OC295921 36
Met brary  TCRIP
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sQL
The SQL tab displays information about the statements associated with the session.
i@ Profing Deteis £

Session: 145, 9180
|| 22 Secmon Deteis | T S0 £ Evenis

| Shatement Exenubons Ackviky [%] = SOL D Chid Mumber Parsrg User 10 Flar Fash ek e
_#B SERT INTGPERAINTA Do, AWDLIGI=0.CBIECT D | DS 104 238785068 0§ Msusass
*& WEERT INTD FERFCHTR _D... USER= FROM 5¥5.LISERE IR 0.20 530002544 a 5 4007535571
f"H =0T c:‘.u‘r:‘f--—arﬁ 5Y,..~ERE STATLIS = CRLTHE Le 0.05 IS45343752 a 5 3510734404
B LN Lh 0.05 3440472121 n o
SQL statements are listed by the following parameters:
Value Notes
Statement The name of the statement.
Executions The number of times the statement was executed during the session.
Activity (%) A graphical representation of the distribution of execution and wait time
for the statement or statement component.
SQL ID The SQL ID value of the statement.
Child Number The child number in the database.
Parsing User ID The ID of the user who parsed the statement.
Plan Hash Value The execution value of the statement.
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Events

The Events tab provides details about the events that the session is associated with.

fﬂ Profiling Details &3

Session: 145, 9180

£E£ session Details | B saL [ﬁ-} E'u'enisl

local write wait

Event | Actvity (%) 7|

idb file sequential read | .79
db file scattered read 0,60
0,05

Events are listed by the following values:

Value Notes

Event Name The name of the event.

Activity (%) A graphical representation of the distribution of execution and wait time
for the statement or statement component.

Procedures

For SQL Server and Sybase data sources only, the Procedures tab provides details about the

procedures that the session is associated with

(@ Profing Detsis £

Session: 112, 5505108 (sa)

E S sesswonDetsis | B 5oL (D Events | § Procedures

Procedure 1D |
AE00AR03E

| Database Rame
codruta

Frocedure Mame
TEST_PROCZ

25

Executions

| DB Activiy )~
1 I 100.00
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The following parameters are displayed on the Procedures tab:

Value Description

Procedure Name The name of the procedure that ran during the selected session.

Database Name The name of the database where the procedure resides.

Procedure ID The uniqgue ID value of the file where the specified procedure resides.

Executions The number of times the procedure was executed during the session.

DB Activity (%) Use the color chart on the right-hand side of the Procedures tab to view the
procedures load on the data source during the profiling session.

VIEWING DETAILS ON THE EVENTS TAB

In the Top Activities Section, selecting a statement entry on the Event tab displays information
in the Profiling Details view. The graph portion and details on the event category tabs on the
new editor pertain only to the selected statement. Additionally, new tabs become available.

Selecting an event type entry on an event category tab opens a new profiling editor page. The
graph portion and details on the Events tab and event category tabs on the new editor page
pertain only to the selected wait event and to SQL statements that waited in that event.

e SQL tab: Shows the statements involved in the selected event. For more information, see
"SQL" on page 26.

® Sessions tab: Displays information about the sessions that the selected event is associated
with. For more information, see "Sessions" on page 27.

® Procedures tab: Displays information about the procedures that ran during the selected
event. For more information, see "Procedures" on page 28.

SQL
The SQL tab displays information about the SQL statements involved in the selected event.
i@ Profing Detsils 13 = A
Event: wait for someone else bo finish reading in mass

B 50| 27 Sessions | § Procedures

Sratements CPu Physical 10 | Memory Usage Execu
B DELETE FROM codruta bl WHERE 17 = (select maxifi) fram codruta.t1) 0 036 B
.T:E WHILE [SELECT COUNT(*) FROM codruta.k1) = 1 BE., . E jji = (select mac( i) from codruta.bi) EMD 1] 1625 8
Value Notes
Statement The name of the statement.
SQL ID The ID value of the SQL statement.
Child Number The child number in the database.
Parsing User ID The ID of the user who parsed the statement.
Plan Hash Value The execution value of the statement.
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Value Notes

CPU Cumulative CPU time for the process. (measured in “ticks”, an arbitrary unit
of time)

Physical 1O Cumulative disk reads and writes for the process. (total count)

Memory Usage

Number of pages in the procedure cache that are currently allocated to
this process. A negative number indicates that the process is freeing
memory allocated by another process.

Executions

The number of times the statement was executed.

Activity (%)

A graphical representation of the distribution of execution and wait time
for the statement or statement component.

Sessions

The Sessions tab displays the sessions and related information regarding those that were
associated with the selected event.

i@ Profiing Datals

frir| R 1 L R i .
B 5w | 47 sesnions | 4 Raw Data

Event: O CFU

Uzear [ams Frogram S0 Cermls Acturty (32 Madune
SISTEN  Bveolocess 5 s MENNM 319 EVOARCADEROROWESITANL _ USER
QRACLEEXE (CTWR) 155 7 29,43 TORLAZORCLIDG_1 BFACKGRAUIND
GRACLE_ EXE (DAWE) o 1 0.75 TOALAAORCL1OG 1 BACEGACURND
AE (MO} 161 1 0,45 TORLAJORCL 100G _1 BACRGRUIUND
IGHITE QRACLE.EXE (3002) 143 26503 0,10 TORLAIORCLLIOG 1 USER
QRACLE_EXE {SMOH) 164 1 0.10 TOALAIORCL LG 1 BACEGRIUND
AE (PSP 168 1 0,10 TORLASORCL1OG _1 BACKGRIUND
| IGHLTE 1& 1 0,05 TORLAICRCLIDG 1 USER
55 124 = x] Q.05 TORLAIORCL DG _1 USER
| SHETEM Exsotor = =5 42 0,08 EMBARCADERO\ROSNaYA001 LISER:
| IGHLTE QRACLESXE {1000} 55 5 0,05 TORLAJORCL DG _1 USER

The following parameters are displayed on the Sessions tab:

Value Notes

User Name The user name under which the session was run.

Program The name of the executable under which the session was run.
SID The SID value of the session.

Serial Number

The serial number of the machine from which the session executed.

Activity (%)

A graphical representation of the distribution of execution and wait time
for the statement or statement component.

Machine

The machine name and network location of the machine from which the

session executed.

Session Type

The type of session.
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Procedures
The Procedures tab displays the procedures and related information regarding those that were
associated with the selected event.
@ Frafing Detais 11 = A
Ewent: waiting for disk write to complete

SOL +
& 5oL | 27 Sessions 5'5 Procedures

Frocedune Mams Dakabase Name Frocedurs 1D Exmoutions D Activiy (%)
TEST_PRiaCi codruta 1842102572 1 [ | (0. ()

The following parameters are displayed on the Procedures tab:

Value Notes

Procedure Name The name of the procedure that ran during the event.

Database Name The name of the database where the procedure resides.

Procedure ID The unigue ID of the procedure.

Executions The number of times the procedure ran during the event.

DB Activity (%) A graphical representation of the distribution of execution and wait time
for the procedure.

VIEWING DETAILS ON THE PROCEDURES TAB

In the Top Activities Section, selecting a procedure entry on the Procedure tab displays
information in the Profiling Details view. The graph portion and details on the procedure
category tabs on the new editor pertain only to the selected procedure. Additionally, new tabs
become available.

Selecting a procedure type entry on a procedure category tab opens a new profiling editor
page. The graph portion and details on the Procedure tab and procedure category tabs on the
new editor page pertain only to the selected procedure and to SQL statements that waited in
that procedure.

e The SQL Text tab shows the SQL of the procedure. For more information, see "SQL Text"
on page 29.

e The SQL shows the statements involved in the procedure. For more information, see "SQL"
on page 29.

® The Events displays the time and parameter information about the selected procedure. For
more information, see "Events" on page 30.

® The Sessions displays information about the sessions that the selected procedure is
associated with. For more information, see "Sessions" on page 30.
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SQL Text
The SQL Text tab displays the full code of the procedure.

@ Profiing Details 2 =g
Procedure: TEST_PROC1

&S00

33 son Tet | 2B oy | (Db Everks | 27 Sessions

CREATE FROCEDURE dbo.TEST FROC1 AS i
DECLARE Bi INT
BEGINM
SET Bd = 1
WHILE
Bi <= 1000000
BEGIN
SQL

The SQL tab displays information about the SQL statements involved in the selected procedure.

‘@ Profiing Detaie & =08
Procedure: TEST_PROCI

o ool Text | o son | (5 Everks | §7 Sessions

Statements CPU Physical 10 | Memary Usage Execu
o3 TMSERT INTO codruta. k11 i, if, i, u) VALLES { @i, &, @i, & ) z 3 8
;_,:t WHILE @i <= 1000000 BEGIN INSERT INTO codruk, . LLES { @i, &, @i, @i ) SET @i= @i+ 1 END ] 0 8
% SET @i= @i + 1 1 0 8

The SQL tab displays the following parameters about the statement:

Value Notes

Statement The name of the statement.

SQLID The ID value of the SQL statement.

Child Number The child number in the database.

Parsing User ID The ID of the user who parsed the statement.

Plan Hash Value The execution value of the statement.

CPU Cumulative CPU time for the process. (measured in “ticks”, an arbitrary unit
of time)

Physical 1O Cumulative disk reads and writes for the process. (total count)

Memory Usage Number of pages in the procedure cache that are currently allocated to
this process. A negative number indicates that the process is freeing
memory allocated by another process.

Executions The number of times the statement was executed.

Activity (%) A graphical representation of the distribution of execution and wait time
for the statement or statement component.
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The Events tab provides details about the events that the session is associated with

‘@ Proflng Detais 12

S oo [ () Everks | 27 Sessions

23 SOl Text

Event -

wasiting For disk write to complete

wasiting for network sand to complete

wagiting for ssmaphore
wiiting on run gueus after sleep
waaiting on run gueus after yisld

Procedure: TEST_PROCI

HETWORK
LOCK

CRY

CRU

Events are listed by the following values:

Value

Notes

Event Name

The name of the event.

Class The wait group the event in the selected procedure belongs to.
Activity (%) A graphical representation of the distribution of execution and wait time
for the event.
Sessions

The Sessions tab displays the sessions and related information regarding those that were
associated with the selected procedure.

i@ Frofing Detais &3

=

User Name

CB S0 Test

Applicaton

‘:-:5 Everts _:-I Sessions

SPID

Procedure: TEST_PROCI

1P Address
10,4030, 135

KPID Active (%) Hast Mame:

an 511 1866 I 10000 TCAMMYEGHD]

The following parameters are displayed on the Sessions tab:

Value Notes

User Name The user name under which the session was run.

Program The name of the executable under which the session was run.
SID The SID value of the session.

Serial Number

The serial number of the machine from which the session executed.

Activity (%) A graphical representation of the distribution of execution and wait time
for the statement or statement component.
Machine The machine name and network location of the machine from which the

session executed.

Session Type

The type of session.
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For the Oracle Platform, you can kill a session by right-clicking the entry on the Sessions tab and
choosing Kill Session. You can start a trace on a session by right-clicking the entry on the
Sessions tab and choosing Trace. For more information, see Killing an Oracle Session on page 6

and Tracing an Oracle Session on page 7.

CREATING PROFILING REPORTS

After profiling a data source you can create an HTML or PDF Report of the profiling session. You
can choose the details to include in the report.

1 At the top right corner of the Profiling tab, click the Export Report button.

|'[E] Unkiled Tuning Job 4.tun @ ROMLABORCLG 2 [

s ROMLABORCLYi_2 ~ Processes: |-k~ | Fiter by: [-tone- /@c

Praofile Session EXport RepOI’t
Ed BoMCPU Bsystem 10 BUserv0 OCster BApplication BContiguration B Commit B Other
o MaeoPu
o 1
=
(=1
w
W
a
o
g ° o o o ] 1] o o R
g A1 o W # o s B A o
R Lo o Lo Lo Lo Lo o 7"
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The Export a Profile Report dialog appears.

& Export a Profile Report |:|[E

Export a Profile Report ) e
Zonfigure and export a profiling report in various Formats, q

Report Title: Data Source Profile Report |

Report Descripkion:

Profile Report Cptions

- SQL o
[v]sqL
[+] Report only the top roms
[¥] Include detail information for top Fows
¢ Events
F Sessions

(£

General Report Options

Farmak Layaouk FPaper Size
(%) FOF (%) PORTRAIT (%) Letker (8.5 x 11, 216 x 279
IHTML () LAMDSCAPE {JLegal (8.5 x 14, 216 x 356)

(a4 (3.3% 11,7, 210 x 297)

Use default export location

@ [ Export H Cancel

2 Enter a Report Title and Description.

3 In the Profile Report Options area, click the triangles to expand the options.
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4 Select your options, enter the location for the report, and then click Export.

A report in PDF format will resemble the following:

E Ranknarks
n s -
B 1 - Dsts Sourca \-.
& 2 - Profils Load chart Data Source Profile Report
Bl 3-TopBsm Jamany 27, 2011 11:43 AM
‘SaEments
1 - Data Source
Fame:  WA14013

Flatiom e 10701

Start  Jarwary 272011 11:30AM
Erd. Jarvsary 27, 2011 1121 &M
Durstion: im Tln

2 - Profile Load Chart

Bt GPU I Svwem D B Usnn i 0 Cluder BAppicasen B Cardgaration B comnd [ Mstesit B sdmicietatss B Cancurarey 38 ar l Gibwr
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SAVING PROFILING SESSIONS

The profiling session is saved automatically or when you try to close it according to the choices
made in the Profile Configuration dialog. For information on configuring the your profiling
sessions, see "Building Profiling Configurations" on page 42. Profiling sessions can be saved in
the current workspace in an archive file with a .oar suffix or for Oracle users, into the Profiling
Repository.

The .oar archive file is named with a default file name of:

® The name of the data source if the session was not initiated from a named launch
configuration

® The name of the launch configuration if the session was initiated from a named launch
configuration.

33 DB OPTIMIZER™ XE PRO 2 USER GUIDE



USING PROFILING > RUNNING A PROFILING SESSION

If you are using an Oracle data source and have configured DB Optimizer to automatically save
profiling sessions in a Profiling Repository within an Oracle data source, then the profiling
session is saved in the Profiling Repository under the name of the data source. Each profiling
session for that data source is named using a date and time stamp. As you can see below, the
duration of the profiling session is also saved with the session data.

i

= 5 TORLABORCLS ]
F-L3 Database Chjeds
=l Profilrg Reposkory
= _||j HOMLABORCLIDG 2
& 2010-02-18 21:55:06 {1m)
L& 2000-02-23 Z2:50:03 (1m)
L& 2000-02-24 20=38:03 (Zm)
L&y 2000-02-24 20:43:00 (1m)
+ S ROMLABORCL105_3

For information on working with the Profiling Repository, see "Work with the Profiling
Repository" on page 34.

The time period of the saved session is the amount of data on the chart. The maximum amount
of data on the chart is determined when profiling is started (1 hour default). You can specify the
amount of time to profile the data source in the Profile Configurations dialog and you can also
stop the profiling at any time.

Saving the profile lets you open the archive at a later time for subsequent analysis by yourself or
by other DB Optimizer users. Use standard DB Optimizer file techniques to save, open, or close
SQL Profiling archives.

If you open a profiling archive on a machine on which the associated data source is not
registered, a Data source not available warning appears in the profiling editor header. Use the
associated control to specify a data source already defined on the machine or to register a new
data source.

B EXETOVNMHHABORZ = nirs saisa dar Sisilahis
Aktach Existing Daka Source |,

Profile Session Aktach Mew Data Source ..

\WORK WITH THE PROFILING REPOSITORY

NOTE: Saving wait-time statistics to the Profiling Repository is not supported in DB Optimizer
XE Developer.

The Profiling Repository is only available when profile session data is saved to an Oracle data
source. For more information, see "Building Profiling Configurations" on page 42. When the
system is configured to automatically save profiling information to the Profiling Repository DB
Optimizer can profile 24 hours a day 7 days a week, thus providing much more statistical data for
analysis. Also, since the Profiling Repository resides on a data source and not on the local disk,
other DB Optimizer users can also view and analyze the profiles.
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To start saving profile sessions to the Profiling Repository:

1

From the Data Source Explorer right-click the data source you want to profile for and select
Profile As from the menu, then choose Profile Configurations.

The Profile Configurations dialog appears.
In the Name field of the Profile tab, enter a name for the profile group for this data source.

In the Profiling Repository area of the Profile tab, click Save to data source and then from
the list of available datasources, choose the Oracle data source where you want to store your
profiling information.

Click Apply and then click Profile to start a profiling session immediately.

Any new profiling session that you start continue until you manually stop it. The profile
session can be for as long as you like, days or weeks even. When the profiling session has
been stopped a profile file is stored in the profile group for this data source. The name of
the profile file is the date and time when the profile finished.

To delete profile sessions saved in the Profiling Repository:

1

35

In the Data Source Explorer, locate and then click the Profiling Repository.
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DB Optimizer connects to the Profiling Repository data source.

To delete all sessions in the Profiling Repository, right-click Profiling Repository and then
select Delete All.

To delete a specific profiling session, expand the Profiling Repository and the data source
containing the profiling session, and right-click the name of the profiling session, and then
select Delete.

The profiling session data is deleted, however, some information about the data source is
retained in order to expedite future profiling on this data source. If you are certain you will
not want to retain this information, right-click the Profiling Repository and then select Clean.
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IMPORT STATEMENTS TO TUNING

The profiling feature lets you submit one or more SQL tab statements for tuning by the tuning
feature. This lets you take advantage of tuning’s hint-based and transformation-based
suggestions, detailed execution statistics, and explain plan costing, in tuning a statement.
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To open a tuning job on a statement appearing on the SQL tab of the profiling editor:
e Select one or more statements, right-click and select Tune from the context menu. Tuning
opens on the selected statement.

NOTE: The SQL will be tuned as the user/schema that profiling was running under. If the query
being tuned was run by another user/schema, it is recommended to connect to the
database as that user/schema and copy/paste the query into tuning, rather than import
the statement directly from profiling.

For more information, see “Tuning SQL Statements” in the SQL Tuner help.

OTHER PROFILING COMMANDS

In addition to the default viewing options provided by the views, profiling also provides the
following features and functionality:

e Zooming In and Out. For more information, see "Zooming In and Out" on page 36.

e Filtering Results. For more information, see "Filtering Results" on page 37.

ZOOMING IN AND OUT

To zoom in or out on the Load Graph:

In the upper right-hand corner of the Load graph, click the Zoom In or Zoom Out icons,
respectively.

NOTE: The Zoom In and Zoom Out commands are only available when a session has been
stopped.
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By default, the information contained on the Load Chart spans the entire length of the profiling
session. You can select one or more bars of the graph to have the tabbed view populated with
statistics for only the selected subset of the graph.

To display statistics for one or more bars on the graph, use one of the following methods:

Click-drag across one or more bars.

FILTERING RESULTS

You can display filtered subsets of the original profiling results set for each section of profiling
based on DBMS platform type:

e IBM DB/2 for Windows, Unix, and Linux: Creator ID, Cursor Name, Package Name, and
Statement Type

¢ Microsoft SQL Server: Application Name, Command, Database Name, and Hostname

¢ Oracle: Action Hash, Module Hash, and Program. When profiling a RAC, there is also an
instance filter that appears to let you limit the profiling results shown to a specific instance.

e Sybase: Application, Database ID, Host, IP Address, and Process priority
You filter results using the filter controls in the upper, right-hand part of the profiling editor.

Filter by: | -None- v| e I

Additionally, on Oracle platforms, you can filter results by user, or foreground, or background
activity. Select All, User (Foreground), or Background to filter out the specified process activity,
respectively.
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To filter profile editor results:

1 Use the Filter By menu to select a filter type. The second menu becomes active based on
your selection in the first menu.

2 Use the second menu to specify a value.
The profiling editor is updated to show only results associated with your choice.

TIP: Select -None- from the Filter by dropdown to restore the unfiltered results.

CONFIGURING PROFILING

This section addresses the following topics:

e Configuring DBMS Properties and Permissions on page 38

e Building Profiling Configurations on page 42

CONFIGURING DBMS PROPERTIES AND PERMISSIONS
Profiling supports the following DBMS platforms:

e |BM DB/2 for Windows, Unix, and Linux
e Microsoft SQL Server

e Oracle

e Sybase

The following describe how to set up a platform to utilize Optimizer on supported database
platforms:

e Configuring IBM DB/2 for Windows, Unix, and Linux on page 38

e Configuring Microsoft SQL Server on page 40

e Configuring Oracle on page 41

* Configuring Sybase on page 41

CONFIGURING IBM DB/2 FOR WINDOWS, UNIX, AND LINUX
NOTE: The connected profiling user should be a member of the DB2 SYSMON group.
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By default, DB2 Monitor flags are set to OFF. As a result, when attempting to launch a Profile job
on a DB2 data source, users may encounter the following message: “One or more errors have
occurred that prevent session profiling against this data source.” Examine the details below and
consult your data source administrator and/or the data source documentation to resolve the
problem(s).”

You can resolve this error using one of two methods:
¢ Enabling DB2 Monitor Flags via Embarcadero DBArtisan

e Command Line Option

To resolve the error through DBArtisan:

1 Ensure the following DB2 Monitor Flags are turned on in DB2:
e dft_mon_uow

e dft_ mon_stmt

dft_mon_lock

dft_mon_bufpool

dft_mon_sort

dft_mon_table

dft_mon_timestamp

You can set view and set Monitor Flags via DBArtisan. Ensure that the New Value field for
each variable is set to Yes, as shown below.

Edit Configuration For, TEP1ESE

Parameter: | dft_mon_bufpool |

Current i alue: |I:IFF |

Hew value: 3

|v.f (1] .9 | |% Cancel | |":' Help |

2 Restart the DB2 data source to enable the changes, then launch DB Optimizer and begin
profiling.
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To resolve the error through the command line:

This solution must be performed from DB2 CLP, on the DB2 server. If you attempt to perform
these tasks through a client, an error message will result.

1 Navigate to start > Programs > IBM DB2/COMMAND LINE TOOLS > COMMAND LINE
PROCESSOR.

2 Turn the monitor switches on using the following commands:

db2 update dbm cfg using dft mon_lock on dft mon bufpool on dft mon_ sort on
dft mon stmt on dft mon table on timestamp on dft mon uow on

db2stop

db2start

3 Ensure that the switches are turned on by connecting to the server with the following
command:

Db2 connect to database username password password

The following screenshot provides an example of the input and output from the server:

db? => connect to gim user dblZadmin
Enter current password for dblZadmin
dbZ? => get monitor switches

Monitor Recording Switches

Switch list for db partition number 0

Buffer Pool Activity Information (BUFFERPOOL) = ON 037052009 19:14:06.61:
Lock Information (LOCE) = ON 03/05/2009 19:14:06.61:
Sorting Information (SORT) = ON 03/05/2009 19:14:06.61:
S5QL Statement Information (STATEMENT) = ON 03/05/2009 19:14:06.61:
Table Activity Information (TRBLE) = ON O03/05/2009 19:14:06.61:
Take Timestamp Information (TIMESTAMP) = ON 03/05/2009 18:50:44.00¢(
Unit of Work Information (UOW) = ON 03/05/2009 19:14:06.61:

CONFIGURING MICROSOFT SQL SERVER
Perform the following tasks to ensure that SQL Server is compatible with Optimizer:

e If you are setting up SQL Server 2000, ensure the current user is a member of the sysadmin
group.

* |f you are setting up later versions of SQL Server, the current user must meet one of the
following requirements:

® Be a member of sysadmin, or have the VIEW SERVER STATE permission enabled.

e Be a member of sysadmin, or have the SELECT permission enabled.
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On SQL Server 2000 only:
You can enable profiling to capture more SQL by adding the following flag:

DBCC TRACEON (2861)

Trace flag 2861 instructs SQL Server to keep zero cost plans in cache, which SQL Server would
typically not cache (such as simple ad-hoc queries, set statements, commit transaction, and
others). In other words, the number of objects in the procedure cache increases when trace flag
2861 is turned on because the additional objects are so small, there is a slight increase in
memory that is taken up by the procedure cache.

Ensure you restart the server for your changes to take affect.

CONFIGURING ORACLE

Oracle users need access to V$ views. In order to configure Oracle to provide users with these
privileges:

e If you are setting up Oracle 10 or later, ensure you are logged in as sys or system with the
sysdba role, or the SELECT_CATALOG_ROLE has been granted to user_name.

e If you are setting up an earlier version of Oracle, ensure you are logged in as sys or system
with the sysdba role.

CONFIGURING SYBASE
Perform the following tasks to ensure that Sybase is compatible with Optimizer:

e Ensure the following system configuration properties are activated:

e Enabling Monitoring (sp_configure “enable monitoring”, 1)
e \Wait Event Timing (sp_configure “wait event timing”, 1)
* SQL Batch Capture (sp_configure “SQL batch capture”, 1)

* Max SQL Text Monitored (sp_configure “max SQL text monitored”, 2048) 2048 is the
suggested value, must be greater than 0. This defines the maximum size a SQL statement
that can be captured.

The following options are specific to Sybase 15.0.2 and higher.
e SQL Text Pipe Active (sp_configure “sgltext pipe active”,1)

¢ SQL Text Pipe Max Messages (sp_configure “sql text pipe max messages”, 512) 512 is the
suggested value, must be greater than 0. This defines the maximum number of SQL
statements that Sybase tracks at any given time. You may want to increase this number if
you observe a lot of UNKNOWN statements in the Profile Editor.

e Statement Statistics Active (sp_configure “statement statistics active”, 1)

® Per Object Statistics Active (sp_configure “per object statistics active”,1)
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Additionally, perform the following tasks, as necessary:

e |f a user does not have mon_role enabled, the user will not be able to access Adaptive
Server's monitoring tables.

e If the monProcess table is missing, the user will not be able to view currently connected
sessions.

e If the sysprocesses table is missing, the user will not be able to view information about
Adaptive Server processes.

e |f the monWaitEventinfo table is missing, the user will not be able to view information about
wait events.

e |f the monProcessSQLText table is missing, the user will not be able to view currently
executing SQL statements.

NOTE: These packages should only be installed by the DBA.

Profiling enables you to create a set of launch configurations to store the basic properties for
each profiling session that you run on a regular basis. A launch configuration enables you to start
profiling sessions from a single menu command, rather than re-define configuration parameters
each time you want to run one.

BUILDING PROFILING CONFIGURATIONS

Profiling enables you to store parameters related to specific profiling sessions, in a profile
configuration for stored routines. Multiple configurations can be created for each data source in
your enterprise and saved with unique names that identify them in the application.

NOTE: On all supported platforms, support for stored routines includes functions and
procedures. On Oracle, stored routine support also includes package functions and
package procedures.
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To create a profile configuration:

1 Right-click the data source you want to build a configuration for and select Profile As from
the menu, then choose Profile Configurations.

The Profile Configurations dialog appears.
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Create, manage, and run configurations @

Nae: | ROMLABORCLS_2 |

| | - -
: - Profile . =] Comman
5] m’ Data Source Eﬁ]

i romasoRcLE_y || || Frefing Tarest
m: ROMLABORCLSI_2 Data source:| ROMLABORCLSI_Z (Oracle) |
s 5L Stored Routine [IReal Appication Cluster (RAC) mode

Profiling Pepositary
{%)Save to disk {.OAR: file)

Time inkerval length: |1 5 hours | 0 3| minubes

{1 Save to data source:

Real-time profiing
[+#] Shaws data while profiling session is in progress

Refreshimterval: |5 5 | seconds

< > el Ravar
Fiker makched 4 of 4 ikems

@ [ Profile | [ Close

2 Select the name of the data source and modify the parameters on the Profile tab, as
needed.

3 In the Name field, provide a name for the launch configuration. You should select a name
that will make the launch configuration unique and easily identified once it is saved in the
application.
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4 In the Profiling Target area, click Real Application Cluster (RAC) mode if the target
database is an Oracle RAC. This enables you to profile the entire cluster in one profiling
session. (In general, profiling a RAC entails querying the GV$ views.)

TIP:  When profiling a RAC, you can also filter the profiling details to show only the details
for a selected instance. At the top of the Profiling view, click the Instances list and
choose the instance you want to examine.

5 In the Profiling Repository area, choose to save the profile session to disk or if you are
profiling an Oracle data source then you can choose to save the profile session to the data
source.

If you choose to save the session to disk, in the Time interval length area specify the length
of the profiling session. When you try to close the Profile Session, you will be prompted to
save the file and can then name the file as desired.

A .oar file saved to disk opens very quickly from File > Open dialog and has a limit of just
under 1000 hours of profiling data. Profiling to a data source directly allows the system to
capture more data for a longer period of time, until you decide to stop the profiling session.
The profiling session is automatically saved to the Profiling Repository where other DB
Optimizer users can also view the session for their own analysis.

6 Click Apply. The launch configuration is stored in the application.

Once a launch configuration is defined, you can execute it in profiling. For more
information, see "Running a Profiling Session" on page 4.

NOTE: The parameters provided when you select the data source name in the left pane control
session parameters for the specified data source. To set these controls, see

"Configuring DBMS Properties and Permissions" on page 38.

The following describes fields and options of the Profile tab that require further explanation.
* Name indicates the name of the profile configuration.

¢ Data source indicates the name of the data source to which the profile applies.

DB OPTIMIZER™ XE PRO 2 USER GUIDE 44



USING PROFILING > CONFIGURING PROFILING

¢ Save to disk/Save to data source gives you the option to save your profiling session to a
.oar file which you can access from within DB Optimizer or you can save the profiling session
to a data source of your choice if you are using an Oracle data source. DB Optimizer will
create a Profiling Repository, similar to the following on the selected Oracle data source. The
structure of the Profiling Repository is created from the name of the data source and the
date and time of each specific profiling session.

E'EI Data Source Explor 22 %’ S0L Project Explore =0
TN

=l 1=F Managed Diata Sources (8] L
=I-=F Data Source Group (3)
=I-{=F Microsoft SOL Server (2)
+-l=F Microsaft S0L Server (1)
+- S TORLAESCQLOO_1_#2 (S0L Server 8,0,20
=T+ Cracle (&)
+ ﬁ Mew data source (Oracle 5.1.7.4)
+- i ROMLABORCLSI_1 (Oracle 8,1.7.4)
+- S ROMLABORCLSi_Z (Oracle 2,2.0.1)
= _‘9!|v sfvpclbi0l.embarcadero.com (Cracle 10,2
+ l__l:;l Database Ohijecks
= |l|_l[| Prafiling Repository
= i rormlabsgldS_1-5a
4, 2010-01-08 00:46:23 {34m)

+- [ TORLABORCLSI 2 (Oracle 5.1.7.4) v
< »

Saving your profiling sessions to a live data source enables you to better organize your
profile session data for later review.

¢ Time Interval Length indicates how many hours of the session to save to disk. Since the
profile session continues until you manually stop it the session length may exceed the time
interval length. For example, the time interval length is set to four hours but the profiling
session continues for 10 hours. In this case only the last four hours of data is retained. This
parameter also indicates the total width of the time load graph. The longer a profile is, the
larger the saved file will be. For heavily loaded databases, the time interval length value
should not exceed eight hours.

e The Show Data While Profile Session is in Progress check box enables “real time”
profiling, which refreshes the data of the session as profiling runs. The Refresh Interval
specifies how often in seconds profiling updates this data.

NOTE: Profiling can run sessions based on ad hoc parameters you designate before executing
the profiling process. However, by building profile launch profiles, it is a much more
efficient method of managing standard, frequent, or common profiling sessions.
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USING LOAD TESTER

File Edit Mavigate Search Project Run Window Help
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The load editor can be run either with File > New > Load Editor or with the load editor icon
shown above in the red square.

The icon depicts an RPM meter on a car with a red line. The idea behind the icon is that we can
run a load on a database and stress the database with the load similar to red lining.
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The load editor page has space on the left to show the sgl to be run. The sgl can be typed in or
pasted in or read from a file if the SQL File option at the top right-hand side of the window is
selected.
On the right are options on how to run the SQL

® Number of parallel sessions

e Length of test

* Number of executions
Sleep between executions

e No sleep

e Fixed sleep
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e Random sleep between a max and min

Methodology
e \Write SQL with Editor

Set up Load with Load Editor

Kick off profiling the database

Run the load in the Load Editor

Verify the database load profile to see if there are any major issues

The SQL Load Editor enables you to configure and execute SQL code against a data source.
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This feature enables you to specify a data source against which the code will be executed, and
then provides options that enable you to choose a period of time that you want the script to
execute for, and at what intervals the execution “loop” occurs.

On execution, SQL Load Editor runs in the background. It can therefore be run in conjunction
with a profiling session in order to analyze the effects of the executing load against the specified
data source. Once you run a SQL script via Load Editor, you can start the SQL Profiling function
and analyze the results of the load.
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The Load Editor is accessed via the Load Editor icon on the Toolbar:

= SQL Optimization - Untitled SOL Load - Embarcadero DB Optimizer - C:\Documents 3
File Edit Mavigate Search Project Run Window Help

0-8-Q-: 4

When you open Load Editor, click Select Data Source to specify the data source against which
you want the SQL script to run.

Choose Ad hoc SQL and manually type (or copy/paste) the SQL code into the window provided,
or select SQL file and navigate to the SQL file you want to run. The window populates with the
code from the selected file.

The following configuration parameters are set with Load Editor prior to executing the SQL
script:

Configuration Parameter Description

Number of Parallel Sessions Specifies the number of jobs that the
execution script will operate on.

Execution End Condition Specifies if the script execution process
runs for a set amount of time or script
executions.

Choose Time if you want the script to
execute over a specific period of time,
or Number of Executions if you want
the script to execute a specific number
of times.

Sleep Between Executions Specifies if Load Editor will wait before
running the execution script again.
Select the check box and choose Fixed
Delay or Random Interval, depending
on whether you want the script to
execute at a specific time, or at
random intervals within a specified
range of time.

To run Load Editor:
1 Access Load Editor by selecting the icon on the Toolbar. Load Editor opens.

2 Click Select Data Source and choose a data source you want to run the SQL code against.

3 Choose Ad hoc SQL or SQL file, and then copy/paste or manually type the code you want
to execute in the window provided, or navigate to the location of the file, respectively.

4 In the right-hand panel, choose the execution configuration parameters to specify how you
want Load Editor to handle the script.

5 Click the Execute icon in the lower right-hand corner of the screen. The script starts to
execute against the specified data source, using the configuration parameters you selected.
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6 Ifyou are profiling a data source, start and run a new profiling session on the data source you
specified in Load Editor. The session will reflect how your SQL script executes against the
specified data source.
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This section provides information on tuning, its functionality, and is structured so a user can
follow the information provided to fully tune their enterprise in terms of more efficient query
paths at the SQL statement level of individual data sources.

Tuner has three parts
® Query rewrites and quick fixes
e Alternative execution plans generated via optimizer directives
¢ Analysis of Query showing
® Indexes used, not used, missing (suggested to create)
¢ Graphic display of query

The SQL tuner will take a query and add database optimizer directives to change the execution
path of the query. A list of all the unique execution paths will be generated with all duplicates
eliminated from the list. The final list of alternative paths can be executed. Any path that takes
more that 150% of the base case will be canceled because we are only interested on paths that
could be faster than the base case so no need to waste time and resources continuing to run
cases that are slower than the original. After the cases have been executed they can be sorted in
order of elapsed time. If a better path is found then those optimizer directives can be included in
the original query to achieve optimal response time.

You can save the entire content of a tuning job for later analysis or for sharing with other users.
This section contains the following topics:

e Introduction to Database Tuning on page 5

e Understanding the Tuner Interface on page 18

e Tuning SQOL Statements on page 25

¢ Using Oracle-Specific Features on page 62
¢ Additional Tuning Commands on page 66

e Configuring Tuning on page 69

e Examples of Transformations and SQL Query Rewrites on page 74

e DBMS Hints on page 76

INTRODUCTION TO DATABASE TUNING

This discussion will help you understand the methodology behind DB Optimizer's tuning
functionality and how you can use it to optimize database performance. This discussion is
comprised of the following topics:
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Introduction to DB Optimizer’s Tuner on page 6

SQL Tuning Methodology on page 8

SQOL Tuner Overview on page 9

What's happening on the databases? on page 10

Tuning Example on page 13

® The Database is Hanging or the Application has Problems on page 13

e The Database Caused the Problem on page 15
e The Machine Caused the Problem on page 16

Finding and Tuning Problem SQL on page 18

INTRODUCTION TO DB OPTIMIZER'S TUNER

DB Optimizer's methodology grew out of the impossible predicament presented by the defacto
method of database tuning. The standard method was trying to collect 100% of the statistics
100% of the time. Trying to collect all the statistics as fast as possible ends up putting load on
the monitored database and creating problems. Stories of problems created by database
monitoring products abound in the industry. In order to avoid putting load on the target
database, performance monitoring tools have to collect less often as a compromise. Oracle
compromised in 10g with AWR (their automated performance data collector), only running it
once an hour because of the performance impact. Not only is the impact on the monitored
target high, but the amount of data collected is staggering, but the worst problem of all though,
is the impossibility of correlating statistics with the sessions and SQL that created the problems
or suffered the consequences.

The solution to collecting performance data required letting go of the old problematic
paradigm of trying to collect as many performance counters possible as often as we could and
instead freeing ourselves with the simple approach of sampling session state. Session state
includes what the session is, what its state is (active, waiting, and if waiting, what it is waiting on)
and what SQL it is running. The session state method was officially packaged by Oracle in 10g
when they introduced Active Session History (ASH). ASH is an automated collection of session
state sampling. The rich robust data from ASH in its raw form is difficult to read and interpret.
The solution for this was Average Active Sessions (AAS). AAS is a single powerful metric which
measures the load on the database based on the ASH data. AAS data provided the perfect road
map for what data to drill into. The main drill downs are “top sgl”, “top session”, “top event”,
and “top objects”.

Other aggregations are possible based on the different dimensions in the ASH data.
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Here is an example screen shot of the same batch job being run four times. Between each run
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Run:

1 Inrun1,” logfile sync “event is the primary bottleneck. To correct this we moved the log files
to a faster device. (You can see the checkpoint activity just after run 1 where we moved the

log files.)

In run 2, the "buffer busy wait” event is the primary bottleneck. To correct this we moved the

table from a normal tablespace to an Automatic Segment Space Managed tablespace.

In run 3 the “log file switch” (checkpoint incomplete) event is the primary bottleneck. To

correct this we increased the size of the log files. (You can see the 10 time spent creating the
new redo logs just after run 3.)

The run time of run4 is the shortest and all the time is spent on the CPU which was our goal,

take advantage of all the processors and run the batch job as quickly as possible.

NOTE:
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Conclusion:

With the load chart we can quickly and easily identify the bottlenecks in the database, take
corrective actions, and see the results. In the first run, almost all the time is spent waiting, in the
second run we eliminated a bottleneck but we actually spent more time - the bottleneck was
worse. Sometime this happens as eliminating one bottleneck causes great contention on the
next bottleneck.(You can see the width of the run, the time it ran, is wider in run 2). By the third
run, we are using more CPU and the run time is faster and finally by the 4th run all the time spent
is on CPU, no waiting, and the run is the fastest by far.

SQL TUNING METHODOLOGY
1 Verify that the execution path is the optimal for the query

If not either use the tuning directives (such as hints on Oracle) or
Identify why the native optimizer failed to pick the optimal path
2 If the query is still slow then look at adding indexes
3 If the query is still slow, then you know you are going to have to look a the architecture
What information is the query trying to get?
Is this information necessary?
Are there alternative ways to get this information?

DB Optimizer's SQL Tuner can help with 1 and 2. Step 3 will have to be done by a developer or
DBA but knowing that step 1 and 2 have already been validated can indicate to management
that step 3 is necessary rand therefore allocate sufficient resources for step 3.

How do we know if the native database optimizer chose the optimal path? How long would it
take to check this by hand?

DB Optimizer's SQL Tuner is a solid fast sanity test to verify the plan chosen by the native
database SQL optimizer. Tuner quickly generates as many alternative paths as possible and
allows the user to execute them to see if there are more efficient execution paths. DB
Optimizer's SQL Tuner is successful at tuning queries that have a suboptimal execution path.

A query has a sub-optimal execution path when the database optimizer has miscalculated the
cost of the various possible access paths and mistakenly chosen a bad path. The access path
calculations can be miscalculated because of the following reasons:

¢ The table/index statistics are missing or wrong. (For example, the number or rows is missing
or way off.)

® The data is skewed, for example, the number of orders with an open status is usually low
compared to all the orders that have a closed status because the work is complete. (For
example, orders get filled every day, but only a few are open and needing to be processed.)
Looking for open orders should probably use an index and return fewer rows than looking
for closed orders which should probably just do a full table scan.
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® The predicates used are correlated. The optimizer treats two predicate filters on a table as
more selective than just one, but this is not always the case such is the case in the query, how
many Swedes speak Swedish which basically returns the same number of results as just
asking for the number of Swedes alone. Another example is how many Swedes speak
Swahili, which is probably more selective than the optimizer would guess.

e Abugin the optimizer

DB Optimizer's SQL tuner will take a query and try to produce as many execution paths as
possible. These alternative execution paths can then be run to see if there is a faster or less
resource expensive execution path. The execution of each alternative case is timed and if the
execution exceeds 1.5 X the original case then its execution is stopped and we move on to the
next case. This avoids wasting time and resources on execution plans that are clearly
suboptimal.

SQL TUNER OVERVIEW

Tuning provides an easy and optimal way to discover efficient paths for queries that may not be
performing as quickly or as efficiently as they could be.

The application enables the optimization of poorly-performing SQL code through the detection
and modification of execution paths used in data retrieval. This process is performed through
the following functions:

® Hint Injection
¢ Index Analysis
e Statistic Analysis (Oracle only)

e Query re-writes such as suggesting joins to eliminate Cartesian joins, adding transitivity
predicates, and unnesting subqueries in the WHERE claus.

Tuning analyzes an SQL statement and supplies execution path directives to the application that
encourage the database to use different paths.

For example, if tuning is selecting from two tables (A and B), it will enable the joining of A to B,
or B to A as well as the join form. Additionally, different joining methods such as nested loops or
hash joins can be used and will be tested, as appropriate. Tuning will select alternate paths, and
enable you to change the original path to one of the alternates. Execution paths slower than the
original are eliminated, which enables you to select the quickest of the returned selections and
improve query times, overall.

This enables the DBA to correctly optimize queries in the cases where the native optimizer
failed.
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WHAT'S HAPPENING ON THE DATABASES?

Is the database idle, working or bottlenecked?

When a bottleneck happens how can you know which of these problems are causing the
problem? A bottleneck could be caused by:

* An application problem
® An undersized machine
¢ SQL requiring optimization
¢ A misconfigured database
All of these can be easily identified from DB Optimizer's performance profiling screen.

Let's look at the components of the performance profiling screen
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The screen has six important parts

1. Databases. For more information, see "Databases" on page 11.

2. Average Active Sessions (AAS) Load of selected database. For more information, see

Average Active Sessions (AAS) Load of selected database" on page 11.

3. Maximum CPU line. For more information, see "Maximum CPU line" on page 11.

4. Top SQL. For more information, see "Top SQL, Top Bottlenecks, and Top Sessions" on

page 12.

5. Top Bottlenecks. For more information, see "Top SQL, Top Bottlenecks, and Top

Sessions" on page 12.

6. Top Sessions. For more information, see "Top SQL, Top Bottlenecks, and Top Sessions'

on page 12.
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Databases
First, on top left, is a list of our databases we have registered.
Average Active Sessions (AAS) Load of selected database

The most important part of the screen is the Average Active Sessions (AAS) graph. AAS shows
the performance of the database measured in the single powerful unified metric AAS. AAS easily
and quickly shows any performance bottlenecks on the database when compared to the
Maximum CPU line. The Max CPU line is a yardstick for performance on the database. When
AAS is larger than the Max CPU line there is a bottleneck on the database. Bottleneck
identification is that easy.

AAS or the average number or sessions active, shows how many sessions are active on average
(over a 5 second range in DB Optimizer) and what the breakdown of their activity was. If all the
users were running on CPU then the AAS bar is all green. If some users were running on CPU
and some were doing |O, represented by blue, then the AAS bar will be partly green and partly
blue.

Maximum CPU line

The line "Max CPU" represents the number of CPU processors on the machine. If we have one
CPU then only one user can be running on the CPU at a time. If we have two CPUs then only 2
users can be on CPU at any instant in time. Of course users can go on and off the CPU extremely
rapidly. When we talk about sessions on the CPU we are talking about the average number of
sessions on CPU. A load of one session on the CPU, thus would be an average which could
represent one user who is consistently on the CPU or many users who are on the CPU for short
time periods. When a CPU becomes a resource bottleneck on the database we will see the
average active sessions in CPU state go over the Max CPU line. The number of sessions above
the max CPU line is the average number of sessions waiting for CPU.

The Max CPU is a yardstick for performance on the database.

From looking at the previous chart the problem is a machine resource problem.
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Top SQL, Top Bottlenecks, and Top Sessions

In order to know what the problem is, we have to find out where that demand is coming from. To
find out where the demand is coming from we can look at Top SQL and Top Session tables
below the load chart. In our case shown here the load is well distributed over all SQL in Top SQL
and all sessions in Top Session. There is no outlier or resource hog. In this case it's the machine
that's underpowered. What does a case look like where we should tune the application? The
following screenshot depicts such a problem.
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In this case, again the CPU demand is more than the machine can supply but if we look at “Top
SQL" we can see that the first SQL statement (with the large green bar) uses up much more CPU
than any of the rest, actually 60%! If we could get it down to 10% CPU then we'd save 50% of the
CPU usage on the machine! Thus in this case it's worth our while to spend a day or week or even
a couple weeks trying to tune that one SQL statement instead of buying a bigger machine.
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Finally, how do we know when the database configuration is a problem? We know it's a
configuration problem when we are seeing something other than CPU as the bottleneck in Top
Bottleneck section. Here's an example

In this case we can see the load is higher than the Max CPU line but the load is coming from
brown colored bars and the green CPU colored bars. If we look at Top SQL we see that there is
only one SQL taking up almost all the load, but it's not because of CPU which would be a green
bar, but some other color. What does this other color represent? We can look at the Top
Bottleneck section and see that it is “log file switch (incomplete)” which basically means the log
files are too small, the database is not correctly configured. This bottleneck can be resolved
simply by increasing the log size.

TUNING EXAMPLE

This example is comprised of the following parts:

e The Database is Hanging or the Application has Problems on page 13

e The Database Caused the Problem on page 15

¢ The Machine Caused the Problem on page 16

THE DATABASE 1S HANGING OR THE APPLICATION HAS PROBLEMS

| wonder if you can imagine, or have had the experience of the application guys calling with
anger and panic in their voices saying, “The database is so slow, you've got to speed it up.”

What's your first reaction? What tools do you use? How long does it take to figure out what's
going on?
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Let's take a look at how it would work with DB Optimizer.

e B

We can clearly see that the database is not bottlenecked and there must be a problem on the
application.

Why do we think it's the application and not the database? The database is showing plenty of
free CPU in the load chart, the largest chart, on the top in the image above. In the load chart,
there is a horizontal red line. The red line represents the number of CPUs on the system, which in
this case is two CPUs. The CPU line is rarely crossed by bars which represent the load on the
database, measured in average number of sessions. The session activity is averaged over five
samples over five seconds, thus bars are five seconds wide. The bars above fall mostly about one
average active session and the bars are rarely green. Green represents CPU load. Any other
color bar indicates a sessions waiting. The main wait in this case is orange, which is log file sync,
waits for commits. Why is the database more or less idle and why are most of the waits we do
see for “commit”? When we look at the code coming to the database we see something like
this:

insert into foo values ('a');
commit;
insert into foo values ('a');
commit;
insert into foo values ('a');
commit;
insert into foo values ('a');
commit;
insert into foo values ('a');
commit;
insert into foo values ('a');
commit;
insert into foo values ('a');
commit;
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Doing single row inserts and committing after each is very inefficient. There is a lot of time
wasted on network communication which is why the database is mainly idle. When the
application thinks it's running full speed ahead, it is actually waiting mainly on network
communication and commits. If we commit less and batch the work we send to the database,
reducing network communications, we will run much more efficiently. Changing the code to

begin
for i in 1..1000 loop
insert into foo values ('a');
-- commit;
end loop;
end;
/

commit;

improves the communication delay and now we get a fully loaded database but we run into
database configuration issues.

THE DATABASE CAUSED THE PROBLEM

Bt e e et e oy A g £

D U T ———

I mpem e Gmme - prem e

E e S Q- :
ki B e = I P LA T
o b - -
[ (RS 5
-
[ ] ¥ i i ¥ - Tp— ¥ sr s
=4 v
- el s
- Y
o -
I 2
=
-
=
-
-
- 3 3
=P s
E L rumre
o =" ety — ———
" e —r— —— i rr— r
- o i o e 8 v i - — =
g o - - B = 13
. ] ™ ey
wr L L e
- L] - -
- 1 - ]
. i L}
¥ - »
i ] =
= N
= -

In the above DB Optimizer screen, the same workload was run 4 times. We can see that the time
(width of the load) reduced, and the percent of activity on CPU increased.

Runs:

1. "log file sync”, the orange color, is the biggest color area, which means uses are waiting on
commits, still even though we are committing less in the code. In this case we moved the log
files to a faster device. (you can see the checkpoint activity just after run 1 where we moved the
log files)

2 "buffer busy wait”, the burnt red, is the biggest color area. We drilled down on the buffer busy
wait event in the Top Event section and the details tells use to move the table from a normal
tablespace to an Automatic Segment Space Managed tablespace.
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3."log file switch (checkpoint incomplete)”, the dark brown, is the largest color area, so we
increased the size of the log files. (You can see the 10 time spent creating the new redo logs just
after run 3.)

4. The run time is the shortest and all the time is spent on the CPU which was our goal, to take
advantage of all the processors and run the batch job as quickly as possible.

THE MACHINE CAUSED THE PROBLEM
Now that the application is tuned and the database is tuned let's run a bigger load:
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We can see that the CPU load is constantly over the max CPU line. How can we have a bigger
CPU load than there are actually CPUs on the machine? Because the demand for CPU is higher
than the CPU available on the machine. In the image above there are 2 CPUs on the machine but
an average of three users think they are on the CPU, which means that on average one user is
not really on the CPU but ready to run on the CPU and waiting for the CPU.

At this point we have two options. In this case we are only running one kind of load, the insert.
For inserts we can actually go even further tuning this insert and use Oracle's bulk load
commands:

declare

TYPE IDX IS TABLE OF Integer INDEX BY BINARY INTEGER;
MY IDX IDX;

BEGIN
for i in 1..8000 loop

MY _IDX(i):=1;

end loop;
FORALL indx IN MY IDX.FIRST .. MY IDX.LAST
INSERT INTO foo ( dummy )
VALUES ( MY_IDX (indx) );
COMMIT;

end;

/
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But if this was an application that had a lot of different SQL and the SQL load was well
distributed across the system then we'd have a case for adding more hardware to the system.
Making the decision to add more hardware can be a difficult decision because in general the
information to make the decision is unknown, unclear or just plain confusing, but DB Optimizer
makes it easy and clear, which can save weeks and months of wasteful meetings and debates.
For example
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If we look in the bottom left, there is no SQL that takes up a significant amount of load, there is
no outlier SQL that we could tune and gain back a lot of wasted CPU. We'd have to tune many
SQL and make improvements on most of them to gain back enough CPU to get our load down
below the max CPU line. In this case, adding CPUs to the machine might be the easiest and
most cost affective solution.

Conclusion:

e With the load chart we can quickly and easily identify the bottlenecks in the database, take
corrective actions, and see the results. In part 1 we had an application problem, in part 2 we
had 3 database configuration issues and in part 3 we had a hardware sizing issue. In all 3
instances DB Optimizer provides a clear and easy presentation of the data and issues
making solutions clear.
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FINDING AND TUNING PROBLEM SQL
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DB Optimizer is targeted at finding problem sgl in a running load with the profiler and then
tuning that (or those) specific queries with the tuner.

It's not efficient just to dump a bunch of procedure code into the tuner and then try and see if
any of the SQL in the package or procedure are tunable. Most queries should, by default, run
optimally on a database, so the goal of DBO is to tune those queries that for one reason or
another are not optimally tuned by the database by default. The easiest way to find those
queries is to identify them on a running system. They can be identified on a running system
because they take up a lot of resources. If we find a resource intensive query then it's worth the
time to generate cases and analyze it for missing indexes to see if there is a way to tune it.

UNDERSTANDING THE TUNER INTERFACE

In the application interface, tuning is composed of two tabs:
e Overview

® Analysis

NOTE: When using tuning on Oracle sources, several additional tabs appear on the Analysis
and Outlines tabs. For more information on utilizing these extra features, see "Using
Oracle-Specific Features" on page 62.
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UNDERSTANDING THE OVERVIEW TAB
Inputting SQL to tune

Click the SQL button on the Overview tab to specify the source of SQL statements you
want to tune.
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* New SQL Text: From the SQL button menu, select New SQL Text, and then copy/paste
SQL statements to the SQL Text dialog or write queries by hand and then click OK.

& soL Text (=1 E3

SELECT
A.

D o T I o O o R =

=11
FROM
P3
WE
WE
P3
P3
WHEERE

eI = T - R

.RUN_ID =
.PAY CONFIRM RUN =
.COMPANY =
.PAYGROUP =
.OFF_CYCLE =
.EFFDT =

COMPANTY,

.PAYGROUF,

-OFF CYCLE,

- SEPCHE FLAG,

- TAX METHOD,

. TLE PERIODS,
.RETROPAY ERNCD,

M (C.AMOUNT DIFF) 3UM AMOUNT

_PAY CALENDAR &,
_JOB B,
_RETROPAY EARNS C,

_RETROPAY RQST D,

_RETROPAYPGM TBL E

'PDZ' AND

'M' AND

A.COMPANY AND

A.PAYGROUP AND
AL.PAY OFF CYCLE CAL AND

(SELECT /*+ gb name(wb ki) */

LY

|

Ik l [ Cancel

20

TIP:

You can also input SQL by clicking anywhere in the Tuning Statements area and

pressing Ctrl-V.

Once you have input the SQL and click OK, you can later edit the text by right-clicking an

entry in the Tuning Statements area and selecting Edit.
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* Extract from Database Objects: Search for and then select (Ctrl-click) data base objects
containing SQL that you want to tune from the selected data source. DB Optimizer will
search through the database to find objects matching your input and presents matches for
you to choose. In order for this option to work, you must enable Data Source Indexing in the
properties for the database. If the data source has not already been indexed you will receive
a message indexing that no indexing information is available. You can configure the
database Properties dialog from the Data Source Objects Selection dialog by clicking
Configure data source indexing....

& Data Source Objects Selection i:.@

Enter object name prefix or patkern (¥ = any character, * = any skring): -

E |

Matching objects:

& COUNT_TIME_INTERVAL {Package) - SYSTEM ~
S DEMS_REPCAT ALTH (Package) - SYSTEM
% DRS (Package) 3
=< DRGS (Package) - SYSTEM
? (Package) - SYSTEM
% DRGSS (Package)
~ L EMP_ACTIONS (Package) - SYSTEM
RN MENT MATA SFelemant :

Confiqure data source indexing.. .

® [ (4 H Cancel ]

For information on setting data source indexing properties, see "Specify Data Source
Indexing Preferences" on page 33.

¢ Import from File (Workspace) and Import from File (System): Browse the workspace or
file system and select an SQL file from which to extract statements to tune.
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® Scan Oracle SGA: For the Oracle platform only, you can also scan the System Global Area
(SGA) for statements to tune.

& Scan 5GA |_,®
SGA filters .
Specify the filkering criteria for ackive SQL in the SGA, DJ

Filker Criteria

Mazimurn retrieved queries:ﬂ'| =

Sort by: |CPU Time v |

advanced Filters

User: | A4 |

Parsing Schema;

Module: | w |
Bckion: | e |
Service:

® You can also drag and drop Materialized Views, Procedures, and Views from the Data Source
Explorer to the Tuning Statements grid and they will be added to the list of statements to
tune.

Running a Tuning Job

Once you click the Run Job icon on the top right-hand side of the Overview tab, the Overview
tab provides the list of statements that were analyzed by the Tuner, as well as the cases
suggested by the execution process to improve them. Additional information may include
statement Name, Text, Source, Cost, and Elapsed Time values, depending on the platform.
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Only the Elapsed Time statistic, appears on all supported platforms. On Oracle platforms,
Execution Statistics and Other Execution Statistics columns will appear. When determining the
best possible path using the Overview tab, it is best to use the Elapsed Time value as the
guideline. The faster the path, the more optimized the query will become.

It *rorAaoROE L L2 ontted Toning Joh e £ =8
b Pl Cvace B [HE ROMLABOROLED (5.1.7.4)

| Owerview | > Analysis |
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Statemant Tinre Anabyiis i
Tame: SchETi Text Tables Hins Elopsed [5) | Dmproved (5] Coses Treckeszess
# [ASEECT 3 T seluck from sys.jobf 0
#y Msaecra e select from Fet§, wsf o
*, [MAszEcTs S sedct from pendng_transd 0
| # [AsEEcTS 55 seleck from sys.obif 0 o
Generated Cases k-
501 Sratemerts snd Cases ¥ Cost | seEwnctl istes | Cithe EerLbhon Satkscs |
) Tt ahie Elsps=d Tive= {57 Fhivscel Feads | Locical Reads ZEU Tire (57
3__, = SASELECT | sedrect from SYSTELDEFS ALl .56 u] .00
==l IHDES _COfMBINE L. 063 u] 11 000
= INDEX EZE.0 i8] o 0.0o
m=l RULE 0.77 u] q 0,00
El Py SELECT 3 sel=ct from sys.jobf
E| - AysELECTA sedect from Fetf, raf
El SELECT 5 sedail from pandng_traref
El ?’jh'_LLLI b celsct from sus.obif, susooesE, rof,

There are three tuning options to choose from before clicking Run Job:

To analyze the SQL statement, click Generate cases

To perform the analysis that populates the Analysis tab now, click Perform detail analysis.
Otherwise, the analysis tab is populated when you click the Analysis tab.

To have the system generate execution statistics, click Execute each generate case and
then select the number of time the system should execute each generated case. Multiple
executions can verify that the case results are not skewed by caching. For example, the first
time a query is run, data might be read off of disk, which is slow, and the second time the
data might be in cache and run faster. Thus, one case might seem faster than another but it
could be just benefiting from the effects of caching. Generally, you only need to execute the
cases once, but it may be beneficial to execute the cases multiple times to see if the
response times and statistics stay the same.

UNDERSTANDING THE ANALYSIS TAB

Index analysis is started when you either generate cases with Perform detail analysis selected
on the Overview tab, or when you click the Analysis tab. If any columns referenced in the
WHERE clause of the tuning candidate are not the first column of an index, tuning will
recommend that you create an index on that column.
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The color-coded Index Analysis feature highlights missing indexes as well as shows which
indexes are used and which are not used in the default execution path. The Index Analysis
feature highlights issues where the database optimizer might not be using the preferred
indexes. DB Optimizer also lists indexes on the tables that do not have fields in the WHERE
clause helping the designer to see if adding an additional predicate in the WHERE clause might
make use of an existing index.

The layout of the Analysis tab shows the SQL text and Visual SQL Tuning (VST) diagram on the
top, and the indexes on the tables in the query below.
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The Analysis tab has five important components as depicted in the previous illustration:

—_

Statement selector, if there are multiple statements in the tuning set.
2 Statement text for selected statement.

3 Graphical diagram of the SQL statement.
4

Index analysis of the SQL statement.

24 DB OPTIMIZER™ XE PRO 2 USER GUIDE



USING TUNING > TUNING SQL STATEMENTS

5 Description of the selected index, including the reasoning behind DB Optimizer
recommendations.

NOTE: For the Oracle platform, there are several other tabs available, including Table
Statistics, Column Statistics And Histograms, and Outlines. For more information, see
"Using Oracle-Specific Features" on page 62.

TIP:  The text, diagram, and analysis sections can be resized or expanded to take up the
whole page.

The Analysis tab suggests missing indexes, indicates which indexes are used in the execution
path and lists all indexes that exist on all the tables in the query. Indexes on the table are listed
on the Analysis tab and color coded as follows:

Text Color Interpretation

Index is used in the query

- Index is usable but not used in the current execution path.

This index is missing. DB Optimizer recommends that you create this index.

This index exists on the table but not usable in this query as it is written.

In the Collect and Create Indexes table, orange-highlighted entries indicate missing indexes
that DB Optimizer recommends be created to improve performance. Clicking on that index,
displays text to the right outlining the rational behind this recommendation.

For more information on using the Analysis tab, see "Using the Analysis Tab" on page 38.

TUNING SQL STATEMENTS

A tuning job enables you to view the cost details of SQL statements on a registered data source
and then select the best, or most efficient, array of execution path directives in order to make
query execution faster, therefore improving the entire enterprise, overall.

A tuning job consists of a set of SQL statements and any analysis results you generate against a
data source using tuning. The SQL statements and analysis results that compose a tuning job
can be saved in a tuning file (.tun). This enables you to open a tuning job at a later time for
inspection and analysis, to add, delete, or modify the SQL statements, or generate new
execution statistics.

The following topics provide a high-level overview of the tuning process:

1 Create a New Tuning Job on page 26

2 Specify a Data Source on page 26

3 Add SQL Statements on page 28

4 Run a Tuning Job on page 30
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5 Analyze Tuning Results on page 32

6 Modify Tuning Results on page 36

NOTE: Foradditional commands that fall outside the general tuning workflow, but may still be
helpful, see "Additional Tuning Commands" on page 66.

TIP: Forinformation on working with data sources such as adding and browsing them, see
Working with Data Sources on page 43.

CREATE A NEW TUNING JOB

New tuning jobs can be created via the File > New > Tuning Job command, or by importing
statements directly from profiling. A New Tuning Job icon is also available on the Toolbar.

To create a new tuning job via the Menu or Icon command:

Select File > New > Tuning Job, or click the New Tuning Job icon on the Toolbar. Tuning
opens.

You can now proceed to set up the parameters of the new job.

To create a new tuning job from profiling:

After you have run a profiling session, in profiling’s Profiling Details tab, select one or more
statements, right-click, and select Tune from the context menu. Tuning opens, pre-
populated with parameters based on the statements you selected.

To open an existing tuning job:
Navigate to the SQL Project tab and double-click the name of the existing tuning job.

To name a job, save it:

Ensure you specify a meaningful name that identifies the job in other views and dialogs. You
can save the job by selecting File > Save or File > Save All from the Menu bar. Once a job
is saved, it is added to the SQL Project view.

SPECIFY A DATA SOURCE

The bread crumbs at the top of the tuning job window identify the data source where the SQL
statements to be tuned reside. The default data source is the one that was selected when the
new tuning job was initiated. For example in the following image, we see that the data source is
TORLACSCORCL., which is part of the Oracle data source group. The color of the bar at the top
of the tuning window shows the category of the data source as defined in the data source
configuration properties.
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b '} Oracle b S8 TORLABSCORCL (10,2.0.1)
= Overview Fi“-' Analysis

£E Overview

You can change the data source of a tuning job by clicking a bread crumb triangle and then
navigating to the data source or using the filter to locate and then select a data source. In the
following screenshot, Microsoft SQL Server was clicked and T was entered in the filter text area,
which resulted in several matches.

[= [=F Data Source Group
= 1=F Microsoft SOL Server
[=-T=F Microsaft S0L Server

SC
8 TORLABSQLOO_1_

Click the name of the desired data source to affect the change.

NOTE: Multiple tuning jobs can be saved against the same data source. You can therefore set
up your tuning jobs organizationally. You might for example, set up a tuning job to tune
only SQL associated with procedures or a set of SQL sources that are functionally
related. Alternatively, your tuning jobs may be organized by application.

DB OPTIMIZER™ XE PRO 2 USER GUIDE 27



USING TUNING > TUNING SQL STATEMENTS

ADD SQL STATEMENTS

Once you have created a tuning job and named it, using File > Save As, you need to add SQL

statements to the job that are to be tuned. All standard DML statements can be tuned (SELECT,
INSERT, DELETE, and UPDATE).

NOTE: When you try to tune a statement containing a bind variable you will be warned that
either the type is not set or the value is not set. Mouse over the error to learn what
problems were detected.

b '}y Oracle b 8] TORLABSCORCL (10.2.0.1)

= Overview [&' Analysis

@ Overview 1 eror detected

Tuning Statements E!INSERT 2: bind wariable valug is NOT set |u:|etai| a
Skakernent
Manme Schema Text Tables
&s  [PSELECT 1 HR. select from employees, &
_;'ﬁ INSERT 2 HR. insert inko job_hiskory

Statements are added to tuning via the Overview pane.

lil ProfileTORLABSCORCL.0ar | L] *Unkitled Tuning Job 2 &3 =0
b ot Orade B P TORLABSCORCL (10.2.0.1)

= Overview L-‘-' Analysis

=E Overview = v% @
71 Mew SQL Text

'] Extract from Database Object j v

,E_I} Irmport From File (Workspace)

e, Import from File (System)

fu Scan Oracle 5G4

Tuning Stat  [#]Generstecas  [|Performdetai [ ]Exec

Skakement

_ 15
harne Schema Text

| Imprnv&d.

oA

There are several different methods for adding SQL statements to a job, as reflected by the
option in the New SQL text menu.

¢ New SQL Text enables tuning via manual entry, or cutting and pasting into the tuning
window.
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* Extract from Database Objects enables you to select stored SQL from the data source to
which you are connected. You can either drag and drop objects from the Data Source
Explorer or you can add database objects matching specified filers. For example, entering t
in the filter area of the Data Source Objects Selection dialog, can match functions,
materialized views, procedures , and views, whose name begins with t. You can then drag
and drop the matches from the Data Source Explorer to the Tuning Statements grid.

e The Import from File (Workspace) and Import from File (System) options enables you to
choose an SQL file saved in your workspace or elsewhere on your computer or network.

® The Scan Oracle SGA option is available for the Oracle platform only. It enables you to scan
for and select active SQL in the System Global Area (SGA). For more information, see

"Tuning SQL Statements in the System Global Area (SGA)" on page 65

To add an ad hoc SOL statement:

Select the New SQL Text option and manually type an SQL statement in the window, or
copy/paste the statement from another source.

To add a database object:
1 Select the Extract from Database Objects option

The Data Source Object Selection dialog appears where you can search for and then select
the object you want to tune.

2 Type an object name prefix or pattern in the field provided. The Matching objects window
automatically populates with all statements residing on the specified data source that match
your criteria. Database objects include functions, materialized views, packages, package
bodies, procedures, stored outlines, triggers, and views.

NOTE: In order to find matching objects, data source indexing must be enabled. To enable

data source indexing, click Configure data source indexing, select Enable indexing,
and then click OK.

3 Click the object you want to add. Ctrl-click to add more than one object to the job.
4 Click OK.

NOTE: Alternatively, after clicking the Database Objects tab, you can drag and drop objects
from Data Source Explorer into the Database Objects window. As long as the dragged
object is a valid object type, it will be added to the Database Objects tab.

To add an SQL file:

1 From the New SQL Text menu, select either Import from File (Workspace) or Import from
File (System), depending on where the file you want to add is stored:

e Workspace files are files that reside in the application, meaning project files or other
objects generated or stored in the system.

e File System files are files that reside on your machine or the network.
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2 Select a file from the dialog that appears. It is automatically added to the job.

To add SQOL from the Oracle SGA
1  From the New SQL Text menu, select Scan Oracle SGA.

2 The system scans for SQL text which you can filter on the Scan SGA dialog that appears.

3 Choose the statement to be tuned and then click Finish.

RUN A TUNING JOB

As you add SQL statements to the job on the Overview tab of the tuner, tuning-supported DML
statements (SELECT, INSERT, DELETE, and UPDATE) are parsed from the statements and added
to the Overview tab in preparation for the tuning function execution.

Each tuning source statement is listed by Name, Schema, Text, Tables and Views. For SQL Server
and Sybase platforms, there is also a Catalog column. Additionally, each statement will have
Time and Analysis values that approximate how efficiently they execute on the specified data
source.

In the Generated Cases area of the Overview tab of a tuning job, the Cost and Execution
Statistics columns let you compare the relative efficiency of SQL statements or statement cases.
While the explain plan Cost for a statement or case is calculated when you add SQL to a tuning
job, the Elapsed Time and Execution Statistics columns are not populated until you execute that
statement or case.

If the Tuning Status Indicator indicates that a statement or case is ready to execute, you can
execute one or more statements on the Overview tab. Alternatively, the Tuning Status Indicator
may show that you have to correct the SQL or set bind variables before you can execute.

Once the tuning job has run, the Overview tab provides a series of cases, per statement, that
you can select and modify based on your results.

In some cases, automatic case generation might be disabled (via the Preferences panel). If this is
true, or if you have otherwise modified the Generated Cases table and can no longer generate a
specific case, you can instead explicitly generate a case for specific statements.

Execute each generated case | 1 = | times r f/‘ rimly

To execute a tuning job:

1 Ensure you have registered and selected a data source. For more information, see "Register
Data Sources" on page 40 and "Specify a Data Source" on page 26.

2 Ensure you are connected to the database by double clicking the database name in the
Data Source Explorer.

3 Click the tuning icon on the toolbar, or click File > New > Tuning Job.

30 DB OPTIMIZER™ XE PRO 2 USER GUIDE



USING TUNING > TUNING SQL STATEMENTS

4 On the Overview tab, specify the SQL you want to tune:

5 Modify the number of times to execute each statement in the Execute each generated
case field at the top right of the tuner, as needed.

6 Click the execution button [@] on the right side of the case generation field.

The tuning job runs, exacting and analyzing each statement and providing values in the
appropriate columns.

To explicitly generate a case for a specific statement:

1 Ensure you are connected to the database by double clicking the database name in the
Data Source Explorer.

2 Click the Overview tab.

3 Inthe Generated Cases area, right-click in the Name field of a statement or transformation
case and select Generate Cases from the context menu, or click the Overview Run Job
icon. The specified case is generated.

To view the generated cases for a specific statement

1 Inthe Tuning Statements area, click the checkbox to the left of the tuning source statement
name.

A check mark appears in the checkbox and the cases displayed in the Generated Cases area
are filtered to display only those cases related to the selected source statement.
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ANALYZE TUNING RESULTS

Once you have executed a tuning job, the Overview tab reflects tuning analysis of the specified
statements. The Analysis tab shows the resulting analysis of the query, including indexes used,
not used, and missing (or suggested to create). For more information on using the Analysis tab,
see "Understanding the Analysis Tab" on page 23

Tuning Status Indicator Column Set Run/Cancel Job
Enable Execution Expand/Collapse Controls
Check Box Control
Increase/Decrease

Pane Size Control

L.-» Overview P Analysis

B E eelect from BROKER, CLIENT TRANSACTION, 34014.0 5.32
el 4 ..sfarmatian 2740 0.03
tE  F T SELECT 1 select from ciient_transaction, dient, 4.0 0.00
e USE_HASH 14.0 0,00
el ORDERED 8.0 0.00
el NG_LISE_ML 16,0 0.00
= LEADING4 _ Extracted SQL 4 0.00
&= (Eapmey  ransformation Case Statements 0.0 .01
eEl LEADING2 Hint-Based 7.0 0.01
o LEADING1 / Cases 4.0 0.00
ﬂg INDEX_FFS 9.0 0.0
e ELLL £4.0 0.00
o FIRST_ROWS 40 0.00
<

* The Generated case Expand/Collapse control lets you hide or display the hint-based cases
and transformation-based case generated for a statement.

* The Enable Execution check boxes let you enable multiple statements or cases for
simultaneous execution while the Run/Cancel Job controls let you start and stop
simultaneous execution.

e The Column set Expand/Collapse controls let you expand a column set to display more of
the columns within the table.
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The Tuning Status Indicator indicates whether a statement or case is ready to execute or
has successfully executed. The following table provides information on the Tuning Status
Indicator states:

Icon Description
The case has not been executed. There are no errors or warnings and the case is ready to be executed.
Ei:'—il The case has been successfully executed.

; xecution for this case failed or was cancelled due to execution time exceeding 1.5 of original case time.
E E tion for th failed lled due t tion t ding 1.5 of original t

o,

Hovering the mouse over the Tuning Status Indicator displays a tip that notes the nature of a
warning or error.

NOTE: If a warning indicates that one or more tables do not have statistics, you can right-click
the statement and select Analyze Tables to gather statistics.

A warning can indicate an object caching error. For example, a table may not exist or not be
fully qualified. Cases cannot be generated for the associated statement.

The explain plan-based Cost field can be expended to display a graphical representation of
the values for statements or cases. Similarly, after executing a statement or case, the
Elapsed Time field can be expanded to display a graphical representation. The bar length
and colors used in the representation are intended as an aid in comparing values,
particularly among cases. For example:

?E_

1.5435 I

I:I.E'BB ——

0,490 S

Du?g? I

I:I-BEB EE—

In the case of both Cost and Elapsed Time, the values for the original statement are
considered the baseline values. With respect to color-coding for individual case variants,
values within a degradation threshold (default 10%) and improvement threshold (default
10%) are represented with a neutral color (default light blue). Values less than the
improvement threshold are represented with a distinctive color (default green). Values
greater than the degradation threshold are shown with their own distinctive color (default
red).

With respect to bar length, the baseline value of the original statement spans half the width
of the column. For child-cases of the original statement, if one or more cases show a
degradation value, the largest degradation value spans the width of the column. Bar length
for all other children cases is a function of the value for that case in comparison to the
highest degradation value.

NOTE: Forinformation on specifying colors, and the improvement threshold and degradation
threshold values used in these graphical representations, see "Specify Tuning Job
Editor Preferences" on page 35.
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Additionally, once results have been generated you can:
e Compare Cases. For more information, see "Compare Cases" on page 34.

e Filter and Delete Cases. For more information, see "Filter and Delete Cases" on page 35.

e Visual SQL Tuning. For more information, see "Visual SOL Tuning" on page 40.

¢ Create an Outline. For more information, see "Create an Outline" on page 35.

COMPARE CASES

You can compare cases between an original statement and one of its tuning-generated
statements, or another statement case via the Compare to Parent and Compare
Selected commands, respectively

& Compare Statements E@E

£ A AR
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A.YEARS WITH FIRM, A.BRORER_FIRSI_NRME,
c.OFFICE HAME: A.YEARS WITH FIRM, 3
< > < >
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To compare a case side-by-side with its parent:

Right-click in the Name field of a case and select Compare to Parent from the context
menu.

To compare two cases:

Select the two cases then right-click in the Name field of either case and select Compare
Selected from the context menu.
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FILTER AND DELETE CASES

You filter cases from the Generated Cases table via the Filter icons on the Generated
Cases Toolbar of the Overview tab.

-+l
—

Filter the cases on the Overview tab so that hints that are not improvements on the original
statement are not displayed. You can filter:

¢ Non-optimizable statements
e Optimized statements

* \Worst cost cases

* Worst elapsed time cases

When filtering, the criteria remain in effect until you change the criteria. That is, as new cases are
generated, only those cases that do not satisfy the filtering criteria are displayed. To restore an
unfiltered set of cases, open the Filter dialog and deselect the filtering options.

When removing cases, the criteria you set has no effect on cases subsequently generated.

To filter cases from the Overview table:

1 Click the Filter button, respectively. A Filters dialog opens.

2 Use the check boxes to select your filtering and then click OK.

To delete cases from the Overview table:
1 Right-click on the row of the case you want to delete and select Delete. A Delete dialog
opens.

2 Use the check boxes to select your filtering and then click OK.

When removing cases, the criteria you set has no effect on cases subsequently generated.

CREATE AN OUTLINE

If SQL is executed by an external application or If you cannot directly modify the SQL being
executed but would like to improve the execution performance, you can create an outline on the
Oracle platform. An outline instructs the Oracle database on the execution path that should be
taken for a particular statement.

To create an outline for a change suggested by a case:

1 On the Overview tab of a tuning job, rlght-click in the Name field of a case and select
Create Outline from the context menu.

A New Outline wizard opens.

DB OPTIMIZER™ XE PRO 2 USER GUIDE 35



USING TUNING > TUNING SQL STATEMENTS

2 On the first panel, provide an Outline name, select an Outline category, and then click
Next.

A Preview Outline panel opens previewing the SQL code to create the outline.

3 Select an Action to take option of Execute or Open in new SQL editor and then click
Finish.

For more information, see "Using the Outlines Tab" on page 64.

MODIFY TUNING RESULTS

As you add SQL source to the Input tab of a tuning job, the supported DML statements are
automatically parsed out and a numbered statement record for each statement is added to the
Overview tab.

Cases generated from tuning candidates are alternative forms of the original statement that
have been optimized or otherwise “fixed” by the tuning function. Once you have executed a
tuning job, tuning automatically generates all SQL optimizer hint-based variations that can be
applied to the statement:

e All SQL Optimizer hint-based variations that can be applied to a statement.
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e A transformation-based case, if any of the eight common quick fixes can be applied to an
SQL statement. This feature leverages the DB Optimizer Code Quality Check functionality.
See "Understanding Code Quality Checks" on page 75 for more information on the eight
quick fixes. A transformation case, in turn, has its own set of SQL Optimizer hint cases. For
information on Oracle transformations or query rewrites, see "Oracle Query Rewrites" on
page 38. For information on other transformations, see "Examples of Transformations and
SOl Query Rewrites" on page 74.

i,-' Overview | P Analysis l
Iy Overview 3warningdetected T
Tuning Source Stat [Ocenerate Cases I Perform datai analysic [¥] Execute each generated case .d 't!j
Statement | Time |
MName * | Schema Text Tables Views Blapsed (5] | Improved (5) | Cases
i BdssecT2 SISTEM  select from BROKER, 6.32 532 -
T Hs=eEcT: SYSTEM select from 0.00 0.00 10
<
Generated Cases Transformation-based case
S0OL 5t rits and Cases *»  Cost | MExecull. istics | M Other

Mame ¥ Tk Value Elapsed Trne (s) | Physical Reads
gel Sy SEECT 2 select from BROKER, CLIENT _TRANSACTION, 34014.0 6.32 2
el # [Mizging  ...sformation 274.0 0.03 0
gl ST SEECT1 \ select from chent_transaction, dient, 2.0 0.00 0

= USE HA

g et Hint-based cases 2 i o
el ORDERED 8.0 0.0:0 0
ekl MNO_USE_NL 16.0 0.00 0
e LEADINGS 2.0 0.00 0
EEl LEADING3 10.0 0.01 0
3 LEADING2 ] 0.01 0
el LEADING1 40 0.00 0
e INDEX_FFS 9.0 Q.00 0
¢El FlLL 4.0 0.00 0
el FIRST_ROWS 3.0 0.00 0
<

Hint-based cases and the transformation-based case are a special case of the statement records
added to the Overview tab as you add candidates to a tuning job. With the exception of the
Text, Source, and Index Analysis fields, cases are identical to the standard statement record.
Similarly, execution, statistics collection, and other options available for basic statement records
are available for individual cases.

Once cases have been generated, if you have the required permissions on the specified data
source, you can apply the changes suggested by hint and transformation based cases in the
Overview table.
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To apply a change:

1 Right-click on the Name field of the case that you want to use to modify the original

statement and select Apply Change.

The Apply Change dialog appears.

2 Choose Execute to apply the change to the statement automatically.

Alternatively, select Open in New SQL Editor to open the modified statement in SQL
Editor for manual changes or to save it to a file.

ORACLE QUERY REWRITES

The following query rewrites or transformations may be recommended during tuning for Oracle

data sources.

Before

After

select * from t1 where
EXISTS
(select null from t2 where t2.key = t1.key);

select * from t1 where t1.key
IN
(select t2.key from t2);

select * from t1 where
NOT EXISTS
(select null from t2 where t2.key = t1.key);

select * from t1 where t1.key
NOT IN
(select t2.key from t2 where t2.key is not null);

select * from t1 where t1.key
IN
(select t2.key from t2);

select * from t1 where
EXISTS
(select null from t2 where t2.key = t1.key);

select * from t1 where t1.key
NOT IN
(select t2.key from t2 where t2.key is not null);

select * from t1 where
NOT EXISTS
(select null from t2 where t2.key = t1.key);

select * from t1 where
NOT EXISTS
(select null from t2 where t2.key = t1.key);

select t1.* from t1, t2 where t1.key = t2.key(+) and t2.key
is null

select * from t1 where t1.key
NOT IN
(select t2.key from t2 where t2.key is not null);

select t1.* from t1, t2 where t1.key = t2.key(+) and t2.key
is null;

select column BETWEEN X AND Y

select (column <= X AND column >=Y)

select column NOT BETWEEN X AND Y

select (column < X AND column >)

select (column<= X AND column >=Y)

select column BETWEEN X AND Y

select (column < X AND column >Y)

select column NOT BETWEEN X AND Y

USING THE ANALYSIS TAB

The Analysis tab provides detailed information about statements and cases selected from the
Overview tab, after a tuning job has been executed. It also shows filter ratio, and table and join

sizes.

38
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The Analysis tab contains information about the statement or case, its full SQL code, a diagram
of the SQL statement, and Index Analysis.

_é] *#Unkitled Tuning Job % =8
P ot} Oracle b P TORLABSCORCL (MOVIES) {10,2.0.1)

P Overview L.- Analysis
SQL Analysis Select statement of inkerest: |SELECT 1 v - @
select e
cs.customerid,
cs.firsthame, RENTALITEM {RI)
cs. lastname,
wr.rentalid,
e . duedate, )
e . totalcharge, [
ri.itemnumber | & MOVIERENTAL {MR) | L NOT I (2)
from
HOVIES . customer o3,
HOVIES .movierental e,
HOVIES . rentalitem ri o
where | (50 CUSTOMER. {C5) Sa SUBGUERY (1)
length (3. lastnans) = 5
cs.zip > Vo062 and
1 < cs.custowerid + 2 anw
£ . . >. | .< . [
Index Analysis [T Table Statistics 5 Column Statistics and Histograms | [Z] Outines
Collect and creste indexes W | O
Indes Hame Table Cwner Table Marne -~
II._E._D Oipx_MOYIERENTAL_O MOYIES MOYIERENTAL TOTALCH,
& [ CUSTOMER_PE MOYIES CUSTOMER. CUSTOME
" CrmovIeCosry_PE MOYIES MOVIECOPY MOWIECD :
" [ RENTALITEM_FK1 MOYIES REMTALITERM REMTALIC
® []cusTomMER_IEL MOYIES CUSTOMER. LASTMAMI
< | >

Additionally, for the Oracle platform there are Table Statistics, Column Statistics and Histograms,
and Outlines tabs. For more information, see "Using Oracle-Specific Features" on page 62.

Statement analysis is performed when you click Perform detail analysis on the Overview tab
and then click Run Job or when you click the Analysis tab. In order to view and analyze
statement statistics, select the tab (Index Analysis, Table Statistics, Column Statistics and
Histograms, or Outline) and the statements whose statistics you want to analyze.

For more information, see "Visual SOL Tuning" on page 40.
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IMPLEMENTING INDEX ANALYSIS RECOMMENDATIONS

Once you have added tuning candidates to a tuning job, DB Optimizer can analyze the
effectiveness of the indexes in the database and recommend the creation of new indexes where
the new indexes can increase performance.

In the Collect and create indexes table, any indexes DB Optimizer recommends you create are
marked in orange.

[£] Indee dnztyms | 53] Tale Szakitics | 22 Colmn Stabstics And Miszoarams | [£f Cubres

Colect and coesbe ncexas |
Index hlsme bl Cxirier Tzkke Name Column Hams [rede:z Tpe A | Teble MOUES MOWIERENTAL | ciannid | & | Create
T e T S T S TTEE] ] || efl e o bt ths o e index
flis L =
¥ [Jcustarer_m FICHIES CLETCHER CLETOMERTD Unicie 4 {berakog] feem WIS, mcvderental)
o CIMoviEcor FOWTES MNTECPY MORIECCRY D Unioue 4 eriik end we meeked a vitvelindes
o CIRENTALITEM_FK1L FIHIES RENTH.ITEM REATALID Homs 105¢_MOUEERENTAL 0 which the opltinkar

R pizked up, 50 we suo0es molEmerkng
@ [JcusTOrER IEL MEWILS LLETOMZR LaZThabz Homns

To accept the suggestion and have tuning automatically generate an index:

1 For any recommended index, click the checkbox to the left of the index.

Optionally, modify the Index type by clicking in the Index Type column and then selecting a
type from the list.

2 Click the Create Indexes button.
The Index Analysis dialog appears.

To view the index SQL in an editor for later implementation, click the statement and then
click Open in a SQL editor.

To run the index SQL and create the index on the selected database, click Execute.

VISUAL SQL TUNING
NOTE: Visual SQL Tuning is not available in DB Optimizer XE Developer.

DB Optimizer can now parse an SQL query and analyze the indexes and constraints on the
tables in the query and display the query in graphical format on The Visual SQL Tuning (VST)
diagram, which can be displayed in either Summary Mode or Detail Mode, helps developers,
designers and DBAs see flaws in the schema design such as Cartesians joins, implied Cartesians
joins and many-to-many relationships. The VST diagram also helps the user to more quickly
understand the components of an SQL query, thus accelerating trouble-shooting and analysis.

This section is comprised of the following topics:

¢ Changing Diagram Detail Display on page 41

e Interpreting the VST Diagram Graphics on page 50
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CHANGING DIAGRAM DETAIL DISPLAY
This section is comprised of the following topics:

e Viewing the VST Diagram Legend on page 41

¢ Viewing Table Counts and Ratios on page 42

¢ Viewing the Explain Plan on page 44

e Viewing the VST Diagram in Summary Mode on page 44

e Viewing the VST Diagram in Detail Mode on page 45

e Changing Detail Level for a Specific Table on page 45

e Viewing All Table Fields on page 46

e Viewing Diagram Object SQL on page 47

e Expanding Views in the VST Diagram on page 47

e Viewing the Oracle Explain Plan Overlay on page 49

VIEWING THE VST DIAGRAM LEGEND
Click the Diagram Legend toggle [ 5] to view the legend and then click it again to hide it.

All the icons used in the VST diagram are identified and in the Diagram Legend.

Diagram Legend A

Table

AL View
2 Materiglized View

&G Sub-guery

[cTel  Commion Table Expression
£ Column

Index

B Primary Key

U Unique Key

[d Filkered object

Za—== Many ko Many (M:N)

—== Parent ko Child (1:M)

Unique (1:1)

4= OUTER J0IN

I EXISTS |/ IN v
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VIEWING TABLE COUNTS AND RATIOS
To view or hide table counts, two table join sizes and filtered result set ratios, click the Ratios

and Counts icon [*2].

"‘:‘:1 KA
5 2 ) @

1 10000
s SUBQUERY (1) [ (2 RENTALITEM (RI)
'~+-" 100
1
15?1 10000 10000
S0 A\ 1]
| E MOVIERENTAL (MR) | S NOT IN (2)

conn

|2

| (3 cusToMER (C5)
100

Green numbers at top left of table represent the total number of rows in that table. In the above
the MOVIERENTAL (MR) table has 5000 rows.

Blue percentage at the bottom right of the table represent the percentage of rows in that table
that meet the selection criteria. In the above example, 100 percent of the rows in the
RENTALITEM (RI) table have met the selection criteria.

The numbers on the table joins indicate the total number of rows that meet the selection criteria
for both tables.
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You can also view the SQL Query that created a relationship by hovering over the relationship. If
the tooltip contents is larger than the size of the tooltip rectangle, you can hover the mouse on
top of the tooltip for a second, then it will turn into a dialog you can re-size, scroll in, and select
text from to copy into the Clipboard.

1 10000
S000 [ 3 RENTALITEM (RI)

| B2 movIERENTAL | %
N / I
™,

100
1591 Cardinality: Master-Detail
\\ / Joined Row Count: 10000
coog o .
+ Relat 3
[ EZ mowierenTaL (1 oo 0
ri.REMTALID = mr RENTALID

Columns:

o

EEI|EIEI MOVIERENTAL.RENTALID

. RENTALITEM.REMTALID

| Ij CIUSTOMER, (C5 SOL Count Statement:

100 sE| ECT COUNT ()
FROM
MOVIES.MOVIEREMTAL MR,
MOVIES.RENTALITEM RI
WHERE ri.RENTALID = mr.RENTALID
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VIEWING THE EXPLAIN PLAN
NOTE: The Explain Plan is available only for the Oracle 10g platform.

Hover the mouse over the VST diagram to see the Explain Plan icon [¢% and then click it to
view the Explain Plan Overlay. Click the Explain Plan icon again to hide the overlay.

The additional nodes shown in the Explain Plan overlay provide details on the flow of the
query plan, with operations (such as nested loops, sorts, and joins) showing connecting

tables and other operations..
= £% ML

| REr':.IT.ﬁ.LITEM (RI) |
»*

200 EI
|3 moviECoRY (mC) |

B2

=]
[ cusTomER (<3)| | B MOVIERENTAL |

Hover the mouse over the objects or relationships in the overlay to view additional details.

VIEWING THE VST DIAGRAM IN SUMMARY MODE
By default the diagram displays Summary Mode, showing only table names and joins, as seen in
the following illustration

€M Q

| (3 RENTALITEM (RI)
»*

M
| E MoVIERENTAL (MR) | & NOT IN (2)

|13 cusTomER (c3) | s SUBQUERY (1)
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VIEWING THE VST DIAGRAM IN DETAIL MODE
By default, the VST diagram displays in Summary Mode, but by clicking the Detail Mode/
Summary Mode switch.

wllm| q

| (3] RENTALITEM (R} |
*

Detail Mode/ Summary Mode

i Switch
| B MOVIERENTAL (MR) | & NOT IN (2)

|13 cusTOMER (C5) | S SUBQUERY (1)

additional details of the tables display, including table columns and indexes

€ H]Q !

RENTALITEM (RI}

[3E ITEMNUMEER:: NUMEER.
£2 MOVIECOPYID: NUMEER,
[5E RENTALID: MUMBER

REMTALITEM_FK1
REMTALITEM_Fk2
¥B REMTALITEM_PK

&)
MOYIEREMTAL (MR SHL MOT IN (2)
£S CUSTOMERID: MUMBER, [3E COPYCOMDITION: Ck 4

CHANGING DETAIL LEVEL FOR A SPECIFIC TABLE

You can also switch between Summary Mode and Detail Mode for a specific table or view, by

double-clicking the object name.
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VIEWING ALL TABLE FIELDS

By default, only fields that are used in the WHERE clause are displayed in detail mode; however,
if you right-click the table you can choose to display even unused columns as follows:

ra
MOVIERENTAL (MR
CUSTOMERID: NUMBER
LEDATE: DATE
RENTALID: MUMEE

1 Reset Layout
== TOTALCHARGE: ML +
+* Layout Direction k

MOVIEREMTAL_FE

MOVIEREMTAL FK) £F Show Explain Plan
MOVIERENTAL _IE] _
MOVIERENTAL TE3 137 Show Ratios{Counks

P MOVIERENTAL_PK| ] summary Mode

// Expand &l

Show Unused Columns k

L Show Object Cwners

Showe Query Mames

&, Zoam In
'El Zoam ok

All the columns in the table are shown, and not just the ones used in the WHERE clause of the
SQL statement.

MOWIEREMTAL (MR

£ CUSTOMERID: MUMBER
DUEDATE: DATE
RENTALID: MUMBER.

£E TOTALCHARGE: MUMBER,

MOVIEREMTAL_FK1
MOVIEREMTAL_FKZ
MOWIEREMTAL_IEL
MOVIEREMTAL_IEZ
ﬁﬂ' MOVIEREMTAL_PK
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VIEWING DIAGRAM OBJECT SQL

While in Detail Mode, hovering the mouse over the sub query, table name, field, or index
displays the SQL required to create that object.

REMTALITEM (RI)

[5E ITEMNUMEER:: NUMEER.
2= MOYIECOPYID: NUMBER,
[3E RENTALID: NUMBER,

REMTALITEM_Fk1

[EE] REMTALITR—=
75 rentaLTel] [E| RENTALITEM_FK2

CREATE IMDEX MOVIES.RENTALITEM_FK2
OM MOVIES. REMTALITEM{MOVIECOPYID)

TABLESPACE LUSERS

LOGGIMG

Hovering over the join between two tables displays the relationship between the two tables.

REMTALITEM (RI)

[5E ITEMNUMEER.: NUMEER:
2= MOYIECOPYID: MUMEBER
[5E RENTALID: NUMBER:

REMTALITEM_FK1
REMTALITEM_FK2
“ % RENTALITEM_PK

Cardinality: Master-Detail
Relations:
MOYIEREMTAL I:MR:l ri. RENTALID = mr.RENTALID
CUSTOMERID: NUMpgR | COlumAS:
DUEDATE: DATE E COPYFORMAT: CHAR

RENTALID: MUMEER.
= TOTALCHARGE: NMUMBER

ID%_MOVIEREMTAL_O

EXPANDING VIEWS IN THE VST DIAGRAM

If there are views in the Visual SQL Tuning diagram, they can be expanded by right clicking the
view name and choosing Expand View:
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Right click on the view, and choose Expand View

&3 EMP_DETAILS_VIEW

- epdien |

I;éh Reset Layouk
+I+ Lawouk Direction r

12”_: Shows Ratios!Counts

L%

A o
., Detail Made
B Expand Al

== Show Unused Caolumnns

L show Object Cwners

T1

Show Query Mames

(ﬂ Zoam In

Now we can see the objects in the view:

&% EMP_DETAILS_YIEW

| & EMPLOYEES (E) |

| B DEPARTMENTS (D) |
W

| & LocaTions (1)
W

| Bl countries ()
W

REGIOMS (R

You can further expand the sub-view within the original view also.

The following is an example of view expansion along with the Explain Plan to the left.
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Notice in the view expansion a list of all the indexes on all the underlying tables in the views and
sub views and which of those indexes is used in the default execution plan.

I

| B s0L Analysis (il

| |
Lahpes it of Piprgat: [SUBCT § w

SELECT COUNT () :9: :u: # 8

Thes & TRAMSACTIONS |1

| B o denivmin | [T Tisoie Srunmnes | Coiern Suntares A Haingeaes | [ Cuniews | [sHE

| Bl cuiee send
| Gt and rents reas T Rrasii o | 0

Ingen hiamg Tobie Gvre o i Coinor ] M CLIEHT 2

alalalalalalala]e

SEXEXXeRLY ,

VIEWING THE ORACLE EXPLAIN PLAN OVERLAY
NOTE: This option is only available for Oracle versions 10 and higher.

Click the Explain Plan toggle [ %], you can choose to view or hide the Explain Plan details.

The additional nodes shown in the Explain Plan overlay provide details on the flow of the
query plan, with operations (such as nested loops, sorts, and joins) showing connecting
tables and other operations. Hover the mouse over the objects or relationships to view
additional details.

[ =]
%3 wnu&l

IND_STATS$ (15T} |
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EXPANDING SUBQUERIES AND NESTED SUBQUERIES

Double-click queries to expand them or right-click the query and select Expand Query from the
menu that appears. The following shows several layers of nesting queries.

[Tl RENTALITEM (RI)
7 -

INTERPRETING THE VST DIAGRAM GRAPHICS

[ MOYIECORY (M)
&

=

[Z MOYIETITLE {MT}
w

=

[E2] MONVTECATEGORY (1MC)

S8 CATESORYID: NUMBER
ZZ RENTALPRICE: MUMEER,

f}l MOVIECATEGORY _PK
SR MOVIECATEGORY _LIK

MCVIECATEGORY

== CATEGCRYID: MUMBER,
SE RENTALPRICE: NUMEER
TR MOVIECATEGORY PY
PR MOVIECATEGORY UK

This section contains the following topics that will help you understand the graphics in VST
diagrams:

¢ Viewing the Diagram Legend on page 51

e Colors on page 51

¢ Connecting Lines/Joins on page 51
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VIEWING THE DIAGRAM LEGEND

Click the Diagram Legend Toggle button as shown in the diagram below to see a description
of the icons and relationship lines used in VST diagrams.

Diagram Legend

Table

As Wiew

& Materislized Yiew
&Gl Sub-guery

[cTEl  Common Table Expression
£ Column

Index

B Primary Key

un  Unique Key

[ Filtered object

Z=—=T Many bo Mary (MM
—== Parent to Child (1:M)
nigue (1:17

45— CUTER 10IN

—F— ExISTS | IN

I WOT EXISTS | NOT IN

COLORS
The color of the index entries in the Collect and Create Indexes table is interpreted as follows:

Text Color Interpretation

Index is used in the query.

Index is usable but not used by the current execution path.

This index is missing. DB Optimizer recommends that you create this index.

This index exists on the table but not usable in this query as it is written.

CONNECTING LINES/JOINS

Joins are represented with connecting lines between nodes. You can move tables in the diagram
by clicking and dragging them to the desired location. The position of the connecting lines is
automatically adjusted. The following describes when a particular type of connecting line is used
and the default positioning of the line.

Connecting Lines When used

—F One-to-One Join relationships are graphed horizontally using blue lines. For more
information, see "One-to-One Join" on page 52.
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Connecting Lines

When used

One-to-Many Join relationships are graphed with the many table above the one table. For
more information, see "One-to-Many Join" on page 52.

Cartesian Join shows the table highlighted in red with no connectors to indicate that it is
joined in via a Cartesian join. For more information, see "Cartesian Join" on page 53.

—
ENE

Many-to-Many Join relationships are connected by a red line and the relative location is not
restricted. For more information, see "Many-to-Many Join" on page 55.

Indirect Relationship. For more information, see "Indirect Relationship" on page 55

= =i
-Er—l- Outer Join: For more information, see "Outer Join" on page 59.
- Unique: For more information, see "Unique" on page 40.
—ff— Not Exists and Not in relationship lines connect the subquery to the table being queried.
Notice that when you click this relationship line, the SQL text creating the relationship is also
selected. For more information, see Not In or Not Exists Join on page 60.
—a—= Exists and In relationship lines connect the subquery to the table being queried. Notice that

when you click this relationship line, the SQL text creating the relationship is also selected. For
more information, see In or Exists Join on page 56.

ONE-TO-ONE JOIN

If two tables are joined on their primary key, then graphically, these would be laid out side-by-
side, with a one-to-one connector:

| B2 muvEsTMENT_TvRE | [FE OFFICE_LOCATION |

ONE-TO-MANY JOIN

This is the default positioning of a one-to-many relationship, where INVESTMENT_TYPE is the
master table and INVESTMENT is the details table.

IMVESTMEMT

| B mwvesTMENT TYPE |
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The following is an example of a query that consists of only many-to-one joins, which is more
typical:

SELECT
ct.action,
c.client id,
i.investment unit,
it.investment type name

FROM

client transaction ct,
client c,

investment type it,
investment 1

WHERE
ct.client_id = c.client_id AND
ct.investment id = i.investment id AND
i.investment_type_ id = it.investment_type_id and
client transaction id=1

| & cLIENT_TRANSACTION |

| E cuenT| | B mwvesTMENT |

| B mvESTMENT _TvPE |

CARTESIAN JOIN

A Cartesian join is described in the following example where the query is missing join criteria on
the table INVESTMENT:

SELECT

A.BROKER_ ID BROKER ID,
A.BROKER LAST NAME BROKER_ LAST NAME,
A.BROKER_FIRST NAME BROKER_ FIRST NAME,
A.YEARS WITH FIRM YEARS WITH FIRM,
C.OFFICE_NAME OFFICE NAME,
SUM (B.BROKER COMMISSION) TOTAL COMMISSIONS

FROM
BROKER A,
CLIENT_ TRANSACTION B,
OFFICE_LOCATION C,
INVESTMENT I

WHERE
A.BROKER ID = B.BROKER_ID AND
A.OFFICE_LOCATION ID = C.OFFICE_ LOCATION_ ID

GROUP BY
A.BROKER_ID,
A.BROKER LAST NAME,
A.BROKER FIRST NAME,
A.YEARS WITH FIRM,
C.OFFICE_NAME;
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Graphically, this looks like:

| E CLIENT_TRANSACTION |

BROKER

[ E9 oFFice_LocaTion|

INVESTMENT is highlighted in red with no connectors to indicate that it is joined in via a
Cartesian join.

Possible missing join conditions are displayed in the Overview tab under Generated Cases in
the transformations area. DB Optimize recommends that you create these joins.

* 501 Statements and Casss | ¥ Cost WExmouti, isbcs | 2 Orther Exsqution Stetislics

Mame Tenct Valua Elapsad Time {s) = Physical Reads | Logical Reads CPUTI
B [Mizzig & valid jain eriberia) ransfarmatan 1740 0.04 a 157
ALL 34015.0 6,29 a 173
LEADINGL 340170 8,25 a 142
ALL_ROANE 390140 6,35 ] 170
LEADTMGES 330170 6,41 a 170
IRDEX 343820 6,58 a 414
LEADING2 381430 794 a 170
QORDERED |40 BA1 ] ]
LSS ML iE194.0 9.03 a 37516

£ E

NOTE: Transformations are highlighted in yellow.

IMPLIED CARTESIAN JOIN

If there are different details for a master without other criteria then a Cartesian-type join is
created:

SELECT *

FROM
investment 1,
broker b,
client c

WHERE
b.manager_id=c.client_id and
i.investment type id=c.client id;
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| & srokeR | | B mweESTMENT

CLIEMT

The result set of BROKER to CLIENT will be multiplied by the result set of INVESTMENT to
CLIENT.

MANY-TO-MANY JOIN

If there is no unique index at either end of a join then it can be assumed that in some or all cases
the join is many-to-many; there are no constraints preventing a many-to-many join. For example,
examine the following query:

SELECT *
FROM
client_ transaction ct,
client c
WHERE
ct.transaction status=c.client marital status;

There is no unique index on either of the fields being joined so the optimizer assumes this is a
many-to-many join and the relationship is displayed graphically as:

| & cLEnT_TRANSACTION |
7

I&LIEH‘I’

If one of the fields is unique, then the index should be declared as such to help the optimizer.

INDIRECT RELATIONSHIP

Indirect relationships are produced by the following SQL, where BIG_STATEMENT2 is a
Materialized View.

SELECT CS.*

FROM
MOVIES.CUSTOMER CS,
MOVIES .MOVIERENTAL MR,
MOVIES.RENTALITEM RI,
OE.BIG_STATEMENT2

WHERE
CS.ZIP > '75062' AND
MR.RENTALID = RI.RENTALID AND

RI.ITEMNUMBER OE.BIG_STATEMENT2.ITEMNUMBER AND
MR .CUSTOMERID = CS.CUSTOMERID;
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The following diagram produced by the SQL above shows that an indirect relationship exists
between the RENTALITEM(RI) tables inside and outside the materialized view,
BIG_STATEMENT2. An indirect relationship also exists between MOVIERENTAL (MR) inside
BIG_STATEMENTZ2 and MOVIERENTAL(MR) inside the RENT_VIEW1 view.

~
.
[ WOVTEREWTAL {HIR) [ £ BIG_STATEMENT2
2]
= uaT W (2)
o
\
kY

W

.
[F woviEREWTAL

[F cusTomEr (cs) .
[ &5 RENT_vIEW1

IN OR EXISTS JOIN
The following SQL contains a nest IN subquery (shown in bold text) that is graphically
represented with the Subquery summary icon and the IN join.

SELECT
cs.customerid,
cs.firstname,
cs.lastname,
mr.rentalid,
mr .duedate,
mr.totalcharge,
ri.itemnumber

FROM

SELECT
cl.customerid,
cl.firstname,
cl.lastname,
cl.phone
FROM MOVIES.customer cl
WHERE EXISTS (SELECT NULL
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FROM MOVIES.customer
WHERE
cl.customerid <>

cl.lastname c2.
cl.phone BETWEEN

USING TUNING > TUNING SQL STATEMENTS

c2

c2.customerid AND
lastname AND
0 AND 9999569900)

cs,
(
SELECT
customerid,
rentalid,
duedate,
totalcharge,
rentaldate
FROM MOVIES.movierental
WHERE totalcharge > 10
)
mr,
MOVIES.rentalitem ri
WHERE
LENGTH (cs.lastname) = 10 AND
- 1 < cs.customerid AND
ROUND (ri.rentalid) > 10 AND
TRUNC (ri.itemnumber) > 1 AND
mr.totalcharge > (SELECT AVG (totalcharge)

FROM MOVIES.movierental

WHERE TOTALCHARGE >=
ri.moviecopyid NOT IN

40) AND

(SELECT mc.moviecopyid

FROM MOVIES.moviecopy mc

WHERE

mc.copyformat
mc .copycondition

'vhs' AND
'new' AND

mc.movieid IN (SELECT mt.movieid

mc.categoryid

MOVIES.moviecategory mc

mc.rentalprice (SELECT MAX (rentalprice)

FROM MOVIES.moviecategory

WHERE categoryid
mr . CUSTOMERID

mc.categoryid)))) AND
cs.CUSTOMERID AND
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FROM MOVIES.movietitle mt

WHERE
mt.year < 1990 AND
mt.rating IN ('pg', 'r') AND
mt.categoryid IN (SELECT

FROM

WHERE
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ri.RENTALID = mr.RENTALID

Graphically, this would display as the following when the MOVIECOPY (MC) subquery is
expanded:

[ ©5 [ [T} RENTALITEM (RT)
L1 P k:

i
4

7 .
F

.

=
] {4

(F] ND\']EREI'WD.LI
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OUTER JOIN

The bold SQL predicate in the statement below defines the outer join between customer and
movierental.

select cs.*
from
MOVIES.customer cs,
MOVIES.movierental mr
where
length (cs.lastname) = 8 and
cs.zip > 75062 and
1 < cs.customerid + 2 and
cs.phone between 9625569900 and 9999569900 and
mr.rentalid = (select max (ri.rentalid)
from
MOVIES.rentalitem ri,
MOVIES.moviecopy mc
where
ri.itemnumber > 1 and

mc.moviecopyid = 700) and
mr.customerid (+) = cs.customerid;

The following screen shot illustrates how the outer join is displayed in the VST diagram.

o 1f TR
18 ) 0] &

s SUBQUERY (1)

| = MOVIERENTAL (MR) |

Cardinality: Outer Join
Relations:
mr.customerid (+) = cs.customerid

Columns:

| (3 cusTOMER (C5) |
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UNIQUE
The subquery below illustrates a unique relationship between two primary keys.

...select max (rentalprice)
from MOVIES.moviecategory
where categoryid = mc.categoryid...

MOYIECATEGORY (MC)

Cardinality: One-to-One
Relations:
categoryid = mc.cateqoryid
| B2 movIECATEGORY Columns:

NOT IN OR NOT EXISTS JOIN
The following SQL contains a NOT IN subquery (shown in bold below) that is graphically
represented with the Subquery summary icon and the NOT IN join.

SELECT CS.*
FROM
MOVIES.CUSTOMER CS,
MOVIES.MOVIERENTAL MR
WHERE
CS.ZIP > '75062' AND
MR.RENTALID NOT IN (SELECT MAX (MOVIES.BIG STATEMENTS.CUSTOMERID)
FROM
MOVIES.RENTALITEM RI,
MOVIES.MOVIECOPY MC,
MOVIES.BIG STATEMENTS
WHERE
RI.ITEMNUMBER > 1 AND
MC.MOVIECOPYID = 700) AND
MR .CUSTOMERID = CS.CUSTOMERID;
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Graphically, this statement would look like this:

| E MOVIERENTAL (MR) |
|

1]

| (3 cusTOMER (C5)| & NOT TN (1)
== WA (MOVIES BIG_STATEMENTS, CUSTOMERID): NUMBER

E ITEMMUMBER.: MUMBER.
E MOYIECOPYID: MUMEER,

VIEWING OBJECT SQL

Hover over the name of an object to view the object SQL as shown in the diagram below.

- [ GaRENT viEW |
2 RENTALID: MY 3 RENT_VIEW1
CREATE OR REPLACE VIEW MOVIES

RENTALID,
RENTALDATE,
T

REFRESHING THE VST DIAGRAM
There are two refresh options available: Refresh and Refresh All. Click the Refresh list as shown

below to gain access to these options

Select skatement of interest: | /=N b :;ét' NE 7

_ 1 Refresh
Y [5E YEAR: CHAR i Full Refresh

b1
‘ |

i

® Refresh: Regenerates the Analysis tab including the VST diagram. Any changes made on
the tab are reflected in the diagram.

¢ Full Refresh: Re-caches all objects used in (or related to) the query, then regenerates the
Analysis tab including the VST diagram. This option is typically used when the underlying
objects have been recently changed.
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USING ORACLE-SPECIFIC FEATURES

This section describes the tuning features available for the Oracle platform. These features are
not available for other database platforms.

e Using the Table Statistics Tab on page 62

e Using the Column Statistics And Histograms Tab on page 63

e Using the Outlines Tab on page 64
e Tuning SQL Statements in the System Global Area (SGA) on page 65

USING THE TABLE STATISTICS TAB

The Table Statistics area of the Analysis tab indicates when and if table statistics were last taken.
Using the Table Statistics you can view the information the optimizer uses to choose a path and
assess the validity of the various hints presented on the Overview tab.

E_I Indax Anakyss | £ Table Statistics | 22 Column Staistics and Histograms | [£2] Qutines

woen bable statistics . £|_|
Chiject Es Statistics * Maritoring > Attributes e
Table Coaper Table Nams Stakigkics Skatus Cuayps Sinee Skats Taken MMariterirg Cache
SYSTEM P5_RETRCPAYRGN_TBL Statidhcs OF 200 YES V'
s = B B A e N )
O svstem WE_IDE Shatishics (K 200 YES i
D SYSTEM WWE_RETROPAY EARNMS  Stelishics O 200 YES i)
{ '_|1=\.'=_.=rﬂ. AT NCTRANARY NEeET T a1l Kl } b

This table draws attention to:

¢ Missing statistics: Missing statistics can cause the optimizer to choose the wrong path
because the optimizer uses table statistics to make decisions. If the statistics are missing,
you can click the select a table and then click

Collect Statistics - on the far right of the tab. This sends a request to the database to
analyze the table and calculate the statistics.

e Out-of-date statistics: Like missing statistics, out-of-date statistics can also cause the
optimizer to choose the wrong path. You can update the statistics by selecting a table, and

then clicking Display Statistics ", which refreshes the statistics from the database or by

clicking Collect Statistics £ , which requests the database to analyze the table and
calculate the statistics.

NOTE: Collecting Statistics may be time-consuming, depending on how many tables the

database is analyzing and the number of rows in each table.
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e Useful statistics: The number of rows in a table and whether the table has been modified
since the statistics were last collected can help you to determine which hints you should
implement in the SQL code. These statistics can help the DB Administrator to better

understand the database.

TIP:  You can right-click anywhere in a row and choose options such as Collect Statistics,
Display Statistics, and Copy from the short-cut menu.

USING THE COLUMN STATISTICS AND HISTOGRAMS TAB

Histograms are special statistics that exist for a limited number of columns and are created by
the database administrator. Column histograms should be created only when there are highly-
skewed values in a column, such as is the case of an order details table with an Order Status
column where the number of closed orders for a business operating for several years is far
greater than the number of open orders. The Order Status column therefore meets the criteria of
a useful target for a histogram because the data is highly skewed. Using histograms the
optimizer determines that a full-scan is recommended when searching for closed orders, but an
index scan is more useful when searching for open orders.

DBOptimizer looks at the columns that have histograms and using statistics tries to determine
whether the column is a good or bad candidate for a histogram and presents this information on

the Column Statistics And Histograms tab.

[E] ride ety | T Tkl Shatistics 2= Colomn Skakistics Aod Hebograms, [ Culines
Wiz column statiskics | g0
Ohy=ck | e Hetograms
Gather | Drop Table Mame Codurmn Marme Histogran 2 Euckeds Fler Tope Ircexed Fedian Yabue Dedation & Distinect Yalue
D D P53 _PaY CALENCWR P& _CORFIRM_RUM HOKE L Uteral Equaty a5
O O P5_RETROPAY ROET RETRCFAT ZECQ MO HOMHE L Join Equaley b= L
D D P53 _RETROPAYPGE TEL COFF_CWCLE NOKE L Jain Equehse Hz
O O PS5 _PAaY_CALENCAR PATGROUF HOHE L Join Equalcs b=
— m, AT FRETRSSANASTE TR ACTEERAY M= Lliall LI E PP T LIES ] o
i >

The row shading indicates the following:
® Green: Good histogram candidate
¢ Red: Bad histogram candidate

* No shading: Not determined to be a good or bad histogram candidate

Median Value Deviation

For columns that have histograms, the median value deviation is presented. Understanding the
median value deviation can help you determine whether an index scan or a full-table scan would

be more efficient.
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The median value deviation represents the number of values that have duplicates away from the
median. In the case or the Order Status column, there are only three possible values, open,
processing, and closed. Consider the following:

10 open orders
100, 000 closed orders
1 order in processing

In this case the median is the middle value, 10. The number of closed orders is 10,000 times the
median which indicates that the column data is highly skewed. In this case the value in the
Median Value Deviation column would be presented as

1,0,0,0,1,0,0,0

There are 1's at the first and 5th spot in the median value deviation field indicating one column
value (value of orders in the processing state which appears once) is 1 factor of 10 away from the
median and there is a 1 at the 5th position indicating there is a column value (orders in the
closed state) that appears 5 factors of 10 more often (10,000) than the median value of 10.

A column with a median value deviation of 0, 0, 0, 0, 0, 0, O, 0 indicates that the column data is
not skewed and it is a bad candidate for a histogram, and therefore a full scan of the table would
more efficiently satisfy a query than an index scan.

To update the statistics of any object, you can select Gather for that column and then click
Display Statistics or Collect Statistics.

To stop gathering statistics for an object, such as a bad candidate for a histogram, select Drop
for that column and then click Display Statistics or Collect Statistics.

TIP:  If you are gathering statistics for a column for which the statistics were missing or out-
of-date, then once the statistics collection is complete, you should return to the
Overview tab and rerun the cases, because the characteristics of the column may have
changed, so the hints to improve performance would also change.

USING THE QUTLINES TAB

The Outlines tab provides detailed information about outlines created by the query during the
statement execution process on the Overview tab.

It provides information including the SQL statement name, if the outline is enabled or not, and
the Name, Category, and Hints associated with the outline. Additionally, the Drop parameter
specifies if it is dropped or not at execution time.

[E2 Index nalysis | 53 Table Statistics | S Cobumn Statistics And Hisbograms  [E] Outlines

Wiz autines
- Enabled Crop PMame Categary Hirks
m] o SYS_0... 20884 DEFALLT FLLL{a"SELS2™
=] o FLLL TEST SWAP_JOIN_INFUTS{@ SEL$1"
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In order to view outlines, the session needs to have USE_STORED_OUTLINES=true set prior to
execution. Outlines in tuning are created for the DEFAULT category, by default. Use the
following commands to enable outlines with the default settings:

alter system set USE STORED OUTILNES=true;
alter system set USE_STORED OUTLINES='DEFAULT’ ;
alter session set USE STORED OUTLINES=true;

Additionally, in order for a session to USE_STORED_OUTLINES, the user requires the create any
outline role. Use the following command to set up the proper permissions:

grant create any outline to [user];

TUNING SQL STATEMENTS IN THE SYSTEM GLOBAL AREA (SGA)

On Oracle platforms, SQL statements that reside in the SGA can also be tuned. When you
create a tuning job and specify an Oracle source, an additional tab appears in the Tuning
Candidates section of tuning, named Active SQL in SGA.

The SGA contains all the SQL since the database has been started up, except for those that
have been purged when the system runs out of memory. When analyzing the causes of a
database bottleneck, it is perhaps more useful to view and tune the SQL statements most
recently run, than those that have run in the last month, for example. DBOptimizer cannot tell
you which statements have most recently run by looking in the SGA. However, by profiling the
database using DBOptimizer Profiling and then optimizing the code by executing and running
the generated cases, you will be able to see which paths are most likely causing a bottleneck
and can be altered to enhance performance. Also, you can use Embarcadero Performance
Center to continually monitor a database over a longer period of time to help you analyze and
optimize database performance.
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& Scan SGA |:IE

SGA filters f

Specify the filkering criteria for ackive SQL in the SGA,

Filker Criteria

Maximum retrieved queries:f‘|

Sort b |Executiu:uns LT |

Advanced Filters

| 3
Parsing Schema: | v |
Module: | v |
Action: | v |
Service: | v |

@

To add a statement active in the SGA:
1 From the Overview tab, click the SQL icon and select Scan Oracle SGA.

The Scan SGA wizard appears.

2 Set the filtering criteria for an SGA scan and then run the wizard. It returns all active
statements on the Oracle source.

3 Choose the specific statements and add them to the tuning job.

ADDITIONAL TUNING COMMANDS

In addition to tuning, the interface provides additional commands and functionality that enables
you to view source code, statements, and other information regarding the data source.

e View the Source Code of Tuning Candidates on page 67

¢ View Statement or Case Code in SQL Viewer on page 67

® Open an Explain Plan for a Statement or Case on page 67
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e Executing a Session from the Command Line on page 68

VIEW THE SOURCE CODE OF TUNING CANDIDATES
You can view the source code of a tuning candidate as follows:

* On the Ad hoc SQL tab of the Input tab, you can see the SQL statements you typed or
pasted into that tab.

e On the Database objects, SQL Files, and Active SQL in SGA tabs of the Input tab, you
can double-click the name of any object added to that tab and an SQL session will open that
displays the SQL of that database Object. The SQL editor in use is actually Rapid SQL, an
Embarcadero product that is integrated with DB Optimizer.

VIEW STATEMENT OR CASE CODE IN SQL VIEWER

The Tuning job’s Overview tab let you open a statement in an SQL Viewer if you want to
perform either of the following tasks:

* View the entire SQL statement.

e Set bind variables. If the Tuning Status Indicator indicates a statement or case has invalid
bind variables, you must set those variables before executing the statement or case.

To view or set bind variables in a statement or case:
1 Right-click a statement or case and select Edit.

2 Use the Data Type and Value (or NULL) controls to specify the type and value for each bind
variable.

After setting bind variables, you can execute a case.

NOTE: Setting the bind variables in a parent statement sets the bind variables in all generated
cases for that statement.

OPEN AN EXPLAIN PLAN FOR A STATEMENT OR CASE

Any valid SQL statement added to the Overview tab shows a calculated explain plan cost in the
Cost field of the statement or case record. You can open an explain plan on these statements to
view the sequence of operations used to execute the statement and the costs and other explain
plan details for each operation.

On Oracle version 9 and higher, DB Optimizer attempts to get the Explain Plan from
V$SQL_PLAN when possible. Otherwise, the Explain Plan is generated by the Oracle EXPLAIN
PLAN command.
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To initially open an explain plan on a valid SQL statement on the Overview tab:
1 Right-click in the Name field of any statement record showing a value in the Cost field.
2 Select Explain Plan from the context menu.

An Explain Plan tab opens below the Overview tab.

TS0 Ervors = SQL Log @ Error Leg + Search 5 Explain Plan
sedect from cata.chientil, cata.factur 1, cata.linlifactl, < Nested Tables: cata liniifact] >
bype filter bext .
Flan Cost " Estimated Statistics = Actual Statistics» #
Cperation Cost  Operation Cost  Result  Cardinality Bytes  CPUCost [OCost | Optimizer Starts
« SELECT STATEMENT 253.0 0.0 37 2183 10%.107 235 ALL..W5
P COORDIMNATOR
AP SEND - 5Y5.:TQ100H 253.0 0o Er 2183 102..107 235
iHAEH 2530 0.0 w EZ 102...107 235
4P RECEIVE 2530 0.0 7 2183 102..107 235
8 K SEND - 515, TQ1000% 2530 Q.o EH 2183 10L..107 235
“HASH 2830 1.0 37 2183 10L%..107 235
FHASH JOIN 252.0 1.0 7981 470879 95195351 235
4 Fif RECEIVE &7.0 0.0 37 TO3 24604129 63
< P SEND - TQL0001 67.0 0.0 37 TO03 24604129 63
* P BLOCK &7.0 0.0 7 03 24604129 63
TGTABLE A JENTIL 7.0 B7.08= e 03 24604129 63 ANA, ED
- HASH JOIH 184.0 1.0 11706 463240 GTIETLITL 173 [

Explain plan operations are shown in a typical tree structure showing parent-child
relationships. The following table describes the column groups shown for each operation on
the Explain Plan tab.

With the Explain Plan tab open, you can quickly switch the view to an explain plan for
another SQL statement.

To change the Explain Plan tab display to another SQL statement:
1 Click in the Name field of another statement record showing a value in the Cost field.

EXECUTING A SESSION FROM THE COMMAND LINE

You can launch a tuning job from the command line using the following syntax:

dboptimizer.exe tune ds:ROMLABORCL10G 1 sglfile: C:\dboptimizer\workspace\test.sqgl

In the above command, the user has specified ROMLABORCL10G_1 as the data source, and
indicates a tuning session using the test.sql script.
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SAVING A TUNING JOB

A tuning session can be saved to a file with a . tun suffix. This enables you to open the file at a
later time for analysis and to share the tuning job results with other users.

¥ Save As .; @

Save As

Save a tuning job

Enter ar select the parent folder:

| SLProject

= SOLPraject

File name: | Intitled Tuning Job 3.tun

@:l Ok H Cancel ]

Profiling sessions can be saved as .oar files for use at a later time.

Once you have saved a tuning session to disk as a .tun file, it appears in the SQL Project Explorer
under the name you saved it as. It can be opened again by double-clicking the project name.

To save a tuning session:

Select the tuning session and then choose File > Save As.... Specify the project location you
want to save the file in and modify the file name, as needed. Click OK. The tuning job project is
added to SQL Project Explorer.

CONFIGURING TUNING

This section contains information on configuring tuning. It provides information on setting up
your data sources to work with tuning functionality, as well as information regarding preferences
within the application for the customization of various features and functionality.

This section is comprised of the following topics:

¢ Set Roles and Permissions on Data Sources on page 70

e Specify Tuning Job Editor Preferences on page 71
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e Specify Case Generation Preferences on page 73

SET ROLES AND PERMISSIONS ON DATA SOURCES

In order to take advantage of all tuning features, each user must have a specific set of
permissions. The code below creates a role with all required permissions. To create the required
role, execute the SQL against the target data source, modified according to the specific needs
of your site:

/* Create the role */
CREATE ROLE SQLTUNING NOT IDENTIFIED

éRANT SQLTUNING TO "CONNECT"

éRANT SQLTUNING TO SELECT_CATALOG_ROLE
éRANT ANALYZE ANY TO SQLTUNING

éRANT CREATE ANY OUTLINE TO SQLTUNING

éRANT CREATE ANY PROCEDURE TO SQLTUNING
éRANT CREATE ANY TABLE TO SQLTUNING

éRANT CREATE ANY TRIGGER TO SQLTUNING

éRANT CREATE ANY VIEW TO SQLTUNING

éRANT CREATE PROCEDURE TO SQLTUNING

éRANT CREATE SESSION TO SQLTUNING

éRANT CREATE TRIGGER TO SQLTUNING

éRANT CREATE VIEW TO SQLTUNING

éRANT DROP ANY OUTLINE TO SQLTUNING

éRANT DROP ANY PROCEDURE TO SQLTUNING

éRANT DROP ANY TRIGGER TO SQLTUNING

éRANT DROP ANY VIEW TO SQLTUNING

éRANT SELECT ON SYS.V_$SESSION TO SQLTUNING
éRANT SELECT ON SYS.V_$SESSTAT TO SQLTUNING
éRANT SELECT ON SYS.V_$SQL TO SQLTUNING
éRANT SELECT ON SYS.V_$STATNAME TO SQLTUNING
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Once complete, you can assign the role to users who will be running tuning jobs:

/* Create a sample user*/
CREATE USER TUNINGUSER IDENTIFIED BY VALUES 'O5FFD26E95CF4A4B'
DEFAULT TABLESPACE USERS
TEMPORARY TABLESPACE TEMP
QUOTA UNLIMITED ON USERS
PROFILE DEFAULT
ACCOUNT UNLOCK

/
GRANT SQLTUNING TO TUNINGUSER

/
ALTER USER TUNINGUSER DEFAULT ROLE SQLTUNING

/

SPECIFY TUNING JOB EDITOR PREFERENCES

Tuning job editor preferences let you control certain aspects of the appearance of items in the
tuning job editor as well as default behaviors.

1 Using the SQL Optimization perspective, select Preferences > Tuning Job Editor.

& Preferences (Filtered)

- EX]

Tuning Job Editor

= 0L Development
#- Tuning Job Editor Conmect to the tuning source autonaticaly

Crdlways i Mever (%) Prompt
Codor scheme For plan cost
Baseline: @

Improvement: (| Threshald (): (10 2

Degradation: (NEEEM]|  Threshold (%): (10 2]

Case execution
Far moee reliable results, it is recommended bo average the execution skatistics over multiple runs.

turber of iberations: | 1 2

Resul set fetch size: | 100 3

2 Make your changes and then to save your changes, click Apply.

The following describes the options available:

General Preferences

Connect to the tuning source automatically: When you open a tuning perspective, it
automatically opens the last saved tuning jobs that were open when you closed the
application. This option lets you specify whether, in addition, you want to automatically
connect to the data sources associated with these tuning jobs. If you typically review
existing tuning job archives rather than run new tuning jobs, you may wish to explicitly
connect to a data source rather than connect automatically. The options are:
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® Always: Automatically connects to data sources associated with tuning jobs that were open
last time you shut down tuning.

® Never: Automatically opens tuning job archives that were open last time you shut down the
application but does not automatically connect to the associated data sources.

® Prompt: Prompts you to connect to data sources associated with tuning jobs that were
open last time you shut down the application.

Color scheme for plan cost: In the graphical representations of explain plan cost and
elapsed time, tuning uses a color scheme to highlight differences among generated cases.
Values for the original statement are treated as a baseline, and values for individual cases
that are within a specified threshold range of the baseline value are represented with a
Baseline color. For cases whose values are outside the threshold range, Improvement and
Degradation colors are used to represent values in those cases.

TIP:  You can set the threshold in the application preferences, by selecting Window >
Preferences > Tuning Job Editor and then changing the threshold levels as required.

Case execution: Lets you dictate how execution statistics are gathered.

See Also

Specify Case Generation Preferences on page 73

Specify VST Diagrams Tuning Preferences on page 74

72
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SPECIFY CASE GENERATION PREFERENCES

Additionally, the Generated Case preference page lets you enable or disable the automatic
generation of SQL Optimizer hint-based cases of SQL statements added to a tuning job. It also
lets you indicate which specific hint types are generated when the feature is enabled.

& Preferences (Filtered)

| Case Generation L=l -

[= S0L Development
Data Source Indexing
[+ Profile Alarts

[ ] Generake cases automatically after exbracting buning candidates

| Orade |Microsoft SQL Server | IBMDBZfor LW | SybaseAsE|

[ S0 Edior [
501 Execution | Select the hints o be considered when generating cases:
EQL_FiIters . Hirk I Values | ~
= Tuning Job Editor | | =[] ORACLE_ACCESS_PATHS
Case GﬁnE:ratin:nn [ O ano_Equal 3
Y5T Diagrams D CLUSTER
[ FuLL
OHasH
[ e
O moex_asc
B2 INDEX_COMBINE
[ moex_pesc
[ moEs_FFs
FHNDES 101N ¥ Z0out af 80 selected
Descripkion:

[Rﬂstnre DeFaLiJ:sI [ Apply I

® I QK “ Cancel ]

Using the SQL Optimization perspective, select Preferences > Tuning Job Editor > Case
Generation.

Use the Case Generation option automatically after extracting tuning candidates control to
enable or disable automatic generation of hint-based cases, and then select the check
boxes to specify the hint-based cases that are generated for a statement added to a tuning

job.
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About Statement Records

Column or column set Description

SQL Statements and Cases Identifiers for the generated statement or case:

Name: Statements are assigned a numbered identifier based on the order in
which they were added to a tuning job.

Text: An excerpt of the statement or case based on the statement type
(SELECT, INSERT, DELETE, and UPDATE). For details on how to view the entire
statement or case.

Cost An explain plan-based cost estimate. This field is populated as soon as the
statement is added to the Overview tab.

This column set can be expanded to display a graphical representation of the
cost to facilitate comparisons among cases.

Index Analysis Tuning automatically detects indexes that require optimization and offers you
the option to automatically optimize the index. For more information, see
"Implementing Index Analysis Recommendations" on page 40.

Elapsed time The execution time during the most recent execution. This column set is not
populated until you execute the statement or case.

This column set can be expanded to display a graphical representation of the
elapsed time to facilitate comparisons among cases.

Other Execution Statistics The default, collapsed view has Physical Reads and Logical Reads columns.
Expanded, there are also Consistent Gets, Block Gets, Rows Returned, CPU
time(s), Parse CPU Time(s), Row Sorts, Memory Sorts, Disk Sorts, and Open
Cursors columns. For details on these statistics, refer to your DBMS
documentation.

This column set is not populated until you execute the statement or case.

SPECIFY VST DIAGRAMS TUNING PREFERENCES

The preferences on this page allow you to control the presentation of Visual SQL Tuning
diagrams.

Using the SQL Optimization perspective, select Preferences > Tuning Job Editor > VST
Diagrams.

The following describes the options available:
Show count information:

Hide sub-query names when expanded:

EXAMPLES OF TRANSFORMATIONS AND SQL QUERY REWRITES

Cartesian Product Elimination: Detects Cartesian Joins and propose corrections based on
analysis of statement, for example suggesting dept.deptno = emp.deptno if emp and dept had
no join criteria.
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Expression Transformation: |dentifies actions on predicates that might suppress index usage
such as “where empid + 1 = 1", should be “where empid=0"

Invalid Outer Join: Identifies invalid outer joins and suggests more efficient alternatives.

Before

After

SELECT * FROM employee e, customer ¢
WHERE e.employee_id = c.salesperson_id ( +)
AND c.state = 'CA'

SELECT * FROM employee e, customer ¢
WHERE e.employee_id = c.salesperson_id ( +)
AND c.state( + ) = 'CA'

Transitivity:

Before

After

SELECT * FROM item i, product p, price pr

WHERE i.product_id = p.product_id AND
p.product_id = pr.product_id

SELECT * FROM item i, product p, price pr

WHERE i.product_id = p.product_id AND
p.product_id = pr.product_id

AND i.product_id = pr.product_id

Move Expression to WHERE Clause

Before

After

SELECT col_a, SUM(col_b) FROM table_a
GROUP BY col_a HAVING col_a > 100

SELECT col_a, SUM(col_b) FROM table_a
WHERE col_a > 100 GROUP BY col_a

NULL Column

Before

After

SELECT * FROM employee
WHERE manager_id != NULL

SELECT * FROM employee
WHERE manager_id IS NUL

Push Subquery

Before

After

SELECT *
FROM employee

WHERE employee_id = (SELECT MAX(salary)
FROM employee)

SELECT employee.*

FROM employee, (SELECT DISTINCT MAX(salary)
col1 FROM employee) t1

WHERE employee_id = t1.col1

Mismatched column types: identify joins type mismatch such as number = character which

might suppress use of Index
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DBMS HINTS

Users can provide hints to a specified platform in order to instruct data source optimizer on the
best way to execute SQL statements. Tuning automatically generates cases using these hints.

Hints can be enabled or disabled when cases are being generated by tuning on the Window >

Preferences > Tuning Job Editor > Case Generation pane. Choose a tab as it pertains to the

platform you want to modify and use the check boxes to select and de-select the hints you want
to enable or disable, respectively.

& Preferences (Filtered)

| Case Generation L=l -

[= S0L Development
Data Source Indexing
[+ Profile Alarts

[ ] Generake cases automatically after exbracting buning candidates

| Orade |Microsoft SQL Server | IBMDBZfor LW | SybaseAsE|

[ S0 Edior [
501 Execution | Select the hints o be considered when generating cases:
EQL_FiIters . Hirk I Values | ~
= TI.II'II] JDEdILT.II’ | | =[] ORACLE_ACCESS_PATHS
Case I:ﬁneratu:nn [ O ano_EquaL A
WET Diagrams Ocwuster
[ FuLL
OHasH
Emoex
O moex_asc
B2 INDEX_COMBINE
[ moex_pesc
[ moEs_FFs
. FHNDES 101N ¥ Z0out af 80 selected
Descripkion:

[Rﬂstnre DeFaLiJ:sI [ Apply I

® I QK “ Cancel ]

The following topics describe platform hints that are packaged in tuning to provide optimal
efficiency when executing jobs:

e Oracle Hints on page 77
e SQL Server Hints on page 82
e DB2 Hints on page 83

e Sybase Hints on page 84
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ORACLE HINTS

NOTE:

USING TUNING > DBMS HINTS

Hint Analysis through SQL hint injection for Oracle data sources is not supported in
DB Optimizer XE Developer.

The following table highlights Oracle hints based on Oracle hints optimization:

[indexspec [TAL: indexspec]...])
*/

Category Hint Available For Notes
ACC PATH AND_EQUAL /*+ CLUSTER (tablespec) */ -
ACC PATH CLUSTER /*+ FULL ( tablespec) */ Use on Clustered Tables only
ACC PATH FULL /*+ HASH (tablespec) */ Forces a table scan even if there are
indexes.
ACC PATH HASH /*+ INDEX ( tablespec [TAL: Only to tables stored in a table
indexspec]) */ cluster.
ACC PATH INDEX /*+ INDEX_ASC ( tablespec If no indexspec is supplied, the
[TAL: indexspec]) */ optimizer will try to scan with each
avail index.
ACC PATH INDEX_ASC /*+ INDEX_COMBINE Essentially the same as INDEX.
(tablespec [ indexspec [TAL:
indexspec]...]) */
ACC PATH INDEX_COMBINE /*+ INDEX_DESC ( tablespec [ Forces the optimizer to try multiple
indexspec [TAL: indexspec]...]) | boolean combinations of indexes.
*
/
ACC PATH INDEX_DESC /*+ INDEX_DESC ( tablespec [ Essentially the same as INDEX.
indexspec [TAL: indexspec ... ])
*
/
ACC PATH INDEX_FFS /*+ INDEX_FFS ( tablespec [ Forces an index scan using
indexspec [TAL: indexspec]...]) | specified index(es).
*
/
ACC PATH INDEX_JOIN /*+ INDEX_JOIN ( tablespec | Indexes used should be based on
indexspec [TAL: indexspec]...]) | columns in the where clause.
*
/
ACC PATH INDEX_SS /*+ INDEX_SS ( tablespec [ Useful with composite indexes
indexspec [TAL: indexspec]...]) | where the first column is not used in
*/ the query, but others are.
ACC PATH INDEX_SS_ASC /*+ INDEX_SS_ASC (tablespec| | Essentially the same as INDEX_SS.
indexspec [TAL: indexspec ... ])
*
/
ACC PATH INDEX_SS_DESC /*+INDEX_SS_DESC (tablespec | Essentially the same as INDEX_SS.
[indexspec [TAL: indexspec]...])
*
/
ACC PATH NO_INDEX /*+ NO_INDEX ( tablespec [ Directs the Optimizer not to use
indexspec [TAL: indexspec]...]) | specified index(es).
*
/
ACC PATH NO_INDEX_FFS /*+ NO_INDEX_FFS ([ tablespec | Directs the Optimizer to exclude a

fast full scan of the specified
index(es).
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Category Hint Available For Notes

ACC PATH NO_INDEX_SS /*+ NO_INDEX_SS (tablespec|[ | Directs the Optimizer to exclude a
indexspec [TAL: indexspec]...]) | skip scan of the specified index(es).
*

/

ACC PATH ROWID - -

JOIN OP HASH_AJ - -

JOIN OP HASH_SJ - -

JOIN OP MERGE_AJ - -

JOIN OP MERGE_SJ - -

JOIN OP NL_AJ - -

JOIN OP NL_SJ - -

JOIN OP NO_USE_HASH /*+ NO_USE_HASH (tablespec | Negates the use of hash joins for
[TAL: tablespec]...) */ the table specified.

JOIN OP NO_USE_MERGE /*+ NO_USE_MERGE ( Negates the use of sort-merge joins
tablespec [TAL: tablespec ]...) */ | for the table specified.

JOIN OP NO_USE_NL /*+ NO_USE_NL (tablespec Negates the use of nested-loop
[TAL: tablespec]...) */ joins for the table specified.

JOIN OP USE_HASH /*+ USE_HASH (tablespec [TAL: | Directive to join each table
tablespec]...) */ specified using a hash join.

JOIN OP USE_MERGE /*+ NO_USE_MERGE ( Directive to join each table
tablespec [TAL: tablespec ]...) */ | specified using a sort--merge join.

JOIN OP USE_NL /*+ NO_USE_NL ( tablespec Directive to use a nested-loop join
[TAL: tablespec]...) */ with the specified tables as the

inner table.

JOIN OP USE_NL_WITH_INDEX /*+ USE_NL_WITH_INDEX ( Directive to use a nested-loop join
tablespec [ indexspec [TAL: with the specified table as the inner
indexspec]...]) */ table using the index specified to

satisfy at least one predicate.

JOIN ORDER | LEADING /*+ LEADING (tablespec) */ Directive to join the tables in the
order specified.

JOIN ORDER | ORDERED /*+ ORDERED */ Directive to join tables in the order
found in the FROM clause.

JOIN ORDER | STAR - -

OPT ALL_ROWS /*+ ALL_ROWS */ Indicates the goal is overall

APPROACH throughput.

OPT CHOOSE - -

APPROACH

OPT FIRST_ROWS /*+ FIRST_ROWS (integer) */ The goal is to retrieve the first row(s)

APPROACH as fast as possible.

OPT RULE /*+ RULE */ Used to disable the COST based

APPROACH optimizer.

OTHER CACHE /*+ CACHE ( tablespec) */ Should be used with the FULL hint.
Places data in the most-recently
used area of the buffer cache.
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Category

Hint

Available For

Notes

OTHER

APPEND

/*+ APPEND */

Directs the optimizer to INSERT
data at the end of the existing table
data using direct path I/0.

OTHER

CURSOR_SHARING_EXA
CT

/*+ CURSOR_SHARING_EXACT
*/

Directs the Optimizer to ignore
previously parsed SQL that
matches, but uses bind variables.
Forces the SQL to be parsed unless
an exact match is found.

OTHER

DRIVING_SITE

/*+ DRIVING_SITE ( tablespec)
*/

Used when data is joined remotely
via DBLink. Normally data at the
remote site is returned to the local
and joined. This hint directs the
optimizer to send the local data to
the remote site for resolution of the
join.

OTHER

DYNAMIC_SAMPLING

/*+ DYNAMIC_SAMPLING
( [TAL: tablespec]integer) */

Only used in simple SELECT
statements with a single table to
approximate cardinality if there are
no existing statistics on the table.

OTHER

MODEL_MIN_ANALYSIS

/*+ MODEL_MIN_ANALYSIS */

Used with spreadsheet and model
analysis to minimize compile time.

OTHER

NO_PUSH_PRED

/*+ NO_PUSH_PRED [TAL:
(tablespec )] */

Opposite of PUSH_PRED, it directs
the Optimizer not to try to push the
predicate into the view.

OTHER

NO_PUSH_SUBQ

/*+ NO_PUSH_SUBQ ] */

Opposite of PUSH_SUBQ, it directs
the Optimizer not to try and
evaluate the subquery first.

OTHER

NO_UNNEST

/*+ NO_UNNEST */

Subqueries in the WHERE clause
are considered nested. A subquery
can be evaluated several times for
multiple results in the “parent”.
Unnesting evaluates the subquery
once and merges the results with
the body of the “parent”. This hint
directs the Optimizer NOT to
unnest.

OTHER

NOAPPEND

/*+ NOAPPEND */

Directs the Optimizer to utilize
existing space in a table and
negates parallel processing.

OTHER

NOCACHE

/*+ NOCACHE ( tablespec) */

Should be used with the FULL hint.
Places data in the least-recently
used area of the buffer cache.

OTHER

OPT_PARAM

OTHER

ORDERED_PREDICATES

OTHER

PUSH_PRED

/*+ PUSH_PRED [TAL:
(tablespec)]*/

Used when one of the tables in a
join is an in-line view. Forces the
predicate used to join the table and
the view into the view.
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Category Hint Available For Notes

OTHER PUSH_SUBQ /*+ PUSH_SUBQ * Used with an EXISTS or IN subselect
to force evaluation of the subquery
rather than the default behavior of
the last.

OTHER UNNEST /*+ UNNEST */ Subqueries in the where clause are
considered nested. A subquery
could be evaluated several times for
multiple results in the “parent”.
Unnesting evaluates the subquery
once and merges results with the
body of the “parent”.

PARALLEL NO_PARALLEL /*+ NO_PARALLEL (tablespec) | Directs the Optimizer not to parallel

*/ the specified table.

PARALLEL NO_PARALLEL_INDEX /*+ NO_PARALLEL_INDEX Directs the Optimizer not to parallel
(tablespec [ indexspec [TAL: the specified index(es).
indexspec]...]) */

PARALLEL NO_PX_JOIN_FILTER /*+ NO_PX_JOIN_FILTER Directs the Optimizer not to try and
(tablespec) */ join bitmap indexes in parallel.

PARALLEL NOPARALLEL /*+ NOPARALLEL (tablespec) */ | Directs the Optimizer not to parallel
the specified table.

PARALLEL NOPAARALLEL_INDEX /*+ NOPARALLEL_INDEX Directs the Optimizer not to parallel
(tablespec [ indexspec [TAL: the specified index(es).
indexspec]...]) */

PARALLEL PARALLEL /*+ PARALLEL ( tablespec [ Number specifies degrees of
integer | TALDEFAULT ]) */ parallelism (how many processes).

PARALLEL PARALLEL_INDEX /*+ PARALLEL_INDEX Number specifies degree of
(tablespec [ indexspec [TAL: parallelism (how many processes).
indexspec ... | integer |
DEFAULT ) */

PARALLEL PQ_DISTRIBUTE /*+ PQ_DISTRIBUTE( tablespec | Used in parallel join operations to
outer_distribution indicate how inner and outer tables
inner_distribution ) */ of the joins should be processed.

The values of the distributions are
HASH, BROADCAST, PARTITION,
and NONE. Only six combinations
table distributions are valid.

PARALLEL PX_JOIN_FILTER /*+ PX_JOIN_FILTER (tablespec) | Directs the Optimizer to try and join
*/ bitmap indexes in parallel.

QUERY EXPAND_GSET_TO_UNIO | /*+ EXPAND_GSET_TO_UNION | Performs transformations on

TRANS N */ queries that have GROUP BY into
Unions.

PARALLEL FACT /*+ FACT ( tablespec) */ In the context of STAR

transformation, this table should be
considered a FACT table (as
opposed to a DIMENSION).
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Category Hint Available For Notes
PARALLEL MERGE /*+ MERGE ([ view | tablespec) | Use with either an in-line view that
*/ has a Group by or Distinctin it as a
joined table, or with the use of IN
subquery to “merge” the “view"
into the body of the rest of the
query.

PARALLEL NO_EXPAND /*+ NO_EXPAND */ Used when OR condition (including
IN lists) is present in the predicate
to not consider transformation to
compound query.

PARALLEL NO_FACT /*+ NO_FACT ( tablespec) */ In the context of STAR
transformation this table should not
be considered a FACT table.

PARALLEL NO_MERGE /*+ NO_MERGE [ ([ view | Directs the Optimizer not to

TAL:tablespec)]*/ “merge” the view into the query.

PARALLEL NO_QUERY_TRANSFOR | /*+ Directs the Optimizer not to

MATION NO_QUERY_TRANSFORMATIO | transform OR, in-lists, in-line views,
N */ and subqueries. Try it whenever any
of these conditions are present.

PARALLEL NO_REWRITE /*+ NO_REWRITE */ Directs the Optimizer not to use a
Materialized View, even if one is
available.

PARALLEL NO_STAR_TRANSFORMA | /*+ Directs the Optimizer not to try a

TION NO_STAR_TRANSFORMATION | Star Transformation.
*/
PARALLEL NO_XML_QUERY_REWRI | /*+ NO_XML_QUERY_REWRITE | Use only if the query is using XML
TE */ functionality.

PARALLEL NO_XMLINDEX_REWRITE | /*+ NO_XMLINDEX_REWRITE */ | Use only if the query is using XML
functionality.

PARALLEL NOFACT /*+ NOFACT (tablespec) */ In the context of STAR
transformation, this table should not
be considered a FACT table.

PARALLEL NOREWRITE /*+ NOREWRITE Directs the Optimizer not to use a
Materialized View, even if one is
available.

PARALLEL REWRITE /*+ REWRITE Directs the Optimizer to use a

[ (view [TAL: view ]...) ] */ Materia]ized View instea'JoI of the
underlying tables. Specify REWRITE
without additional parameters.
Oracle will determine if it can us a
Materialized View or not.

PARALLEL STAR_TRANSFORMATIO | /*+ STAR_TRANSFORMATION Directs the Optimizer to try Star

N */ Transformation. Only try with a 3
table or more join.

PARALLEL USE_CONCAT /*+ USE_CONCAT */ Used when the OR condition

(including IN lists) is present in the
predicate to transform the query
into a compound UNION ALL.
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Category Hint

Available For

Notes

REAL TIME MONITOR

/*+ MONITOR */

Effective only if STATSTICS_LEVEL
initialization parameter is either set
to ALL or TYPICAL and
CONTROL_MANAGEMENT_
PACK_ACCESS is set to
DIAGNOSTIC+TUNING. Turns on
features of the Oracle Database
Tuning Pack.

REAL TIME NO_MONITOR

/*+ NO_MONITOR */

See MONITOR hint.

SQL SERVER HINTS

The following table highlights SQL hints based on MS SQL Server hints optimization:

Category | Hint

Available For

Notes

JOIN LOOP SELECT/UPDATE/DELETE Not applicable for RIGHT OUTER or FULL
joins.

JOIN HASH SELECT/UPDATE/DELETE -

JOIN MERGE SELECT/UPDATE/DELETE -

JOIN REMOTE SELECT/UPDATE/DELETE Only for INNER JOINs. Not applicable
with COLLATE

SELECT/UPDATE/DELETE -

QUERY RECOMPILE SELECT/UPDATE/DELETE -

QUERY FORCE ORDER SELECT/UPDATE/DELETE -

QUERY ROBUST PLAN SELECT/UPDATE/DELETE -

QUERY KEEP PLAN SELECT/UPDATE/DELETE -

QUERY KEEPFIXED PLAN SELECT/UPDATE/DELETE -

QUERY EXPAND VIEWS DML Statements Only for statement containing views.

QUERY HASH GROUP SELECT Only when GROUP BY, COMPUTE and
DISTINCT clauses are used.

QUERY ORDER GROUP SELECT/UPDATE/DELETE Only when GROUP BY, COMPUTE and
DISTINCT clauses are used.

QUERY MERGE UNION SELECT Only for statements chained using UNION

QUERY HASH UNION SELECT Only for statements chained using UNION

QUERY CONCAT UNION SELECT Only for statements chained using UNION

QUERY LOOP JOIN SELECT/UPDATE/DELETE -

QUERY MERGE JOIN SELECT/UPDATE/DELETE -

QUERY HASH JOIN SELECT/UPDATE/DELETE -

TABLE INDEX() DML Statements Only for tables and views with indexes.
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Category | Hint Available For Notes

TABLE KEEPIDENTITY INSERT Only for INSERT statements using
OPENROWSET clause with BULK option.

TABLE KEEPDEFAULTS INSERT Only for INSERT statements using
OPENROWSET clause with BULK option.

TABLE HOLDLOCK DML Statements Not applicable for SELECT statements
using FOR BROWSE clause.

TABLE IGNORE_CONSTRAINT | INSERT Only for INSERT statements using

S OPENROWSET clause with BULK option.

TABLE IGNORE_TRIGGERS INSERT Only for INSERT statements using
OPENROWSET clause with BULK option.

TABLE NOLOCK SELECT/UPDATE/COMPLETE | Not applicable for the target table in
UPDATE/DELETE statements.

TABLE NOWAIT DML Statements -

TABLE PAGLOCK DML Statements -

TABLE READCOMMITED DML Statements -

TABLE READCOMMITEDLOCK | SELECT/UPDATE/COMPLETE | -

TABLE READPAST SELECT/UPDATE/COMPLETE | Not applicable for the target table in
UPDATE/DELETE statements.

TABLE READUNCOMMITED SELECT/UPDATE/COMPLETE | Not applicable for the target table in
UPDATE/DELETE statements.

TABLE REPEATEABLEREAD DML Statements -

TABLE ROWLOCK DML Statements -

TABLE SERIALIZABLE DML Statements Not applicable for SELECT statements
using FOR BROWSE clause.

TABLE TABLOCK DML Statements -

TABLE TABLOCKX DML Statements -

TABLE UPDLOCK DML Statements -

TABLE XLOCK DML Statements -

TABLE FASTFIRSTROW DML Statements -

DB2 HINTS

The following table highlights SQL hints based on IBM DB2 hints optimization:

Category Hint Notes

Command SET OPTIMIZATION LEVEL For top-level SELECT statements
only

Clause optimize for <n> rows For top-level SELECT statements

only
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Category

Hint

Notes

Clause

fetch first <n> rows only

For SELECT statements only

SYBASE HINTS

The following table highlights SQL hints based on Sybase hints optimization:

Category Hint Notes

Logical distinct No explicit implementation

Logical group No explicit implementation

Logical g_join No explicit implementation

Logical nl_g_join Not applicable for: statements with chained
queries; select statements with group by
clause and having clause or group by clause
and order by clause

Logical m_g_join Not applicable for: statements with chained
queries; select statements with group by
clause and having clause or group by clause
and order by clause

Logical join No explicit implementation

Logical nl_join Not applicable for: select statements with
group by clause and having clause or group
by clause and order by clause

Logical m_join Not applicable for: select statements with
group by clause and having clause or group
by clause and order by clause

Logical h_join Not applicable for: select statements with
group by clause and having clause or group
by clause and order by clause

Logical union No explicit implementation

scan No explicit implementation

Logical scalar_agg Only used in combination with other
operators. It does not change the execution
plan itself.

Logical sequence Is a keyword that will be used in the
implementation of scalar_agg operator.

Logical hints We don't support a combination of hints

Logical prop Uses a set of pre-defined values.

Logical table Used only in combination with other
operators, when referring tables from
subqueries

Logical work_t This operator is applicable only together
with store operator
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Category

Hint

Notes

Logical

Used only in combination with other
operators, when referring tables from
subqueries

Logical

subqg

Used only in combination with other
operators, when referring tables from
subqueries

Physical

distinct_sorted

Only for SELECT statements containing
DISTINCT, and only for tables

Physical

distinct_sorting

Only for SELECT statements containing
DISTINCT, and only for tables

Physical

distinct_hashing

Only for SELECT statements containing
DISTINCT, and only for tables

Physical

group_sorted

Only for SELECT statements (not working for
views) with no having and no order by clause.

Physical

group_hashing

Only for SELECT statements (not working for
views) with no having and no order by clause.

Physical

group_inserting

Not implemented

Physical

append_union_all

Not applicable for: UNION chained clauses,
nested sub-selects in a from clause, if a
group by clause is present or if scalar
aggregation is present

Physical

merge_union_all

Not applicable for: UNION ALL chained
clauses, nested sub-selects in a from clause,
or if a group by clause is present.

Physical

merge_union_distinct

Not applicable for: UNION ALL chained
clauses, nested sub-selects in a from clause,
or if a group by clause is present.

Physical

hash_union_distinct

Not applicable for: UNION ALL chained
clauses, nested sub-selects in a from clause,
if a group by clause is present, or if scalar
aggregation is present.

Physical

i_scan

Applied to all table references in the from
clause of the main select and of the sub
select statements except: 1. statement has
sub-selects. 2. table references has no
indexes.
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Category

Hint

Notes

Physical

t_scan

Applied to all the table references in the
from clause of the main select and of the sub
select statements except: On Sybase 12.5
not applied for tables in the main query if: 1.
statement has chained queries. 2. Sub
queries have group by and having clauses;
and not applied to the tables in sub selects
if: 1. has select statements in from clause of
the main select. 2. sub queries have group by
and having clauses. 3. statement has select
statements in select clause. 4. statement has
parent statement and insert statement; on
Sybase 15 not applied for tables in sub
selects if: 1. has select statements in from
clause of the main select. 2. statement has
chained queries.

Physical

m_scan

Applied for all tables if in the where clause
there is a condition like:
table1.indexedColumn1 condition body OR
table1.indexedColumn2 condition body; Not
applied if the LIKE operator is used. For
columns that belong to a primary key only
the first column is considered.

Physical

store

Physical

store_index

Physical

sort

Physical

xchg
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TUTORIALS

The tutorials enable you to get started using DB Optimizer. Their purpose is to provide you with
the foundation needed to fully utilize the features and benefits of the products, and apply them
to your own enterprise. This section contains information on how to register data sources from
your enterprise, and how to profile, analyze, and tune SQL statements, sessions, and events for
the purpose of optimizing the efficiency of your data sources, as well as identify and prevent
system bottlenecks and other wait-related issues.

This guide is comprised of the following sections:

e Working with Data Source Explorer on page 96

e Profiling a Data Source on page 100

¢ Tuning SQL Statements on page 109

e SQL Code Assist and Execution on page 122

Once you have started the application, you can select Help from the Menu Bar to find additional
resources that compliment and build upon the features and tasks presented in this guide.
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WORKING WITH DATA SOURCE EXPLORER

Data Source Explorer provides a tree view of all data sources registered in DB Optimizer. In
addition, it breaks down the components of each data source and categorizes databases and
corresponding database objects by object type and underlying SQL code. This feature provides
you with a view of the contents of data sources in your enterprise in an easily navigated and
cataloged interface. If you have implemented a Profiling Repository for your Oracle data sources
then you can access saved profiling sessions from the Data Source Explore

E'EI Data Source Explor &4 %’ S0QL Project Explore = 8
g BS "

=l T=F Managed Data Sources [5) ~
=I-1=F Daka Source Group (3
=I-1=F Microsoft SOL Server (2]
+-1=F Microsoft SOL Server (1)
+- S TORLAESQLOO_1_#2 (0L Server 8,0,20
=T+ Cracle (&)
+ i Mew data source (Oracls &.1.7,4)
+-Sm ROMLABORCLEI_1 (Oracls 8,1.7.4)
+- i ROMLABORCLSI_2 (Oracle 9.2,0,1)
= fﬂ sfvpclb0l embarcadera.cam (Oracls 10,2
+ [__fj Database Objects
= M Profiling R.epositary
= i romlabsgl0S_1-sa
&, 2010-01-08 00:46:23 {34m)
+ @] TORLABORCLSI 2 (Orace 5.1.7.4) ot
< >

Data Source Explorer sorts databases and database objects by category within DB Optimizer.

If data sources are particularly large or complex, or you are only developing specific objects, you
can apply database object filters on the view in Data Source Explorer.
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ADDING DATA SOURCES

In order to profile and tune statements, you need to register the data sources to be analyzed in
the environment by providing connection information and other details to DB Optimizer. Data
sources are registered and managed in Data Source Explorer. Each time you register a new data
source you need to specify its connection information and organize it in the View, as needed.
Once a data source has been registered, it remains stored in a catalog and does not need to be
registered again each time you open DB Optimizer. Furthermore, it can be used in multiple jobs,
archived, or otherwise “shared” with regards to the general functionality of the application.

Hy ©3 . = s0LProject Expl | — O
m- wghif BER T
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= Hs ROMLABORCLEI_L (Oracle 8,1.7.4)
[L_f:; Database Objects
I8 ROMLABORCLSI_Z (Oracle 2,2.0.1)
% sfypelb0l .embarcadero,.com (Cracle 10
= H TORLABORCLEI_Z (Cracls 5,1.7.4)
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= Hl TORLABORCLEI_S (Oracls)
({3 Database Objects
= Hs TORLABORCLSI_1 (Crarle)
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The Data Source Explorer view provides an organizational tree of registered data sources and the parameters associated with them.
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To
1

add a data source:

Select Data Source Explorer and choose File > New > Data Source from the Menu bar.

The Data Source Wizard appears.

¥ New Data Source: New data source |:|®

Register a new data source

Choose the server bvpe and lacation For wour new data source,

r

Generate an unigue name based on the alias or the host name

[Data source name:

Select a server type:

Select a data source group:

CthGeneric IDBC
C4IEM DEZ for LUW
CHiMicrosoft SOL Server
CHhorace

= [=F Managed Data Sources
[=11=F Data Source GEroup
=-1=F Microsoft S0L Server
[=-T=F Microsaft S0L Server

Ct5vbase ASE

1=F Cracle

|

[=-TF wew

I=F Microsoft SOL Server

I=F Microsoft SQL Ser

|:| Create a new server type-specific subgroup

Select a category: | Mo category

v

@

Cancel

2 Follow the steps provided to register the data source. When you are finished, the data
source is added to Data Source Explorer.

98

NOTE:

To assist you when managing a large number of data sources, you can now assign a

category to a data source. The data source be decorated with the color associated with
the category. Categories include Development, Test, QA, and Production.
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BROWSING DATA SOURCES

In order to analyze and tune statements on data sources within your enterprise, you need to
access the data source objects within the application environment. It is important to be able to
view databases and underlying code in an organized manner, especially when maintaining a
large system. Data Source Explorer’s tree structure can be used to view databases, tables, and
other information about data sources. Expand the nodes of each registered data source to view
details about each data source. Data Source Explorer is also used to launch profiling sessions, by
enabling you to select the data source that you want to execute, and then launching a profiling
session from your selection.
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Properties

The Data Source Explorer tree provides a list of databases, and enables you to launch Optimizer features, such as SQL Profiler, via
the context menu.

All objects listed in Data Source Explorer are organized, in descending order, by data source.
Additionally, if you double-click on an object, SQL Editor will open and display the underlying
SQL code.
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Notice in the screenshot above, there is a Profiling Repository on the last data source in the list
of Oracle data sources. For Oracle data sources only, you can save your profiling sessions to the
Profiling Repository for later examination. We'll discuss this more later in "Saving a Profiling
Session " on page 107.

To browse a data source:

Expand the node of the data source that you want to examine. Double-click an object to view
the code in SQL Editor.

PROFILING A DATA SOURCE

NOTE: The SQL Profiler is not available in the “Basic” version of DB Optimizer.

SQL Profiler is an interface component that constantly samples a data source and builds a
statistical model of the load on the database. Profiling is used to locate and diagnose
problematic SQL code and event-based bottlenecks. Additionally, Profiler enables you to
investigate execution and wait time event details for individual stored routines. Results are
presented in the profiling editor, which enables you to identify problem areas and view
individual SQL statements, as needed.
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SQL Profiler analyzes and provides a statistical model of database load that identifies problematic code and event-based bottlenecks.

SQL Profiler is composed of the following diagnostic parts:

¢ The Load Graph provides a display of the overall load on the system. The bars represent
individual aspects of the data source.

e The Top Activity section displays where load originates. Specifically, Top Activity displays
the top SQL statements, the top events the database spends time in, and the top activity
sessions that may be causing issues in terms of query time and response.

¢ The Profiling Details view displays detailed information for any item selected from Top
Activity. For example, examining a SQL statement from Top Activity displays the
identification parameters and the execution statistics of that specific statement selection.
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STARTING A PROFILING SESSION

In order to access SQL Profiler, you need to run a profiling session on a data source registered in
Data Source Explorer. You can do this by right-clicking on a data source and selecting

Profile As ...> Data Source from the context menu. You can also click the Profile icon in the
Toolbar, which initiates a profile session on the last selected data source in Data Source Explorer.

Once a profiling session launches, it runs until you stop it or it has run for its specified length of
time. You can stop a session by clicking the Stop icon on the right-hand side of the Profiling
progress bar.

When the profiling session is complete, the first two sections (Load Chart and Top Activity) will
be populated with information about the database load. You can then begin analyzing the data
and identifying problem areas.

@ progress i3 % ~ — O
mPrl:-ﬁling torlabsgloD_2
[[(sesw= |

Inibalizing session...

The Progress view indicates that the profiling session has been initiated.

To run a profiling session:

In Data Source Explorer, right-click on a data source and select Profile As ...> Data Source. The
profiling session begins.

ANALYZING SESSION DATA

Profiler is composed of three essential diagnostic views that provide information about load on a
particular database in the system. These views enable you to identify bottlenecks and view
details about specific queries that execute and wait over the course of a profiling session.

SQL Profiler is composed of the following three components, listed in descending order of
granularity:

¢ Load Chart. For more information, see "Load Chart " on page 103.

® Top Activity. For more information, see "Top Activity " on page 103.

¢ Profiling Details. For more information, see "Profiling Details " on page 104.
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LOAD CHART

The Load Chart provides an overview of the load on the system, and is designed as a high level

entry point to reading session results. The colored bars represent individual aspects of the

database, and the graph can be used to discover bottlenecks.
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The Load Chart displays the overall load of the database that you analyzed with Profiler.

Time is displayed on the X axis, and the Y axis shows the average number of sessions waiting or

executing. Each support platform type has a specific set of wait event times. For example,

Sybase platforms will display CPU, Lock, Memory, I/0, Network, and Other. Use the chart legend
to understand the graph. It displays a color and code scheme for executing and waiting session

categories in the upper right-hand corner of the chart.

TOP ACTIVITY

Below the Load Graph, the Top Activity section displays where the load originates and outlines

the top SQL statements, top events, and the top activity sessions on the database. It is

composed of a series of tabs that provide detailed statistics on individual SQL statements and

sessions that are waiting or executing over the length of the profiling session.

EE overview 13 S0L | €5 Events | &7 Sessions | $00 Object 1/0

SOL Statements Events Sessions
Statement D Event DB = | Usar | Program | )
D3 BEGINEMD_..., :3); END [ Ol CPU B | SvsManfoms [
+ e SELECT L.O... EXTENTS, M dh file sequential read Bl | ovIES m
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The Top Activity section displays a more detailed view of the Load Graph. It identifies top statements, events, and sessions that are
waiting or executing over the length of the profiling session.

* The Overview tab provides summary information about SQL statements and events and
their activity levels, and sessions, their system process IDs and their activity level. You can

reorder the rows in any of the three sections of this tab. For example, clicking the Event

column in the Events section changes the alphabetical order to ascending or descending.

e The SQL tab provides information about SQL statements and procedures. This includes all
INSERT, SELECT, DELETE, and UPDATE statements that are executing or waiting to execute
over the length of the profiling session.
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The Events tab displays information about wait events, and should be used to tune at the
application or database configuration level. For example, if the top events are locks, then
application logic needs to be examined. If the top events are related to database
configuration, then the database setup should be investigated.

The Sessions tab displays information about sessions, and can be used to discover sessions
that are very active or bottlenecked.

The Procedures tab displays information about procedures profiled by the execution
process.This is available for Sybase and SQL Server only.

The Object I/0 tab provides information about I/O. This tab will be displayed only if you are
profiling a database on the Oracle platform.

PROFILING DETAILS

When you select any item from Top Activity, details are displayed on the Profiling Details view.

104

TIP:  You may have to select Windows > Show View > Profiling Details to display the
Profiling Details view.
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The tabs that compose the Profiling Details view are dependent on the nature of the object selected in
Top Activity, in order to reflect that item’s specific information. The tabs are also dependent on the data
source platform. For example, the Object I/O tab is available only for the Oracle platform whereas the
Procedures tab is available only for the SQL Server and Sybase platforms.
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Profiling Details displays detailed parameter information on a statement, event, or session that was selected in Top Activity. The data
displayed also varies by database platform.

Depending on the data source platform you have specified, the tabs that appear in the view will
be different, in order to accommodate the parameter specifics of the statement you have
selected.

Depending on the top activity selected and the profiled platform types, some tabs may not be
available.

NOTE: When right-clicking on a SQL statement in the Top Activity Section in Profiling, if the
SQL statement is run by a different user than the user who is running DBO, than the
User Mismatch dialog appears, with an example of the following message: “This query
was executed by [SOE] and you are currently connected as [system]. We recommend
you reconnect as [SOE] to tune the SQL. Would you like to continue anyway?” This
message indicates that the statement is being tuned by a user other than the user who
originally ran the query, and tables may be missing based on the different schemas.
Click OK to run the query, or click Cancel and run tuning under the original user.
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To view session details:
1 In the Profile Session area of the SQL Profiler, in the Sessions column click anywhere in the
row of an application that ran during the profiling session.

2 In the Profiling Details area, click the Sessions tab.

Details of the session are displayed.
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To view SQL:

1 In the Profile Session area of the SQL Profiler, click anywhere in the row of an application
that ran during the profiling session.

2 In the Profiling Details area, click the SQL Text or SQL tab.
The SQL text for the application that selected object displays.
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TIP:  From the SQL tab you can easily tune a statement by right-clicking a statement on the
SQL tab to initiate the tuner, which then opens with the selected statement in the Ad
hoc SQL tab of the Tuner Input.
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SAVING A PROFILING SESSION

A profiling session can be saved to a file with a . oar suffix that contains the name of the data
source. This enables you to open the file at a later time for analysis.

Save As

Save file bo another location,

Enter ar select the parent Falder:

| soLProject

= s0LProject

File name: | sPvpclbidl .embarcadero. com. oar |

@::l Ok l [ Cancel ]

Profiling sessions can be saved as .oar files for use at a later time.

Once you have saved a profiling session to disk as a .oar file, it appears in the SQL Project
Explorer under the name you saved it as. It can be opened again by double-clicking the project
name.

To save a profiling session:

Select the profiling session and then choose File > Save As. Specify the project location you
want to save the file in and modify the file name, as needed. Click OK. The project is added to
SQL Project Explorer.

When profiling Oracle data sources you can alternatively save your profiling sessions to the
Profiling Repository which appears in the Data Source Explorer. This enables you to profile a
data source for an extended period of time, for days or weeks even. Through the Profiling
Repository you can also share your profiling session data for other DB Optimizer users to view
and analyze. For more information, see "Work with the Profiling Repository" on page 34.
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IMPORTING STATEMENTS TO SQL TUNER

SQL Profiler enables you to submit one or more statements into SQL Tuner. This enables you to
take advantage of Tuner’s hint-based and transformation-based suggestions if you want to tune
a problem statement that you detected over the course of a profiling session.
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Context menu commands in SQL Profiler enable you to import statements to a tuning job directly from the Profiler interface.

To Import a statement from Profiler into Tuner

Select one or more statements in Profiler, right-click and select Tune from the context menu.
SQL Tuner opens and contains the selected statements in a new tuning job. You can now
proceed to tune the problematic statements.
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TUNING SQL STATEMENTS

SQL Tuner provides an easy and optimal way to discover efficient paths for queries that may not
be performing as quickly or as efficiently as they could be. Tuner enables you to optimize poorly-
performing SQL code through the detection and modification of execution paths used in data

retrieval. This is primarily performed through hint injection, and index and statistics analysis.
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Tuner analyzes specified SQL statements and then supplies execution path directives. This enables you to select alternate paths for
queries, thus optimizing system performance based on analysis.

For example, if tuning is selecting from two tables (A and B), it will enable the joining of A to B,

or B to A as well as the join form. Additionally, different joining methods such as nested loops or
hash joins can be used and will be tested, as appropriate. Tuning will select alternate paths, and
enable you to change the original path to one of the alternates. Execution paths slower than the

original are eliminated, which enables you to select the quickest of the returned selections and
improve query times, overall.

This enables the DBA to correctly optimize queries in the cases where the native optimizer

failed.

CREATING A NEW TUNING JOB

New tuning jobs can be created from scratch where you can specify the statements to be tuned
from a variety of sources, or statements can be directly imported from existing profiling sessions
on data sources currently registered in the environment.
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Tuning jobs are defined in SQL Tuner by specifying the data source and corresponding statements to be tuned and then executing

the tuning job process.
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To create a new tuning job:

If you determined from a profiling session that a specific SQL statement should be tuned, in
the Profile Session, right-click the statement and select Tune as follows.
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Select File > New > Tuning Job, or click the New Tuning Job icon on the Toolbar. SQL
Tuner opens and you can proceed to set up the parameters of the new job.

Once you have defined the input of the tuning job, you can save the file with a . tun suffix
via the Save As... command. The job is added to the SQL Project Explorer and can be re-
opened and re-run at any time once it is saved to the system.
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ADDING SQL STATEMENTS

Once you have created a name for the tuning job and indicated its source, you can add SQL
statements that you want the job to tune. Statements are added to a job via the Ad hoc SQL
box. All standard DML statements (such as SELECT, INSERT, DELETE, UPDATE) are viable for the
tuning procedure.
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Statements are added to a tuning job via the Input tab.

There are four or five different ways to add SQL statements to a job, as reflected by the options
in the SQL list

Use the SQL menu to specify which SQL statements to tune.

* New SQL Text: Copy/paste SQL statements to the SQL Text dialog or write queries by
hand.

e Extract from Database Objects: Drag and drop database objects from the Data Source
Explorer to the statement grid on the Overview tab.

¢ Import from File (Workspace) and Import from File (System): Browse the workspace or
file system and select SQL files.

® Scan Oracle SGA For the Oracle platform only, you can also scan the System Global Area
(SGA) for statements to tune.
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To add new SOL Text:

From the SQL list, select New SQL Text and manually type an SQL statement in the window.
Alternatively, copy/paste the statement from another source.

& soL Text (=13
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To add a database object:

From the SQL list, select Extract from Database Object. The Data Source Objects Selection
dialog appears. Type an object name prefix or pattern in the field provided and choose a
statement from the window as it populates to match what you typed.

& Data Source Objects Selection i_,@
Enter object name prefix or patkern (¥ = any character, * = any skring): -
E |
Matching objects:

& COUNT_TIME_INTERVAL {Package) - SYSTEM ~
S DEMS_REPCAT ALTH (Package) - SYSTEM 3
% DRS (Package)

% DRGSS (Package)

S EMP_ACTIONS (Package) - SYSTEM

RN MENT MATA SFelemant :

Confiqure data source indexing.. .

® [ (4 l [ Cancel

TIP:  You can also drag an object, such as a Packages, Package Bodies, Views, and
Functions, from the Data Source Explorer to the grid on the Overview tab.

NOTE: In order to drag a database object into the statement grid on the Overview tab, the
database object in the Data Source Explorer must be in the same database that
displays in the breadcrumbs at the top of the Tuning window.

To add a saved SQL file:

From the SQL list, select Import from File (Workspace) or Import from File (File System),
depending on where the file you want to add is stored. Select a file from the dialog that appears
and it will be added to the tuning job.
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To add Active SOL in SGA:

From the SQL list, select Scan Oracle SGA. Specify any filters as required and then click Next.
From the list of SQL statements retrieved from the SGA, select those you want to optimize, and
then click Finish. The selected statements are copied to the tuning job.

& Scan 5GA |._|®
SGA filters £
Specify the filkering criteria for ackive SQL in the SGA, DJ

Filker Criteria

Mazimurn retrieved queries:ﬂ'| =

Sort by: |CPU Time v |

advanced Filters

User: | A4 |

Parsing Schema;

Module: | w |
Bckion: | e |
Service:

RUNNING A TUNING JOB

After you add SQL statements to the job, click the Overview tab. Once you choose your tuning
options and click the Run Job icon, the DML is parsed from the statements and added to the
Generated Cases area. The Generated Cases are alternative execution paths or explain paths
that could be better or worse than the default path the database uses. When these cases are
executed you can use the execution statistics to determine which case would optimize
performance.
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Each extracted statement is listed by Name and Text. Additionally, each statement has a Cost,
Elapsed Time, and Other Execution Statistics value that provide information on how effectively
each case executes on the specified data source. These parameters let you compare the
efficiency of the original statements to the cases generated by the tuning process when it is
executed.

TIP:  You can click the Text field of a generated case to view the SQL source of the

statement.
Tuning Status Indicator Column Set Run/Cancel Job
Enable Execution Expand/Collapse Controls
Check Box Control
Increase/Decrease

Pane Size Control

The Generated Cases tab enables you to measure the various load costs of the original tuning statements and generated cases for
each, which suggest alternative query paths to optimizing your data source.

The Tuning Status Indicator provides the status of each statement or case, and indicates if they
are ready for execution. In some cases, SQL code may need to be corrected or bind variables
may need to be set prior to executing statements. When you try to tune a statement containing
a bind variable you are now warned that either the type is not set or the value is not set.
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Use the check boxes to select which statements and cases you want to run and then click the
Run icon in the lower right-hand corner of the screen. The Execute each generated case field
enables you to execute each selected statement or case.

Once you have executed a tuning job, the Generated Cases tab will reflect SQL Tuner’s analysis
of the specified statements. Once these have been analyzed, you can proceed to modifying the
Tuner results and applying specified cases on the data source to optimize its performance.

To execute a tuning job:

1 Once you have a SQL statement that is a tuning candidate, navigate to the Overview tab.

2 Inthe Tuning Statements area, select the checkbox next to the Statement name that you
want to analyze and then

3 To analyze the SQL statements, click Generate cases.

To perform the analysis that populates the Analysis tab now, click Perform detail analysis.
Otherwise, this analysis tab is performed when you click the Analysis tab.

To have the system generate execution statistics, click Execute each generated case and
then select the number of times the system should execute each generated case. Multiple
executions can verify that the case results are not skewed by caching. For example, the first
time a query is run, data might be read off of disk, which is slow, and the second time the
data might be in cache and run faster. Thus, one case might seem faster than another but it
could be just benefiting from the effects of caching. Generally, you only need to execute the
cases once, but it may be beneficial to execute the cases multiple times to see if the
response times and statistics stay the same.

4 Then click the Run Job icon at the top right-hand side of the window. The tuning job runs,
analyzing each statement and case, and providing values in the appropriate columns.

ANALYZING TUNER RESULTS ON THE OVERVIEW TAB

When you have executed a tuning job, the Generated Cases area of the Overview tab reflects
Tuner's analysis of the specified statements and cases. The Generated cases create alternative
execution or explain paths that could be more or less efficient than the default path the
databases uses. Executing these cases provides the statistics necessary to optimize
performance.

Once a tuning job has executed, use the Cost and Execution Statistics value columns to
determine the fastest execution path for each statement. The Cost column shows the
performance cost of an execution path as determined by the database. The Execution Statistics
are the actual results of running the SQL statement using the generated case. This is where DB
Optimizer can help you find where the database default path is actually not the optimal path.
The Elapsed Time(s) and Results columns can more accurately show the most efficient execution
path.

DB OPTIMIZER™ XE PRO 2 USER GUIDE 117



TUTORIALS > TUNING SQL STATEMENTS

In the Cost and Execution Statistics columns, the values of the original statement are considered
to be the baseline values. A Cost column can be expanded to provide a graphical
representation of the values for statements and cases. Similarly, the Execution Statistics column
can also be expanded to display a graphical representation of values as well. The bar length and
colors are intended as an aid in comparing values, particularly among cases.

I:'-?B I

1.545 I
0.655 M

0.499 S

0,797

I:I-EEB EE—

Case query times based on the original statement can be represented as colored bars on the Generated Cases area of the Overview
tab to help you determine the fastest execution path for the given selections.

The baseline value of the original statement spans half the width of the column, in terms of bar
length. For cases of the original statement, if one or more cases show a degradation value, the
largest value will span the width of the column. Bar lengths for all other cases will then be
displayed in comparison length to the highest degradation value.

The cost and execution results are color-coded as follows:

e Light blue: These cases are within the degradation and improvement threshold. Applying
these changes may marginally improve or degrade the efficiency of the SQL statement.

. : These cases have values less than the improvement threshold. There is a high
probability that changing the SQL statement with this alternative execution path will
improve efficiency.

e Red: These cases have values higher than the improvement threshold. Implementing these
changes will degrade the efficiency of the SQL statement.

To determine the best cases for statement execution path time:

Once the tuning job has executed, view the Generated Cases area of the Overview tab and
determine the best possible case in terms of the Execution Statistics column values. This will
indicate the most optimized query path for a given statement. Once you have determined
the best case, you can execute that case on the specified data source and alter the
database code to run the statement as that case on the native environment.

If you don't find an acceptably fast path, go to the Analysis tab. The Analysis tab can identify
missing indexes and by examining the diagram you may be able to determine if there is
something wrong with the SQL or schema.
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FINDING MISSING INDEXES AND SQL PROBLEMS

The tuner performs the index and SQL analysis as part of the tuner run job performed on the
Overview tab if Perform Detail Analysis is selected. Otherwise, the analysis is performed when

you click the Analysis tab.

¥ oy Oracle ¥ 5 sfvpelbl ] embarcaders, comi( (10,2.0,1)
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FROR rd \
e w50
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WHEF Earang
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DB Optimizer can parse an SQL query and analyze the indexes and constraints on the tables in
the query and display the query in graphical format on the Visual SQL Tuning (VST) diagram. The
VST diagram which can be displayed in either Summary Mode or Detail Mode, helps
developers, designers and DBAs see flaws in the schema design such as Cartesians joins,
implied Cartesians joins and many-to-many relationships. The VST diagram also helps the user
to more quickly understand the components of an SQL query, thus accelerating trouble-
shooting and analysis.

This section is comprised of the following topics:

¢ Finding Missing Indexes on page 120

e Applying Tuner Results to the Data Source on page 120
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FINDING MISSING INDEXES

Missing indexes are color-coded orange in the Collect and create indexes area of the Overview
tab. Creating a missing index can improve the execution path of the SQL statement being
analyzed.

TIP: Indexes that are used are color-coded green. Indexes that are present but not used in
this execution path are color-coded grey.
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SQL Analysis Select statement of interest: | SELECT 1 v oy B @
SELECT -
ct.action, [ & CLIEMT_TRANSACTICN {u}|
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client o, <
investment _type it, | 3 INVESTMENT _TYFE (it) |
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ct.olient_id = c.clienc
ct. invest.ment_id = i.in
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Collect and create indexes i | gH
v
Index Mame Table Owner Table Mame o |
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APPLYING TUNER RESULTS TO THE DATA SOURCE

Once Tuner has generated cases and statement results and analyzed the indexes, you can apply
the suggested changes to the data source from the Generated Cases area of the Overview tab.
You can create any recommended indexes from the Index Analysis area of the Analysis tab.

IMPLEMENTING RECOMMENDATIONS ON THE OVERVIEW TAB

To change an SQL statement based on a transformation or hint-based case:

In the Generated Cases area, right-click the Name field of the case you want to modify the
original statement with and choose Clone Case.
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Cases can be selected and applied on the data source where the statement originated. This process improves the former
statement’s execution path and therefore lessens overall data source load.

IMPLEMENTING RECOMMENDATIONS ON THE INDEX ANALYSIS TAB

Once you have added tuning candidates to a tuning job, DB Optimizer can analyze the
effectiveness of the indexes in the database and recommend the creation of new indexes where
the new indexes can increase performance.

In the Collect and create indexes table, any indexes DB Optimizer recommends you create are
marked in orange and have the little create index symbol in the far left column.
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To accept the suggestion and have tuning automatically generate an index:
1 For any recommended index, click the checkbox to the left of the index you want to create.

For a selected index you can modify the Index type by clicking in the Index Type column
and then selecting a type from the list: Normal, Bitmap, Reverse Key, Reverse Key
Unique, or Unique.
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2 Click the Create Indexes button.
The Index Analysis dialog appears.

3 To view the index SQL in an editor for later implementation, click the statement and then
click Open in a SQL editor.

4 To run the index SQOL and create the index on the selected database, click Execute.

SQL CODE ASSIST AND EXECUTION

SQL Code Assist is an interface component that enables the development and formatting of
SQL code for the purposes of creating and modifying database objects. It provides a front-end
application for the delivery of code through its object code extraction capabilities.
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Code Assist provides a number of key features that assist in the coding process, ensuring
greater accuracy in coding, faster development cycles, and a general increase in efficiency
overall.

f} Benson.sgl &%
CREATE TABLE dbo.benson N
{
job CHAR (8) NOT HULL,
sal WOMERIC (38, 0) NOT MULL,
loc WOMERIC (38, O0) NWOT NULL,
COMSTRAINT pijob PRIMARY EEY CLUSTERED (job)

go
IF OBJECT ID('dbo.benson') IS5 HOT HWULL e
FPRINT '<<< dbo.benson »>>>"
ELSE
X ] PROMT <<« by
[ ]
b

SQL Editor provides key features to ensure an increase in code accuracy and overall development efficiency.

The following key features are provided with SQL Code Assist:

e Code Extraction

Code Highlighting

e Automatic Error Detection

Code Complete

Hyperlinks

Code Formatting

Code Folding
¢ Code Quality Checks

In order to access SQL Editor, you need to create a new file or edit existing code from Data
Source Explorer.
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Additionally, SQL Project Explorer provides a tree structure for all files created in DB Optimizer.
You can access files from here by double-clicking the file name you want to open as well.

3 Data Source Explorer E_P,} SQL Project Explorer 53 =

1
I
=

= {3 5QL Project 1
+ * Connections
= |£'l' Creation Scripts
=i Tables
% dbo.benson (Benson.sql) [datoth15]
+ 5|:'|" General QL
l' Large Scripts
+ _b,._" Unknown Fles
[# Benson.sql
% Fie,sal
[*9% test.sql

3 |

SQL Project Explorer provides a tree of all files developed and saved in DB Optimizer.

To create a new file:
Choose File > New > SQL File.

A blank instance of SQL Editor appears in the Workbench. If you save this file, it is
automatically added to the SQL Project Explorer.

To edit an existing file:
Use Data Source Explorer or Project Explorer to navigate to the code you want to modify
and double-click it.

An instance of SQL Editor appears in the Workbench, populated with the extracted code of
the specified object or SQL project file.

CODE EXTRACTION

SQL Editor provides the ability to extract the underlying SQL code of database objects
registered in DB Optimizer to provide a front-end application for the development and
modification of data sources in your enterprise.

To extract underlying SQL code:

¢ Navigate to a database object in Data Source Explorer and select Extract via the right-click
menu.

The object’s underlying SQL code appears in SQL Editor and is ready for editing and further
modification.
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CODE HIGHLIGHTING

SQL Editor identifies commands and provides syntax highlighting changes that are
automatically added to the code as you add lines, which enables you to clearly and quickly
understand code when you read it in the interface.

The following syntax highlighting is automatically added to lines of code in SQL Editor:

Code Formatting
Comments Green italic font
SQL Commands Dark blue font
Syntax Errors Red underlined font
Coding Errors Red font

e Comments: green italics

e SQL Commands: dark blue
e Syntax Errors: red underline
e Coding Errors: red

Additionally, SQL Editor provides a purple change bar in the left-hand column that indicates if a
line of code has been modified from the original text. You can hover over this change bar to view
the original code line. A red square icon in the right-hand column indicates that there are errors
in the code line. You can hover over the icon to view the error count.

= 52

job CHAR (8) MOT NULL,

sal NUMERIC (38, 0) NOT NULL,
loc WNUMERIC (38, 0) NOT NULL,
COHMSTRAINT pjob PRIMARY FEY CLUSTERED (job)

(TS
L]

IF OSJECT_ID('dbo.benson®) IS5 NOT NULL

yl

Pre

|-|

The purple change bar indicates if a line of code has been changed from its original text. Hover your mouse over the change bar to
view the original text.
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AUTOMATIC ERROR DETECTION

The automatic error detection functionality of the editor highlights errors and typos in the code
as you work in “real time".

Automatic error detection automatically identifies and analyzes SELECT, FROM, WHERE,
GROUP BY, HAVING, and ORDER BY statements. If it detects any syntax errors while you type
these statements, the line is automatically flagged by the error icon in the left-hand column of
SQL Editor. You can hover your mouse over the icon to view any errors.

| 5% *Benson.sgl = =
CREATE TABLE dbo.benson il
{
job CHAR (8) NOT NWULL,
=al HUOMERIC (38, 0) HOT NULL,
loc HOMERIC (3B, 0) HWOT NULL,
CONSTRAINT picb PRIMARY EEY CLUSTERED (job)

go
IF GEE:T_E]:IL':':'I:':'.“.E?:.-'!.".'.’] I5 NGT WNULL
PRINT '«<<« CREATED TABLE dbo.benson >>>'
| ELsE
@ ln unexpected token ™ < <> >™ was found. Expected COLON On

Syntax errors are automatically flagged by line as you work with code in SOL Editor. Hover the mouse over the error icon to view the
specific error message.

Additionally, all semantic errors are recorded in the Problems view, an interface component that
automatically logs errors and warnings as you work with files.

*{ Problems &3 1 ShRASTE
3 errors, 0 warnings, 0 infos
Description Resource 2ath Locaton
= B Errors (3 itemns)
3 An unexpected token “< << FAILED CR Benson.sql S0L Project 1 m= 14
& An unexpected token ™ was found. Bxg Fie. sl SOL Project 1 ine &
3 Table benson cannot be resolved on 'da Benson.sql SQL Project 1 e 19

The Problems view logs errors and warnings as you work with files in SQL Editor.

You can double-click on a line in the Problems view and DB Optimizer will automatically navigate
you to that issue in SQL Editor.
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CODE COMPLETE

SQL Editor provides suggestion capabilities for both DML statements and objects. It has the
ability to look up object names in order to avoid errors when defining table names, columns, etc.
in the development process. This feature provides lists of object and code suggestions that will
make the development process more efficient as you will not be forced to manually look up
object names and other statement values. SQL Editor provides code assist for SELECT, UPDATE,
INSERT, and DELETE statements and object suggestion support for tables, alias tables, columns,
alias columns, schemas, and catalogs.

To activate code assist:

1 Click the line on which you want to activate the code assist feature.

2 Press CTRL + Spacebar on your keyboard. Code assist analyzes the line and presents a list
of suggestions as appropriate based on the elements of the statement.

HYPERLINKS

Hyperlinks are used in SQL Editor to provide links to tables, columns, packages and other
reference objects. When you select a hyperlinked object from a piece of code, a new editor
opens and displays the source. Additionally, hyperlinks can be used to link procedures or the
function of a call statement, as well as function calls in DML statements. To enable a hyperlink,
hover your mouse over the object name and hold the CTRL key. It becomes underlined and
changes color.
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CODE FORMATTING

Code formatting is automatically applied to a file as you develop it in SQL code. This enables
you to set global formatting preferences one time, and then apply it to all code development,
saving time and allowing for a more efficient code development process. The code formatter
can be accessed by selecting CTRL + Shift + F in the editor. All code is automatically formatted
based on parameters specified on the Code Formatter node of the Preferences panel. (Select
Window > Preferences in the Main Menu to access this panel.)
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type filter text Code Formatter a2
¥ E'H:‘f-“a' Select a profile:
= )
5 Instal Updaie Embarcaders bislt-n] R I__sﬂ'i,_]
# Licenze Manager
% Run/Debug o —
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R e col4d VARCHAR (30) i
S0L Execution b
S0L Fitters
B Team INSERT
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VALUES
{
9 ¥
9,
g,
‘teat “"'J
[RurhxeDehuHs] [ Apply ]
5 [ ol ] I Cancel ]

Code formatting parameters can be globally set and then applied to all development work in SQL Editor.

In addition to formatting code per individual file, you can also format an entire group of files
from Project Explorer. Select the directory of files that you want to apply formatting to and
execute the Format command from the right-click menu. The files will be automatically
formatted based on the global preferences.
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CODE FOLDING

The code folding feature automatically sorts code into a tree-like outline structure in SQL Editor.
This increases navigation and clarification capacities during the code development process. It
ensures that the file will be easily understood should any future work be required on the code.
As you work in SQL Editor, collapsible nodes are automatically inserted into the appropriate
lines of code. Statements can then be expanded or collapsed as needed, and this feature is
especially useful when working on parts of particularly large or complicated files.

CoODE QUALITY CHECKS

On Oracle-based code, the code quality checking feature provides suggestions regarding
improved code on a statement-by-statement basis. As you work in SQL Editor, markers provides
annotations that prevent and fix common mistakes in the code.

Notes regarding code quality suggestions appear in a window on any line of code where the
editor detects an error, or otherwise detects that the code may not be as efficient as it might be.
Code quality check annotations are activated by clicking the light bulb icon in the margin, or by
selecting Ctrl + | on your keyboard.

The following common errors are detected by the code quality check function in the editor:
e Statement is missing valid JOIN criteria
* Invalid or missing outer join operator
® Transitivity issues
¢ Nested query in WHERE clause
* \Wrong place for conditions in a HAVING clause
¢ Index suppressed by a function or an arithmetic operator
e Mismatched or incompatible column types
¢ Null column comparison
To activate code quality checks:
e Click the light bulb icon in the margin of the editor or select Ctrl + | on your keyboard.

The editor suggestions appear in a window beneath the selected statement. When you click
a suggested amendment, the affected code is automatically updated.

SQL EXECUTION

When you have finished developing or modifying code, you can then execute the file from within
the DB Optimizer environment, on the database of your choosing. This enables you to
immediately execute code upon completion of its development. Alternatively, you can save files
for execution at a later point in time.
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In order to execute a file, you must first associate it with a target database. This is performed by
using the triangles next to the data source group and data source bread crumbs at the top of
the SQL file window. Select a data source and a corresponding database to associate the file
with and then click the green arrow icon to execute the file.

5ol Untitled SQL.sgl 5% & -
b '} Orace b P TORLABSCORCL (MOVYIES) (10.2.0.1) B g -]
|l

=I-l=F Data Source Group
+-l=F Microsaft SOL Server
=I-1=F Oracle
i ROMLABORCLE 1
i ROMLABORCLSI_Z =
i sFvpclb0l embarcadera.com
i| TORLABORCLE_2
i TORLABORCLSI_1
S TORLABSCORCL
=M TORLABSCORCL (MOVIES)
+-1=F Microsoft SOL Server

When the green arrow icon on the right-hand side of the menus is selected, the file is executed on the specified data source and
database.

Additionally, if you have turned off auto-committal in the SQL Preferences panel (Window >
Preferences) and are connected to the relevant data source, you can commit and execute
transactions via the Commit Transaction and Start Transaction icons located beside the Execute
icon.

To execute a file:

Open the file you want to run and ensure it is associated with the correct database and that you
are connected to that datas ource, then click the Execute icon[ = ] DB Optimizer executes the
code on the database you specified.

To execute a transaction:

Open the transaction file you want to run and ensure it is associated with the correct database,
then click the Start Transaction icon| iP]' DB Optimizer executes the transaction on the database
you specified.

To commit a transaction:

Open the transaction file you want to commit, ensure it is associated with the correct database,
and click the Commit Transaction icon [ﬁf]. DB Optimizer commits the transaction on the
database you specified.
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CONFIGURING SQL EXECUTION PARAMETERS

If you do not want to use the default execution options provided by DB Optimizer, use the SQL
Session Options dialog to modify the configuration parameters that determine how DB
Optimizer executes code. These options ensure that code is executed the way you want on an
execution-per-execution basis, ensuring accuracy and flexibility when running new or modified
code.

& SOL Session Options |L”E”E|
S0L Session DOptions @
Specify the S0L session options for the current editor,
Property Yalue
—|Result Set
Plaxirmum Rows in Result Set ]
Mazximurn Mumber of Bytesina.,. 2048
ey Timeout (seconds) 1]
—| Transactions
AukoCormit brue
.
@J Firish l [ Cancel

SQL Sessions Options provide you with the flexibility to adjust execution parameters on a session-by-session basis.

To modify SQL execution options:

1 With an SQL file open, click the SQL Session Options icon [ & ] on the SQL Editor toolbar.
The SQL Sessions Options dialog appears.

2 Click the individual parameters in the Value column to change the configuration of each
property, as specified.

3 Click Finish. The session options are changed and DB Optimizer executes the code as
specified by your options.

NOTE: SQL Session Options are only applied to the currently-opened SQL file, and are not
retained across different files with regards to execution.
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The following topics provide reference details:

e Database Objects

e DBMS Connection Parameters by Platform

DATABASE OBJECTS

The following table describes the database objects displayed in DB Optimizer™ XE Pro 2 and
contains information regarding each one, including object name, DBMS platform, and any notes
pertaining to the specified object.

In DB Optimizer™ XE Pro 2, database objects are stored in Data Source Explorer as subnodes of
individual, pertinent databases.

Database Object DBMS Platforms Notes

Aliases DB2 An alias is an alternate name that references a table, view, and
other database objects. An alias can also reference another
alias as long as the aliases do not reference one anotherin a
circular or repetitive manner.

Aliases are used in view or trigger definitions in any SQL
statements except for table check-constraint definitions. (The
table or view name must be referenced in these cases.)

Once defined, an alias is used in query and development
statements to provide greater control when specifying the
referenced object. Aliases can be defined for objects that do
not exist, but the referenced object must exist when a
statement containing the alias is compiled.

Aliases can be specified for tables, views, existing aliases, or
other objects. Create Alias is a command available on the
shortcut menu.

Check Constraints All A check constraint is a search condition applied to a table.
When a check constraint is in place, Insert and Update
statements issued against the table will only complete if the
statements pass the constraint rules.

Check constraints are used to enforce data integrity when it
cannot be defined by key uniqueness or referential integrity
restraints.

A check condition is a logical expression that defines valid
data values for a column.
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Database Object

DBMS Platforms

Notes

Clusters

Oracle

A cluster is a collection of interconnected, physical machines
used as a single resource for failover, scalability, and
availability purposes.

Individual machines in the cluster maintain a physical host
name, but a cluster host name must be specified to define the
collective as a whole.

To create a cluster, you need the CREATE CLUSTER or
CREATE ANY CLUSTER system privilege.

Database Links

Oracle

A database link is a network path stored locally, that provides
the database with the ability to communicate with a remote
database.

A database link is composed of the name of the remote
database, a communication path to the database, and a user
ID and password (if required).

Database links cannot be edited or altered. To make changes,
drop and re-create.

Foreign Keys

All

A foreign key references a primary or unique key of a table (the
same table the foreign key is defined on, or another table and
is created as a result of an established relationship). Its
purpose is to indicate that referential integrity is maintained
according to the constraints.

The number of columns in a foreign key must be equal to the
number of columns in the corresponding primary or unique
key. Additionally, the column definitions of the foreign key
must have the same data types and lengths.

Foreign key names are automatically assigned if one is not
specified.

Functions

DB2, Oracle

A function is a relationship between a set of input data values
and a set of result values.

For example, the TIMESTAMP function passes input data
values of type DATE and TIME, and the result is TIMESTAMP.

Functions can be built-in or user-defined. Built-in functions are
provided with the database. They return a single value and are
part of the default database schema. User-defined functions
extend the capabilities of the database system by adding
function definitions (provided by users or third-party vendors)
that can be applied in the database engine itself.

A function is identified by its schema, a function name, the
number of parameters, and the data types of its parameters.

Access to functions is controlled through the EXECUTE
privilege. GRANT and REVOKE statements are used to specify
who can or cannot execute a specific function or set of
functions.

Groups

All

Groups are units that contain items. Typically, groups contain
the result of a single business transaction where several items
are involved.

For example, a group is the set of articles bought by a
customer during a visit to the supermarket.
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Database Object

DBMS Platforms

Notes

Indexes

All

An index is an ordered set of pointers to rows in a base table.

Each index is based on the values of data in one or more table
columns. An index is an object that is separate from the data in
the table. When an index is created, the database builds and
maintains it automatically.

Indexes are used to improve performance. In most cases,
access to data is faster with an index. Although an index
cannot be created for a view, an index created for the table on
which a view is based can improve the performance of
operations on that view.

Indexes are also used to ensure uniqueness. A table with a
unigue index cannot have rows with identical keys.

DB2: Allow Reverse Scans, Percent Free (Lets you type or
select the percentage of each index page to leave as free
space when building the index, from 0 to 99), Min Pct Used
(Lets you type or select the minimum percentage of space
used on an index leaf page. If, after a key is removed from an
index leaf page, the percentage of space used on the page is
at or below integer percent, an attempt is made to merge the
remaining keys on this page with those of a neighboring page.
If there is sufficient space on one of these pages, the merge is
performed and one of the pages is deleted. The value of
integer can be from 0 to 99.

Oracle: The Logging, No Sort, Degrees, and Instances
properties are documented in the editor.

Java Classes

Oracle

A model or template, written in Java language, used to create
objects with a common definition and common properties,
operations and behavior.

Java classes can be developed in Eclipse (or another Java
development environment such as Oracle JDeveloper) and
moved into an Oracle database to be used as stored
procedures.

Java classes must be public and static if they are to be used in
this manner.

When writing a class to be executed within the database, you
can take advantage of a special server-side JDBC driver. This
driver uses the user’s default connection and provides the
fastest access to the database.

Java classes become full-fledged database objects once
migrated into the database via the loadjava command-line
utility or the SQL CREATE JAVA statement.

A Java class is published by creating and compiling a call
specification for it. The call spec maps a Java method’s
parameters and return type to Oracle SQL types.

Once a Java class is developed, loaded, and published -- the
final step is to execute it.

Java Resources

Oracle

A Java resource is a collection of files compressed in a .jar file.
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Database Object

DBMS Platforms

Notes

Libraries

Oracle

A library is a configurable folder for storing and sharing
content with an allocated quota. Multiple libraries may exist in
the same database environment.

A library is a special type of folder in Oracle Content Services.
Unlike Containers and regular folders, each library has a Trash
Folder and an allocated amount of disk space.

A library is composed of a name (mandatory), description,
quota, path, and library members.

The library service allows you to create folders, list quotas, and
manage categories, workflow, trash folders, and versioning.
The Library service does not allow you to create or upload
files.

Materialized Views

Oracle

A database object that contains the results of a query. They are
local copies of data located remotely, or are used to create
summary tables based on aggregations of table data.
Materialized views are also known as snapshots.

A materialized view can query tables, views, and other
materialized views. Collectively, these are called master tables
(a replication term) or detail tables (a data warehouse term).

For replication purposes, materialized views allow you to
maintain copies of remote data on your local node. These
copies are read-only. If you want to update the local copies,
you need to use the Advanced Replication feature. You can
select data from a materialized view as you would from a table
or view.

For data warehousing purposes, the materialized views
commonly created are aggregate views, single-table
aggregate views, and join views.

Materialized View Logs

Oracle

Because Materialized Views are used to return faster queries (a
query against a materialized view is faster than a query against
a base table because querying the materialized view does not
query the source table), the Materialized View often returns
the data at the time the view was created, not the current table
data.

There are two ways to refresh data in Materialized Views,
manually or automatically. In a manual refresh, the Materialized
View is completely wiped clean and then repopulated with
data from the source tables (this is known as a complete
refresh). If source tables have changed very little, however, it is
possible to refresh the Materialized View only for changed
records -- this is known as a fast refresh.

In the case of Materialized Views that are updated via fast
refresh, it is necessary to create Materialized View Logs on the
base tables that compose the Materialized View to reflect the
changes.

If the number of entries in this table is too high, it is an
indication that you might need to refresh the Materialized
Views more frequently to ensure that each update does not
take longer than it needs.

Select owner, then select from tables with Materialized Views,
etc.
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Database Object

DBMS Platforms

Notes

Oracle Job Queue

Oracle

The Oracle Job Queue allows for the scheduling and
execution of PL/SQL stored procedures at predefined times
and/or repeated job execution at regular intervals, as
background processes.

For example, you could create a job in the Oracle Job Queue
that processed end-of-day accounting -- a job that must run
every weekday, but can be run unattended, or you could
create a series of jobs that must be run sequentially -- such as
jobs that might be so large, that in order to reduce CPU usage,
only one is run at a time.

Runs PL/SQL code at specified time or on specified schedule,
can enable/disable.

Outlines

Oracle

Oracle preserves the execution plans of “frozen” access paths
to data so that it remains constant despite data changes,
schema changes, and upgrades of the database or application
software through objects named stored outlines.

Outlines are useful for providing stable application
performance and benefit high-end OLTP sites by having SQL
execute without having to invoke the cost-based optimizer at
each SQL execution. This allows complex SQL to be executed
without the additional overhead added by the optimizer when
it performs the calculations necessary to determine the
optimal access path to the data.
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Database Object

DBMS Platforms

Notes

Packages

All

A package is a procedural schema object classified as a PL/
SQL program unit that allows the access and manipulation of
database information.

A package is a group of related procedures and functions,
together with the cursors and variables they use, stored
together in the database for continued use as a unit. Similar to
standalone procedures and functions, packaged procedures
and functions can be called explicitly by applications or users.

DB applications explicitly call packaged procedures as
necessary with privileges granted, a user can explicitly execute
any of the procedures contained in it.

Packages provide a method of encapsulating related
procedures, functions, and associated cursors and variables
together as a unit in the database. For example, a single
package might contain two statements that contain several
procedures and functions used to process banking
transactions.

Packages allow the database administrator or application
developer to organize similar routines as well as offering
increased functionality and database performance.

Packages provide advantages in the following areas:
encapsulation of related procedures and variables, declaration
of public and private procedures, variables, constraints and
cursors, separation of the package specification and package
body, and better performance.

Encapsulation of procedural constructs in a package also
makes privilege management easier. Granting the privilege to
use a package makes all constructs of the package assessable
to the grantee.

The methods of package definition allow you to specify which
variables, cursors, and procedures are: public, directly
accessible to the users of a package, private, or hidden from
the user of the package.

Package Bodies

Oracle

A package body is a package definition file that states how a
package specification will function.

In contrast to the entities declared in the visible part of a
package, the entities declared in the package body are only
visible within the package body itself. As a consequence, a
package with a package body can be used for the construction
of a group of related subprograms in which the logical
operations available to clients are clearly isolated from the
internal entities.
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Database Object

DBMS Platforms

Notes

Primary Keys

All

A key is a set of columns used to identify or access a row or
rows. The key is identified in the description of a table, index,
or referential constraint. The same column can be part of more
than one key.

A unique key is a key that is constrained so that no two of its
values are equal. The columns of a unique key cannot contain
NULL values.

The primary key is one of the unique keys defined on a table,
but is selected to be the key of the first importance. There can
only be one primary key on a table.

Oracle: If an index constraint has been defined for a table, the

constraint status for the table's primary key cannot be set to
Disabled.

Procedures

All

A procedure is an application program that can be started
through the SQL CALL statement. The procedure is specified
by a procedure name, which may be followed by arguments
enclosed within parenthesis.

The argument or arguments of a procedure are individual
scalar values, which can be of different types and can have
different meanings. The arguments can be used to pass values
into the procedure, receive return values from the procedure,
or both.

A procedure, also called a stored procedure, is a database
object created via the CREATE PROCEDURE statement that
can encapsulate logic and SQL statements. Procedures are
used as subroutine extensions to applications, and other
database objects that can contain logic.

When a procedure is invoked in SQL and logic within a
procedure is executed on the server, data is only transferred
between the client and the database server in the procedure
call and in the procedure return. If you have a series of SQL
statements to execute within a client application, and the
application does not need to do any processing in between
the statements, then this series of statements would benefit
from being included in a procedure.

Profiles

Oracle

Profiles are a means to limit resources a user can use by
specifying limits on kernel and password elements.
Additionally, Profiles can be used to track password histories
and the settings of specific profiles may be queried.

The following kernel limits may be set: maximum concurrent
sessions for a user, CPU time limit per session, maximum
connect time, maximum idle time, maximum blocks read per
session, maximum blocks read per call, and maximum amount
of SGA.
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Notes

Roles

Oracle

Arole is a set or group of privileges that can be granted to
users to another role.

A privilege is a right to execute a particular type of SQL
statement or to access another user’s object. For example: the
right to connect to a database, the right to create a tale, the
right to select rows from another user’s table, the right to
execute another user’s stored procedure.

System privileges are rights to enable the performance of a
particular action, or to perform a particular action on a
particular type of object.

Roles are named groups of related privileges that you grant
users or other roles. Roles are designed to ease the
administration of end user system and object privileges.
However, roles are not meant to be used for application
developers, because the privileges to access objects within
stored progmmatic constructs needs to be granted directly.

Sequences

DB2, Oracle

A sequence generates unique numbers.

Sequences are special database objects that provide numbers
in sequence for input into a table. They are useful for
providing generated primary key values and for the input of
number type columns such as purchase order, employee
number, sample number, and sales order number.

Sequences are created by use of the CREATE SEQUENCE
command.

Structured Types

DB2

Structured Types are useful for modeling objects that have a
well-defined structure that consists of attributes. Attributes are
properties that describe an instance of the type.

A geometric shape, for example, might have as attributes its
list of Cartesian coordinates. A person might have attributes of
name, address, and so on. A department might have a name
or some other attribute.

Synonyms

Oracle

A synonym is an alternate name for objects such as tables,
views, sequences, stored procedures, and other database
objects.

A synonym is an alias for one of the following objects: table,
object table, view, object view, sequence, stored procedure,
stored function, package, materialized view, java class, user-
defined object type or another synonym.

Tables

All

Tables are logical structures maintained by the database
manager. Tables are composed of columns and rows. The rows
are not necessarily ordered within a table.

A base table is used to hold persistent user data.

A result table is a set of rows that the database manager
selects or generates from one or more base tables to satisfy a
query.

A summary table is a table defined by a query that is also used
to determine the data in the table.
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Notes

Tablespaces

DB2, Oracle

A tablespace is a storage structure containing tables, indexes,
large objects, and long data. Tablespaces reside in database
partition groups. They allow you to assign the location of
database and table data directly onto containers. (A container
can be a directory name, a device name, or a file name.) This
can provide improved performance and more flexible
configuration.

Triggers

All

A trigger defines a set of actions that are performed when a
specified SQL operation (such as delete, insert, or update)
occurs on a specified table. When the specified SQL operation
occurs, the trigger is activated and starts the defined actions.

Triggers can be used, along with referential constraints and
check constraints, to enforce data integrity rules. Triggers can
also be used to cause updates to other tables, automatically
generate or transform values for inserted or updated rows, or
invoke functions to perform tasks such as issuing alerts.

Undo Segments

Oracle

In an Oracle database, Undo tablespace data is an image or
snapshot of the original contents of a row (or rows) in a table.
The data is stored in Undo segments in the Undo table space.

When a user begins to make a change to the data in a row in
an Oracle table, the original data is first written to Undo
segments in the Undo tablespace. The entire process
(including the creation of the Undo data is recorded in Redo
logs before the change is completed and written in the
Database Buffer Cache, and then the data files via the
database writer (DBW) process.)
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Notes

Unique Keys

All

A unique key is a key that is constrained so that no two of its
values are equal. The columns of a unique key cannot contain
null values. The constraint is enforced by the database
manager during the execution of any operation that changes
data values, such as INSERT or UPDATE. The mechanism used
to enforce the constraint is called a unique index. Thus, every
unigue key is a key of a unique index. Such an index is said to
have the UNIQUE attribute.

A primary key is a special case of a unique key. A table cannot
have more than one primary key.

A foreign key is a key that is specified in the definition of a
referential constraint.

A partitioning key is a key that is part of the definition of a
table in a partitioned database. The partitioning key is used to
determine the partition on which the row of data is stored. If a
partitioning key is defined, unique keys and primary keys must
include the same columns as the partitioning key, but can have
additional columns. A table cannot have more than one
partitioning key.

Oracle: You cannot drop a unique key constraint that is part of
a referential integrity constraint without also dropping the
foreign key. To drop the referenced key and the foreign key
together, check the Delete Cascade option for the foreign key.

Clustered: A cluster composes of a group of tables that share
the same data blocks, and are grouped together because they
share common columns and are often used together.

Filegroup: Lets you select the filegroup within the database
where the constraint is stored.

Fill Factor: Lets you specify a percentage of how large each
constraint can become.

Views

All

A view provides an alternate way of looking at the data in one
or more tables.

A view is a named specification of a result table and can be
thought of as having columns and rows just like a base table.
For retrieval purposes, all views can be used just like base
tables.

You can use views to select certain elements of a table and can
present an existing table in a customized table format without
having to create a new table.
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DBMS CONNECTION PARAMETERS BY PLATFORM
The following topics provide connection details:

e |BM DB2 LUW

Microsoft SOL Server

JDBC Connection Parameters

Oracle Connection Parameters

Sybase Connection Parameters
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IBM DB2 LUW

Connection Parameter

Description

Use Alias from IBM Client or Generic
JDBC Configuration

If you choose to use the alias from the IBM client, select the appropriate
alias name. Otherwise, choose Generic JDBC Configuration and enter the
connection parameters, as specified.

Schema ID (Optional)

The name of the database schema.

Function Path

Optional. Enter an ordered list of schema names to restrict the search
scope for unqualified function invocations.

Security Credentials

The log on information required by DB Optimizer™ XE Pro 2 to connect to
the data source.

Auto Connect

Automatically attempts to connect to the data source when selected in
Data Source Explorer, without prompting the user for connection
information.

JDBC Driver (Advanced)

The name of the JDBC Driver utilized by DB Optimizer™ XE Pro 2 to
initiate a JDBC standard access connection.

Connection URL (Advanced)

Used by the JDBC Driver to connect with a data source. Often contains
host and port numbers, as well as the name of the data source to which it
connects.

For example:

jdbc:postgresql://host:port/database

jdbc:derby://host:port/database

Custom JDBC Diriver Properties
(Advanced)

The name and property value of any custom JDBC drivers associated with
the data source.

MICROSOFT SQL SERVER

Connection Parameter

Description

Use Network Library Configuration

If the data source utilizes a network library, select this parameter. The
corresponding connection parameter fields become available. Otherwise,
choose Generic JDBC Configuration and enter the connection parameters,
as specified.

Host/Instance (JDBC Configuration)

The name of the data source.

Port (JDBC Configuration) (optional)

The listening port used in TCP/IP communications between DB
Optimizer™ XE Pro 2 and the data source.

Protocol (JDBC Configuration)

The communication mechanism between DB Optimizer™ XE Pro 2 and the
data source. Choose TCP/IP or Named Pipes.

Default Database (Optional)

The default SQL database name, as defined by the schema.

Security Credentials

The log on information required by DB Optimizer™ XE Pro 2 to connect to
the data source.

Auto Connect

Automatically attempts to connect to the data source when selected in
Data Source Explorer, without prompting the user for connection
information.
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Connection Parameter Description

Allow Trusted Connections Enables trusted connections to the data source from DB Optimizer™ XE
Pro 2.

JDBC Diriver (Advanced) The name of the JDBC Driver utilized by DB Optimizer™ XE Pro 2 to
connect and communicate with the database.

Connection URL (Advanced) Used by the JDBC Driver to connect with a database. Often contains host
and port numbers, as well as the name of the database to which it
connects.

For example:
jdbc:postgresgl://host:port/database

jdbc:derby://host:port/database

Custom JDBC Driver Properties The name and property value of any custom JDBC drivers associated with
(Advanced) the data source.
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JDBC CONNECTION PARAMETERS

Connection Parameter

Description

Connect String

Used by the JDBC Driver to connect with a database. Often contains host
and port numbers, as well as the name of the database to which it
connects.

For example:
jdbc:postgresql://host:port/database

jdbc:derby://host:port/database

Data Source Name

The name of the data source to which you want DB Optimizer™ XE Pro 2
to connect.

ORACLE CONNECTION PARAMETERS

Connection Parameter

Description

Use TNS Alias

If the data source is mapped to a net service name via tnsnames.ora, select
this parameter. Otherwise, choose Generic JDBC Configuration and enter
the connection parameters, as specified.

Host/Instance (JDBC Configuration)

The name of the host machine on which the data source resides.

Port (JDBC Connection)

The listening port used in TCP/IP communications between DB
Optimizer™ XE Pro 2 and the data source.

Type (JDBC Configuration)

Indicates if the data source is defined via a system identifier (SID) or a
service name.

Service/SID Name (JDBC
Configuration)

The name of the system identifier (SID) or service name that identifies the
data source.

Security Credentials

The log on information required by DB Optimizer™ XE Pro 2 to connect to
the data source.

Auto Connect

Automatically attempts to connect to the data source when selected in
data source Explorer, without prompting the user for connection
information.

Allow Trusted Connections

Enables trusted connections to the data source from DB Optimizer™ XE
Pro 2.

JDBC Driver (Advanced)

The name of the JDBC Driver utilized by DB Optimizer™ XE Pro 2 to
connect and communicate with the database.

Connection URL (Advanced)

Used by the JDBC Driver to connect with a database. Often contains host
and port numbers, as well as the name of the database to which it
connects.

For example:
jdbc:postgresql://host:port/database

jdbc:derby://host:port/database

Custom JDBC Diriver Properties
(Advanced)

The name and property value of any custom JDBC drivers associated with
the data source.
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SYBASE CONNECTION PARAMETERS

Connection Parameter

Description

Use Alias Information from your
SQL.INI File

If the data source is mapped to a name via SQL.INI, select this parameter
to use that name for connection. Otherwise, choose Generic JDBC
Configuration and enter the connection parameters, as specified.

Host/Instance (JDBC Connection)

The name of the host machine on which the data source resides.

Port (JDBC Connection)

The listening port used in TCP/IP communications between DB
Optimizer™ XE Pro 2 and the data source.

Default Database (JDBC Connection)
(Optional)

The default database name, as defined by the schema.

JDBC Driver (Advanced)

The name of the JDBC Driver utilized by DB Optimizer™ XE Pro 2 to
connect and communicate with the database.

Connection URL (Advanced)

Used by the JDBC Driver to connect with a database. Often contains host
and port numbers, as well as the name of the database to which it
connects.

For example:
jdbc:postgresql://host:port/database

jdbc:derby://host:port/database

Custom JDBC Diriver Properties
(Advanced)

The name and property value of any custom JDBC drivers associated with
the data source.
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